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Chapter 1
Getting Started with FixMaster

About FixMaster
FixMaster is a graphical editor for building test fixtures and generating tester download files.

Importing PCB Data
FixMaster imports files in several formats:

• Import Gerber PCB data and supplemental Gerber Layers.

• Import Lavenir Format 4 netlists, IPC-D-356, and several proprietary formats such as ATF,
CATE, and TIF.

• Import NC Drill files in Excellon and Sieb & Meyer.

You specify which data is read in or excluded, map D Codes to Probe Codes, define the Probe Codes,
and decide whether or not to flip the data.

Editing PCB and Test Point Data
Once PCB data has been imported, you can edit a graphic representation of pads, test points, drills, and
probes. Use the Reference Frame to include or exclude portions of the data for automatic group editing
operations. Inspect and edit netlist data all at once or one net at a time. You can automatically or
manually perform many functions:

• Place, move, rotate, and mirror PCB data.

• Specify the D Code size range and all other parameters for automatically generating test
points.

• Select a two-point or three-point stagger and D Code size range for automatically staggering
test points.

• Manually add, delete, move and stagger test points.

• Specify the maximum allowed pin deflection and other design rules for automatically
assigning test points to the fixture grid.

• Manually reassign test points to the fixture grid.

• Inspect and correct unmatched test points and crossed pins with a click of the mouse.
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Fixture Building
FixMaster allows you to design multiple-plate fixtures. You can set up two fixtures for a tower tester,
one for the component side of the board and one for the solder side. You specify the thickness and
material of each plate, the spaces between plates, the fixture grid, and the maximum pin deflection.
Insert, delete, move, copy, transfer, and replicate drills for outside tooling. Create panelized drill files.
Add spacers.

FixMaster automatically generates the data for the fixture plate probe drills when you define the fixture
parameters and assign test points to grid points. FixMaster determines drill position based on PCB
position, test point parameters, fixture configuration, and pin deflection. You can manually assign drill
sizes for each probe in each plate at a range of deflections, or you can have FixMaster automatically
calculate drill size based on oversize parameters and probe diameters.

You specify shaft and head diameters, air gap, stagger margin, and pad size range for different types of
probes used to test through holes, surface-mount pads, or both.

You can also designate D Codes on the PCB to be transferred as tooling holes to the fixture. These
locations can be output in the fixture drill files and used to mount alignment pins that will match the D
Code locations on the PCB.

Exporting Data
FixMaster exports files for use in building fixtures and testing PCBs. Export data in NC Drill and a
variety of tester formats. You can save the fixture tooling and configuration for reuse. FixMaster
exports the following file types:

Exporting NC Drill Files for Manufacturing Fixtures
FixMaster outputs fixture tooling and probe drills in NC format. The output consists of as many files as
there are plates in the fixture. Plates and the corresponding output file for each plate are numbered
starting from the top of the fixture.

FixMaster supports Excellon and Sieb & Meyer output. You set the language and the options you
want.

Exporting Tester Download Files
FixMaster outputs tester download files. Most formats allow you to output a shorts file in addition to a
standard tester download file. Points are output relative to the datum point.

Saving FixMaster Job Files
FixMaster saves and opens FixMaster .JOB files which contain all configuration and environment
variables for a FixMaster job: probe diameters, probe air gaps, probe margins, D Code and probe
mapping, fixture grid size, and stagger and generate options. The file also contains fixture plates and
tooling and the PCB database, including pads, test points, and grid points for both layers.

.JOB files can be used as boilerplate fixture files that can be saved and reloaded when you have
similarly configured jobs.

.JOB files of completed jobs can be loaded into Verify for fault verification.
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What's New in FixMaster 7.0 for Windows
Lavenir has added some new features to FixMaster 7.0 for Windows since the release of Version 6.3:

New Features
• New Support for IPC-356-A: Imports and exports a subset of IPC-356-A. Adds more

support for end of copper testing.

• Nidec/Read: More Nidec/Read support.

• Test Point Staggering: Adds a "random" option for staggering test points around through
holes which staggers test points randomly (up, down, left and right).

• Densely Packed Component Isolation: When a component is to be split out to be tested
separately and multiple test points of split out nets lie outside the component, then only one
test point outside the component needs to be kept with the split. The component isolation
feature makes for more efficient testing of split out components.

Send Us Your Comments
Lavenir is committed to continuous improvement. Your constructive comments on FixMaster will help
us to correct problems and improve features.

• Please e-mail your comments and suggestions regarding FixMaster to
feedback@lavenir.com.

• Visit the Lavenir Web Site at http://www.lavenir.com.

• You can reach Lavenir Technical Support at (925) 680-7400 between the hours of 8am and
5pm Pacific Time.

• Lavenir is located at:
2440 Estand Way
Pleasant Hill, CA   94523
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Download FixMaster Updates
Lavenir will be making updated versions of FixMaster and updated Help files available to customers
who have a current maintenance agreement or warranty. You can download the current FixMaster
updates from the Lavenir Premier Support Web site.

To Download FixMaster Updates:
1. Have your User Name and Password ready before logging on to the Lavenir Premier Web

Site. Your User Name and Password are printed on your User Password Letter. If you do not
know your User Name and Password, call Lavenir at (925) 680-7400.

2. Go to the Lavenir Web Site at http://www.lavenir.com.

3. On the Site Map, click on Premier Support.

4. On the User Name and Password dialog, enter your User Name and Password.

5. Click on Software Library .

6. Follow the instructions to download the FIXMASTER SETUP.EXE  update file to your
system.

7. Double-click on the downloaded FIXMASTER SETUP.EXE  file on your system and follow
the setup instructions.

Lavenir Technical Support
You can reach Lavenir Technical Support by:

• Telephone: (925) 680-7400 between the hours of 8 AM and 5 PM Pacific Standard Time.

• E-Mail: support@lavenir.com.

• Web Site:  http://www.lavenir.com

Contact Lavenir Customer support with questions about Lavenir hardware and software or to arrange
for training or maintenance.

Lavenir is located at:

2440 Estand Way
Pleasant Hill, CA   94523
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Chapter 2
How to Build a Fixture Using FixMaster

This is a general outline for beginning-to-end fixture building in FixMaster. Very few real-life jobs
will follow this outline exactly. Once you have used FixMaster for a while, most jobs will skip the
configuration setups and begin with opening a boilerplate .JOB file, then importing the PCB data.
Some jobs may be processed almost entirely automatically using AutoGen. Use this outline as a
general guide to the steps in a typical job and as a resource for locating more detailed information.

To Build a Fixture Using FixMaster:
1. If you have previously saved fixture configuration, outside tooling, and operation

configurations, open the boilerplate job. See Open a FixMaster Job File on page 293.

2. Set the fixture configuration settings. See Set Up the Fixture Configuration on page 51.

3. Set up outside tooling. See Set Up the Fixture Outside Tooling on page 83.

4. Import the PCB data. See Import PCB Files into the Job on page 299.

5. If you are going to test both sides of a board on one single-sided fixture, do a flip test. See Set
up a Flip Test on page 117.

6. Position the PCB data within the fixture. See Position the PCB on page 119.

7. Map the D Codes to Probe Codes. See Map D Codes to Probe Codes on page 129.

8. Generate test points. See Add Test Points on page 137.

9. Inspect possibly probeable, possibly covered points not given test points. See Possibly
Probeable, Possibly Covered Test Points on page 148.

10. Stagger test points. See Stagger Test Points on page 165.

11. Assign test points to tester grid points. See Assign Test Points to Tester Grid Points on page
177.

12. Inspect and correct design-rule errors. See Check for Design Rule Errors on page 195.

13. Inspect nets one at a time and edit test points in Netlist Inspection mode. See Inspect Netlist
Mode on page 207.

14. If you are going to split out some nets of the netlist to be tested separately, do a Split Net. See
Split Nets on page 221.

15. Do any wire wrapping  required for this job. See Wire Wrapping on page 237.

16. When all the test points are assigned, and all the design rule errors are corrected, add spacers.
See Add Spacers on page 281.

17. Export the Files. See Export Tester Download Files on page 316 and the other export
procedure in File Handling in FixMaster on page 291.
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Chapter 3
FixMaster Interface Overview

FixMaster has a point-and-click Windows interface with most functions available on command menus
and command toolbars. Most functions can also be activated using shortcut key commands. This
chapter provides a brief overview of the major elements of the interface. For more detailed descriptions
of the commands represented on the individual menus and toolbar buttons, see the sections of this
manual that describe the function you want to perform.

Application Window

FixMaster Application Window

The FixMaster Application Window has command menus at the top, toolbars around the edges, a
status bar at the bottom and the viewing area in the center.
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Command Menus
Most commands in FixMaster can be accessed through the command menus. Command menus are
usually accessed by clicking on the command. In this manual, command menu commands are written
in bold and the cascade menus are separated by a dash ( - ).

Command Menu Instruction Example:
� On the Edit  menu, click Fixture-Spacers-Insert Spacer.

The instruction in the example means to click the menu shown in the following graphic.

Command Menu Example

Access Keys for Menu Commands
Command menus can also be accessed from the keyboard using what are sometimes called access keys
or accelerator keys. The underlined character in each menu indicates the access key for that menu
selection. To use the access keys press the Alt  key and the first access key indicated in the top-level
menu. The menu drops down. Then press the other access keys indicated in each cascade menu.

Access Key Example:
1. For the example shown in the Command Menu Example graphic, press Alt+E  together.

The Edit Menu drops down.

2. Press X.

The Fixture  cascade menu drops down.

3. Press S.

The Spacers cascade menu drops down.

4. Press P.

The Insert Spacer command is selected.
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Shortcut Keys for Menu Commands
Often a command on the command menus will have an even faster way to access the command by
keyboard. These key commands are sometimes called shortcut keys or hotkeys. If there is an
equivalent key command, it is usually indicated on the final cascade menu. In the example in the
graphic, the shortcut key command is Shift+R. There are also shortcut keys for commands that are not
on the menus. For more about shortcut key commands see Key Commands on page 16. For a listing of
all shortcut key commands in FixMaster, see Key Commands Summary on page 391.

Command Toolbars
Many commands in FixMaster can be accessed through the command toolbars. Toolbar controls are
activated by clicking on the toolbar button or control. In this manual, toolbar controls are either shown
using a graphic, or the name of the button or control is written in bold.

To Find Out What a Toolbar Control Is:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. The ToolTip gives the name of the control and usually also
gives the equivalent key command. The Message Line in the Status Bar gives some additional
information about the control.

The following sections provide brief descriptions of each of the toolbars. For more detailed
descriptions of the toolbar commands, see the sections of this manual that describe the function you
want to perform.

Main Toolbar

Main Toolbar

The Main toolbar has the File menu commands common to most Windows programs: New File, Open
File and Save File. It also has the Print command.
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Editing Toolbar

Editing Toolbar

The Editing Toolbar has commands for editing different types of elements. The Editing Toolbar and
the Editing Mode Toolbar are used together. The kind of element that can be edited (pad, test point,
drill, or spacer) and the type of commands available on the Editing Toolbar depend on the editing
mode selected on the Editing Mode toolbar. See Editing Mode Toolbar on page 11.
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Editing Mode Toolbar

Editing Mode Toolbar

The Editing Mode Toolbar and the Editing Toolbar are used together. The Editing Mode Toolbar
determines which types of elements can be edited by the commands on the Editing toolbar, and it
determines which commands are available on the Editing Toolbar. See also Editing Toolbar on page
10.

Editing Mode Example:

� To edit drill data using the Editing Toolbar, first click the Drill Editing Mode   button on
the Editing Mode Toolbar.

The Drill Editing Mode is selected and now the Editing Toolbar buttons represent commands that
affect drills only. For instance the Insert button on the Editing Toolbar inserts drills.

� To edit test points using the Editing Toolbar, first click the Test Point Editing Mode 
button on the Editing Mode Toolbar.

The Test Point Editing Mode is selected and now the Editing Toolbar buttons represent commands
that affect test points only. For instance the Insert button on the Editing Toolbar inserts test points.

Note: The Editing Mode Toolbar only affects the editing mode for commands on the Editing
Toolbar. Editing commands that appear on the command menus do not require you to set the
editing mode first.
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Fixture Plates Toolbar

Fixture Plates Toolbar

The Fixture Plates Toolbar indicates the status of fixture plates for drill editing.

Visible Plates
Visible plates show a solid block of color on the toolbar. The color on the toolbar is the same color that
represents the plate in the viewing area. Non-visible plates are indicated on the toolbar using a
crosshatched pattern.

To Make a Single Plate Visible or Non-Visible:
� Double-click on the plate number in the toolbar.

The plate switches from visible to non-visible and vice versa.

To Make all Plates Visible:

� Click on the All Visible   button in the toolbar.

The plate switches from visible to non-visible or vice versa.

To Toggle the Visibility of all Plates:

� Click on the Toggle All  button in the toolbar.

All visible plates switch to non-visible and vice versa.
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To Change the Plate Color:
1. Right-click  on the layer number.

2. On the pop-up context menu, click Color.

3. On the Choose a Color dialog, click the color you want and click OK .

Active Plates
Editing commands only work on active, visible plates. FixMaster can have one active plate or all plates
can be active. When the active plate button at the bottom of the toolbar says All Active , then all plates
are active and editing commands can affect all plates. When the active plate button at the bottom of the
toolbar says One Active, then only the plate that has the black box around it in the toolbar is active,
and editing commands can only affect that one plate.

To Make all Plates Active:
� Click the button at the bottom of the Fixture Plates Toolbar so that it says All Active

.

To Make one Plate Active:
1. Click the button at the bottom of the Fixture Plates Toolbar so that it says One Active

.

2. Then click the plate that you want to be the active plate so that the black box is around that
plate.

Plates with Data
The Fixture Plates Toolbar indicates which plates have drills and which plates don’t. Plates with data
have a solid block of color, while plates that don’t have data have only an outline of color. Also plates
with data have an asterisk next to the plate number, while plates that don’t have data also don’t have
the asterisk.

Goto Toolbar

Goto Toolbar

The Goto Toolbar has commands for going to specific types of elements and test point errors.



FixMaster User’s Guide

14

HiLite Toolbar

HiLite Toolbar

The HiLite Toolbar has commands for highlighting specific types of elements.

Screen Toolbar

Screen Toolbar

The Screen Toolbar has controls for changing the view of the Viewing Area and changing how the
cursor coordinates and distance are shown.
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Visibility Toolbar

Visibility Toolbar

The Visibility Toolbar has buttons that control what is shown on screen.

Status Bar

Status Bar

The Status Bar provides information about the selected elements and displays messages from the
system, such as prompts for commands.
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Key Commands
Many commands in FixMaster can be accessed through the keyboard using the key commands. For a
complete list of all shortcut keys in FixMaster, see Key Commands Summary on page 391.

Shortcut Key Commands
Shortcut keys are the fastest way to activate commands. Shortcut keys are usually a single keyboard
key (such as R or D), or they can use the Shift or Ctrl  keys modifiers (such as Shift+R or Ctrl+R ).

To Find the Shortcut Key for a Menu Command:
� Go to the menu command that you want to use.

If there is a shortcut key for that command, it will be indicated on the final cascade menu.

To Find the Shortcut Key for a Toolbar Control:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. If there is a shortcut key for that command, it will be
indicated on the ToolTip.

Access Key Commands
Access keys are just an alternative way to activate a menu command. The underlined character in each
menu indicates the access key for that menu selection. To use the access keys press the Alt  key and the
first access key indicated in the top-level menu, and then press the other access key indicated in each
cascade menu. For more about access keys, see Access Keys for Menu Commands on page 8.
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Chapter 4
Viewing Data in FixMaster

FixMaster has many options for viewing data. You can choose what data to display on screen,
highlight certain types of data, zoom up and down, go to specific locations or types of data, use an on-
screen positioning grid, measure distance and display job statistics.

Choosing What Data to Display
FixMaster has many commands that allow you to control what data is displayed on screen.

Displaying Component Side or Solder Side Data
You can choose which side of the board to display, either the component side or the solder side. Many
commands only work on the active board side. The currently active side is shown in the Status Bar,
either CMP or SOL.

To Display Component Side or Solder Side Data:
1. On the View menu, go to Active Side and look at Component Side and Solder Side.

• If Component Side has a checkmark next to it, then the Component Side data is being
displayed.

• If Solder Side has a checkmark next to it, then the Solder Side data is being displayed.

2. Click the either Component Side or Solder Side to select that side for display.

Menu: View-Active Side-Component Side or Solder Side

Button:

Key: Shift+O

Displaying the PCB Data
You can choose to display or not to display the imported PCB data.

To Display the PCB Data:
1. On the View menu, go to Data Elements and look at PCB.

• If PCB has a checkmark next to it, then the PCB data is being displayed.

• If PCB does not have a checkmark next to it, then the PCB data is not being displayed.

2. Click PCB to switch between displaying or not displaying the PCB data.

Menu: View-Data Elements-PCB

Button:

Key: B



FixMaster User’s Guide

18

Displaying All Pads or Only Pads with Test Points
When the PCB data is being displayed you can choose to display all pads or only pads that have test
points on them.

To Display All Pads or Only Pads with Test Points:
1. On the View menu, go to Data Elements-Pads and look at All .

• If All  has a checkmark next to it, then the All pads are being displayed.

• If All  does not have a checkmark next to it, then only the pads with test points are being
displayed.

2. Click All  to switch between displaying all pads or only pads with test points.

Menu: View-Data Elements-Pads-All

Button:

Key: Shift+P

Display “Commented” Pads in IPC-D-356 Data
This command displays the “commented” pads in IPC-D-356 data. These are elements in which a letter
C has been inserted into the data to indicate that the element is “commented out.”

To Display “Commented” Pads in IPC-D-356 Data:
1. On the View menu, go to Data Elements-Pads and look at Commented.

• If Commented has a checkmark next to it, then the “commented” pads in IPC-D-356
data are being displayed.

• If Commented does not have a checkmark next to it, then the “commented” pads in IPC-
D-356 data are not being displayed.

2. Click Commented to switch between displaying and not displaying the “commented” pads in
IPC-D-356 data.

Menu: View-Data Elements-Pads-Commented

Button: None

Key: None
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Display Only the Accessed Side for IPC-D-356 Pads with Access Data
Some IPC-D-356 files contain access data indicating which board side a given pad is to be accessed
from.

To Display Only the Accessed Side for IPC-D-356 Pads with Access Data:
1. On the View menu, go to Data Elements-Pads and look at Access.

• If Access has a checkmark next to it, then pads in IPC-D-356 data that have access
information are displayed only for the board side where they can be accessed.

• If Access does not have a checkmark next to it, then even pads in IPC-D-356 data that
have access information are displayed for both board sides, even if they can only be
accessed from one side.

2. Click Access to switch between displaying pads that have access information only on the
accessed board side and displaying those pads on both board sides.

Menu: View-Data Elements-Pads-Access

Button: None

Key: None

Displaying Net Numbers
FixMaster can display the net number of each pad next to each pad.

To Display Net Numbers:
1. On the View menu, go to Data Elements and look at Net Numbers.

• If Net Numbers has a checkmark next to it, then the net numbers are being displayed.

• If Net Numbers does not have a checkmark next to it, then the net numbers are not being
displayed.

2. Click Net Numbers to switch between displaying or not displaying the net numbers.

Menu: View-Data Elements-Net Numbers

Button:

Key: F
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Displaying All Pads or Only Pads with Unassigned Test Points
When the PCB data is being displayed you can choose to display all pads or only pads that have
unassigned test points on them.

To Display Only Unassigned Test Points:
1. On the View menu, go to Data Elements and look at Unassigned TP Only.

• If Unassigned TP Only has a checkmark next to it, then only pads that have unassigned
test points are being displayed.

• If Unassigned TP Only does not have a checkmark next to it, then all pads are being
displayed.

2. Click Unassigned TP Only to switch between displaying all pads or only pads with
unassigned test points.

Menu: View-Data Elements-Unassigned TP Only

Button:

Key: U
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Displaying Traces
When the PCB data is being displayed, you have several options for how to display traces, and you
have the option to not display them at all. Traces must be present in the imported PCB data in order to
be displayed.

To Display Traces:
1. On the View menu, click Data Elements-Trace.

2. In the Traces group box, select an option for which traces to display, if any:

• Hide All:  When this option is selected, no traces are displayed.

• Show Current Layer Plus Inner: When this option is selected, the traces for the active
board side, component or solder, are displayed, and the traces for the inner layers are also
displayed.

• Show Current Layer: When this option is selected, the traces for the active board side,
component or solder, are displayed.

3. In the Turn Off Traces with Net table, enter any net numbers for which you want to turn off
the display of traces. This option only has meaning if you have selected an option which
displays traces.

4. Click OK .

Menu: View-Data Elements-Trace

Button:    This button is a shortcut that switches between showing no traces and showing the
traces in the active board side, CMP or SOL.

Key: T:  This key displays the Show Trace dialog.
Shift+T: This key is a shortcut that switches between showing no traces and showing the
traces in the active board side, CMP or SOL.
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Displaying Fixture Grid Points
You can choose to display or not to display the fixture grid points. The grid points appear on screen as
small red crosses.

To Display Fixture Grid Points:
1. On the View menu, go to Data Elements and look at Grid Probes.

• If Grid Probes has a checkmark next to it, then grid points are being displayed.

• If Grid Probes does not have a checkmark next to it, then grid points are not being
displayed.

2. Click Grid Probes to switch between displaying or not displaying grid points.

Menu: View-Data Elements-Grid Probes

Button:

Key: None

Displaying Silkscreen Data
If you have imported a silkscreen data file, you can choose to display or not to display the silkscreen
data. For information on importing silkscreen data, see Import Supplemental Gerber Files into the Job
on page 312.

To Display Silkscreen Data:
1. On the View menu, go to Data Elements and look at Silkscreen.

• If Silkscreen has a checkmark next to it, then silkscreen data is being displayed.

• If Silkscreen does not have a checkmark next to it, then silkscreen data is not being
displayed.

2. Click Silkscreen to switch between displaying or not displaying silkscreen data.

Menu: View-Data Elements-Silkscreen

Button:

Key: K
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Displaying Soldermask Data
If you have imported a soldermask data file, you can choose to display or not to display the soldermask
data. For information on importing soldermask data, see Import Supplemental Gerber Files into the
Job on page 312.

To Display Soldermask Data:
1. On the View menu, go to Data Elements and look at Soldermask.

• If Soldermask has a checkmark next to it, then soldermask data is being displayed.

• If Soldermask does not have a checkmark next to it, then soldermask data is not being
displayed.

2. Click Soldermask to switch between displaying or not displaying soldermask data.

Menu: View-Data Elements-Soldermask

Button:

Key: None

Displaying Board Outline Data
If you have imported a board outline data file, you can choose to display or not to display the board
outline data. For information on importing board outline data, see Import Supplemental Gerber Files
into the Job on page 312.

To Display Board Outline Data:
1. On the View menu, go to Data Elements and look at Board Outline.

• If Board Outline has a checkmark next to it, then board outline data is being displayed.

• If Board Outline does not have a checkmark next to it, then board outline data is not
being displayed.

2. Click Board Outline to switch between displaying or not displaying board outline data.

Menu: View-Data Elements-Board Outline

Button:

Key: O
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Displaying the Fixture Drills
You can choose to display or not to display the fixture drills. This option allows you to display the
outside tooling and other drills that you add manually, not the probe drills that FixMaster creates.

To Display the Fixture Drills:
1. On the View menu, go to Data Elements and look at Fixture .

• If Fixture  has a checkmark next to it, then the fixture drills are being displayed.

• If Fixture  does not have a checkmark next to it, then the fixture drills are not being
displayed.

2. Click Fixture  to switch between displaying or not displaying the fixture drills.

Menu: View-Data Elements-Fixture

Button:

Key: L

Displaying the Drill Path for the Fixture Drills
When the fixture drills are displayed, you can also choose to display or not to display the drill path for
the fixture drills. This option allows you to display the drill path for the outside tooling and other drills
that you add manually, not the drill path for the probe drills that FixMaster creates.

To Display the Drill Path for the Fixture Drills:
1. On the View menu, go to Data Elements and look at Drill Path .

• If Drill Path  has a checkmark next to it, then the drill path for the fixture drills is being
displayed.

• If Drill Path  does not have a checkmark next to it, then the drill path for the fixture drills
is not being displayed.

2. Click Drill Path  to switch between displaying or not displaying the drill path for the fixture
drills.

Menu: View-Data Elements-Drill Path

Button:

Key: None
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Show the Drill Count
FixMaster can display a dialog that shows the number of drills for each Tool Code.

To Show the Drill Count:
� On the View menu, click Data Elements-Drill Count.

Drill Counts Dialog

Menu: View-Data Elements-Drill Count

Button:

Key: Shift+F5
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Highlighting Data On Screen
FixMaster has several highlighting commands to help you find certain types of data elements on
screen. These commands cause the particular type of data element to be displayed in magenta on
screen. Once data is highlighted, FixMaster also has a command for inspecting each highlighted
element in sequence. See Going to the Next Highlighted Element on page 38.

Show Everything in Gray Except for the Highlighted Elements
FixMaster can make it easier to inspect the highlighted data by displaying everything in gray except for
the highlighted data.

To Show Everything in Gray Except for the Highlighted Elements:
1. On the View menu, click Data Elements-Net Exclusive.

All data elements on screen turn gray.

2. Activate the highlighting command you want to use.

The highlighted elements are shown in magenta and all other elements remain gray.

3. To restore the elements to normal color, go back to the View menu and click Data Elements-
Net Exclusive again.

Menu: View-Data Elements-Net Exclusive

Button: None

Key: None
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Highlighting a Specific Net
You can highlight a specific net.

To Highlight a Specific Net:
1. On the View menu, click Hi Lite Image-By Netlist.

FixMaster prompts for a net number.

Highlight Net

2. On the Net dialog, enter the number of the net you want to highlight and click OK .

FixMaster displays the net highlighted in magenta.

Menu: View-Hi Lite Image-By Netlist

Button:

Key: Shift+F
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Highlighting the Net of a Selected Element
You can highlight the net of a selected element.

To Highlight the Net of a Selected Element:

1. On the HiLite  Toolbar, click the Show Netlists button .

2. Click on the element in the net that you want to highlight.

The cursor snaps to the element and marks it with an X.

3. Click again.

FixMaster displays the net highlighted in magenta.

The Highlight Net of Element tool remains selected until you select another tool or press the
Escape key, so you can highlight one net after another by clicking on more elements.

Menu: None

Button:

Key: None
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Highlighting Data by D Code
You can highlight all the elements that have a selected D Code.

To Highlight Data by D Code:
1. On the View menu, click Hi Lite Image-By D Code.

FixMaster prompts for a D Code number.

Highlight D Code

2. On the D Code dialog, enter the D Code you want to highlight and click OK .

FixMaster displays the all elements of the selected D Code highlighted in magenta.

Menu: View-Hi Lite Image-By D Code

Button:

Key: Ctrl+D

Highlighting Tooling Holes
FixMaster has a command to highlight PCB data that has a D Code designated as representing tooling
holes in FixMaster. For more information on tooling holes, see PCB Tooling Holes and Fixture
Alignment Pins on page 385.

To Highlight Tooling Holes:
� On the View menu, click Hi Lite Image-By Tooling D Code.

FixMaster displays all data having a D Code mapped as a tooling hole highlighted in magenta.

Menu: View-Hi Lite Image-By Tooling D Code

Button:

Key: Shift+E
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Highlighting Data by Probe Code
You can highlight all the pads mapped to a selected Probe Code.

To Highlight Data by Probe Code:
1. On the View menu, click Hi Lite Image-By Probe Code.

FixMaster prompts for a Probe Code number.

Highlight Probe Code

2. On the Probe dialog, enter the Probe Code you want to highlight and click OK .

FixMaster displays the all elements mapped to the Probe Code highlighted in magenta.

Menu: View-Hi Lite Image-By Probe Code

Button:

Key: Shift+B
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Highlighting Data by Pin Deflection
FixMaster has a command that highlights elements that are assigned to grid points within a specified
pin deflection range. You select the pin deflection range and FixMaster highlights those elements in
magenta.

To Highlight Data by Pin Deflection:
1. On the View menu, click Hi Lite Image-By Pin Deflection.

FixMaster prompts for a pin deflection range.

Highlight by Pin Deflection

2. On the Deflection % dialog, select the pin deflection range you want to highlight and click
OK .

FixMaster displays the all elements that have test points assigned to grid within the selected pin
deflection range highlighted in magenta.

Menu: View-Hi Lite Image-By Pin Deflection

Button:

Key: Shift+5
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Highlighting the Data Changed by a Net Replace Operation
The Net Replace operation can change the netlist connectivity data behind a PCB design that has
already been imported into FixMaster. FixMaster has a command to highlight the elements that have
changed due to a Net Replace operation.

To Highlight Data Changed by a Net Replace Operation:
� On the View menu, click Hi Lite Image-By Net Replace.

FixMaster displays the elements that have changed due to a Net Replace operation highlighted in
magenta.

Menu: View-Hi Lite Image-By Net Replace

Button:

Key: None

Removing Highlighting from the Screen
You can remove the highlighting from the screen and return all elements to their normal color.

To Remove Highlighting from the Screen:
� On the View menu, click Hi Lite Image-Remove Hi Lite.

FixMaster removes the magenta highlighting from any elements that are currently highlighted and
displays all elements in their normal colors.

Menu: View-Hi Lite Image-Remove Hi Lite

Button:

Key: Shift+H
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Zooming on Data
FixMaster has several commands for zooming up and down on the viewing area and zooming on
specific areas of the screen.

Zooming Up or Down in Steps
You can zoom up or down by a fixed amount.

To Zoom Up or Down:
� On the View menu, click Zoom-Zoom Up or Zoom Down.

FixMaster zooms the viewing area up or down, centered on the cursor position.

Note: It is usually preferable to run this command from the keyboard rather than the command
menus because you have more control over the cursor position when the command is
activated. This allows you to control the exact position to zoom on.

Menu: View-Zoom-Zoom Up or Zoom Down

Button:   Click the button, then click in the viewing area to Zoom Up.
No button for Zoom Down.

Key: Page Up key or Page Down key

Zooming to Show All Data
You can zoom so that all data fits in the screen.

To Zoom so that All Data is Shown on Screen:
� On the View menu, click Zoom-Zoom to Show All.

FixMaster zooms up or down so that all data on screen fits inside the viewing area.

Menu: View-Zoom-Zoom to Show All

Button:

Key: Home key
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Zooming on the Reference Frame
You can zoom on the Reference Frame.

To Zoom on the Reference Frame:
� On the View menu, click Zoom-Zoom On Frame.

FixMaster zooms on the Reference Frame.

Menu: View-Zoom-Zoom on Frame

Button: None

Key: W

Automatic Zoom-on-Frame Feature
You can set FixMaster to automatically zoom on the Reference Frame whenever a new Frame is
drawn. Or you can turn the feature off so that FixMaster does not automatically zoom on a new
Reference Frame.

To Select to Automatically Zoom when a New Frame is Drawn:
1. On the View menu, go to Zoom and look at Zoom On.

• If Zoom On has a checkmark next to it, then FixMaster will automatically zoom on the
Reference Frame whenever a new Frame is drawn.

• If Zoom On does not have a checkmark next to it, then FixMaster will not automatically
zoom on a new Reference Frame.

2. Click Zoom On to switch between automatically zooming on a new Frame and not
automatically zooming on a new Frame.

Menu: View-Zoom-Zoom On

Button: None

Key: None



Chapter 4 Viewing Data in FixMaster

35

Zooming to a Specific Zoom Level
You can set an exact zoom level.

To Zoom to a Specific Zoom Level:
1. On the View menu, click Zoom-Set Zoom Level.

FixMaster prompts for a zoom level.

Set Zoom Level

2. On the Set Zoom Level dialog, enter the zoom level and click OK .

FixMaster zooms to the zoom level you selected.

Menu: View-Zoom-Set Zoom Level

Button:    Type the zoom level into the control and then move the mouse into the
viewing area.

Key: Z
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Going To Specific Locations on Screen
FixMaster has many commands for going to specific location or specific types of data on screen.

Moving the Cursor Manually
You can manually move the cursor around on the viewing area using the mouse or the arrow keys.

Using the Mouse
Moving the mouse moves the cursor around the screen. You can use the mouse to move the cursor
outside the viewing area to click on menus and buttons, which is something you cannot do using the
arrow keys. When the screen grid is turned on, moving the cursor with the mouse allows you to
position the cursor off of the grid points, which is also something you cannot do using the arrow keys.

Using the Arrow Keys
Pressing the arrow keys moves the cursor up, down, left or right on the viewing area. When the screen
grid is turned on, pressing the arrow keys causes the cursor to hop from one grid point to the next. The
arrow keys cannot be used to move the cursor outside the viewing area to click on menus and buttons.
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Going To Specific X, Y Coordinates
You can go a specific X, Y coordinate.

To Go To Specific X, Y Coordinates:
1. On the View menu, click Go To-Coordinates.

FixMaster prompts for X and Y coordinates.

Move Cursor To dialog

2. On the Move Cursor To dialog, enter new X and Y coordinates and press the Enter key.

FixMaster moves the cursor to the X and Y coordinates.

Note: It is usually preferable to close the dialog using the Enter key instead of clicking OK.
Clicking OK can sometimes cause you to jiggle the mouse and move the cursor off of the
coordinates you set.

Menu: View-Go To-Coordinates

Button:  Click the X or Y buttons.

Key: X key or Y key

Selecting a Test Point or Pad
Selecting an element causes the cursor to hop to the nearest element, and the D Code, net number and
probe number of the selected element is displayed on the Status Bar.

To Select a Pad or Test Point:
� Position the cursor next to the test point or pad and press the S key.

Menu: None

Button: None

Key: S
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Going to the Last Selected Test Point
Pressing Ctrl+H  moves the cursor to the last selected test point. If the selected test point is off the
screen, FixMaster redraws the screen at the current zoom level with the selected test point in the
center. A green cross marks the selected test point.

To Go to the Last Selected Test Point:
� Press Ctrl+H .

Menu: None

Button: None

Key: Ctrl+H

Moving between a Test Point and its Grid Point
Pressing the E key moves the cursor from a selected test point to its assigned fixture grid point.
Pressing E again moves the cursor back to the selected test point. A green cross marks the selected test
point.

To Move between a Test Point and its Grid Point:
� Press the E key.

Menu: None

Button: None

Key: E

Going to the Next Highlighted Element
Pressing the N key moves the cursor sequentially to the next highlighted element. Use this command to
find every highlighted element in sequence. For the highlighting commands, see Highlighting Data On
Screen on page 26.

To Go to the Next Highlighted Element:
1. Highlight the elements.

2. Press the N key.

Menu: None

Button: None

Key: N
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Going To the Datum Point
You can move the cursor to the datum point. For information on setting the datum point, see Setting
the Datum Point on page 340.

To Go To the Datum Point:
� On the View menu, click Go To-Datum Point.

The cursor goes to the datum point.

Menu: View-Go To-Datum Point

Button: None

Key: None

Going To Unassigned Test Points
You can go to each unassigned test point. For more about unassigned test points, see Check for Design
Rule Errors on page 195.

To Go To Unassigned Test Points:
1. On the View menu, click Go To-Unassigned TP.

The Go To Unassigned Test Point tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential unassigned test point. The Go To Unassigned Test Point
tool remains selected until you select another tool or press the Escape key, so you can go to one
unassigned test point after another by clicking the mouse.

Menu: View-Go To-Unassigned TP

Button:

Key: None
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Going To Crossed Pins
You can go to each instance of crossed pins. For more about crossed pins, see Check for Design Rule
Errors on page 195.

To Go To Crossed Pins:
1. On the View menu, click Go To-Crossed Pins.

The Go To Crossed Pins tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential instance of crossed pins. The Go To Crossed Pins tool
remains selected until you select another tool or press the Escape key, so you can go to one
instance of crossed pins after another by clicking the mouse.

Menu: View-Go To-Crossed Pins

Button:

Key: None

Going To Breakouts
You can go to each instance of breakout errors. For more about breakouts, see Check for Design Rule
Errors on page 195.

To Go To Breakouts:
1. On the View menu, click Go To-Breakouts.

The Go To Breakouts tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential instance of breakouts. The Go To Breakouts tool remains
selected until you select another tool or press the Escape key, so you can go to one instance of
breakouts after another by clicking the mouse.

Menu: View-Go To-Breakouts

Button:

Key: None
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Going To Possibly Probeable Pads not Given Test Points
You can go to each instance of pads possibly covered by soldermask or silkscreen. For more about
pads that may be covered by silkscreen or soldermask, see Possibly Probeable, Possibly Covered Test
Points on page 148.

To Go To Possibly Probeable Pads not Given Test Points:
1. On the View menu, click Go To-Probeable TP.

The Go To Possibly Probeable Pads tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential possibly probeable pads not given a test point. Go To
Possibly Probeable Pads tool remains selected until you select another tool or press the Escape
key, so you can go to one possibly probeable ad after another by clicking the mouse.

Menu: View-Go To-Probeable TP

Button:

Key: None
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Using the Screen Grid
The program has a screen grid that can be used for precisely positioning the cursor. The grid can be
turned on and off as needed.

When the grid is on:

• The cursor moves only on the grid points when moved with the arrow keys.

• The cursor snaps to the closest grid point when you activate an editing command such as
insert, copy or move.

• The cursor can be moved off the grid using the mouse or by aligning to an element.

Some settings affect the behavior of the grid:

• The grid unit  determines the spacing of grid points.

• The space between grid points can be fixed at one interval or can be set to be variable
depending on the zoom level.

• The grid can be anchored so that it does not move, or it can be dragged by the cursor.

Turning the Screen Grid On or Off
You can turn the display of the screen grid on and off.

To Turn the Screen Grid On or Off:
1. On the View Menu, go to Screen Grid and look at Display Grid .

• If Display Grid has a checkmark, the grid is On.

• If Display Grid does not have a checkmark, the grid is Off .

2. Click Display Grid  to turn the grid on or off.

Menu: View-Screen Grid-Display Grid

Button:   Up = Off, Down = On

Key: G
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Anchored or Dragged Grid
The grid can be Anchored in place so that it does not move. When the grid is set to Anchored mode
and the cursor is moved, the cursor hops from one grid point to the next.

Or the grid can be Dragged so that it is moveable. When the grid is set to Dragged mode and the
cursor is moved, the cursor drags the grid to a new position.

Generally the grid is left in Anchored mode and is only put in Dragged mode when it needs to be
repositioned.

To Switch between an Anchored Grid and One that can be Dragged:
1. On the View Menu, go to Screen Grid and look at Anchored and Dragged. The position of

the bullet indicates the status of the grid:

• If there is a bullet on Anchored, the grid is stationary, and the cursor hops from one grid
point to the next.

• If there is a bullet on Dragged, the grid is moveable, and the cursor drags the grid.

2. To switch between the two states, click Anchored or Dragged.

Menu: View-Screen Grid-Anchored or Dragged

Button:   Up = Dragged, Down = Anchored

Key: Shift+G
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Fixed or Variable Grid
The grid can be set to Variable or Fixed mode. The difference between these two modes is the interval
displayed between grid dots.

• Variable Mode: The program changes the displayed grid interval so that a comfortable
number of grid dots appears on screen at any zoom level. The displayed grid interval will be
equal to a multiple of the grid unit. The possible grid intervals are grid unit times a power of
ten or any such value divided by two.

As you increase the zoom level, the grid interval becomes smaller to the point of the finest
resolution until it reaches the grid unit. It will never be smaller than the grid unit.

• Fixed Grid:  The interval displayed between grid dots is always equal to the grid unit, at any
zoom level. The grid interval does not change until the screen is almost filled with grid dots.
When there are too many dots to display, the grid becomes invisible, but it is still on.

To Switch between a Fixed Interval Grid and One that is Variable with Zoom:
1. On the View menu, go to Screen Grid and look at Variable and Fixed. The position of the

bullet indicates the status of the grid:

• If there is a bullet on Variable, the grid interval is variable depending on zoom level.

• If there is a bullet on Fixed, the grid interval is fixed regardless of zoom level.

2. To switch between the two states, click Variable or Fixed.

Menu: View-Screen Grid-Variable or Fixed.

Button:   Up = Fixed, Down = Variable

Key: Ctrl+G
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Grid Units
The grid unit is the basis of the grid interval, the space between grid points.

To Set the Grid Unit:
1. On the View menu, click Screen Grid-Units.

FixMaster prompts you to set the grid unit.

Grid Unit Dialog

2. On the Grid Unit  dialog, enter the new grid unit and click OK .

FixMaster displays the grid based on the new grid unit.

Menu: View-Screen Grid-Units.

Button:

Key: None
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Showing the Job Statistics
FixMaster can display a dialog that shows statistics for the current job.

To Show the Job Statistics:
� On the View menu, click Statistics.

Test Information Statistics Dialog

Menu: View-Statistics

Button: None

Key: F6
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Measuring Distance
FixMaster allows you to measure distance in the viewing area in two different ways. You can measure
the straight-line distance between two points in Distance Measurement Mode. Or you can use a relative
origin, which gives you the X and Y distances from one point to the other.

Using Distance Measurement Mode
When Distance Measurement Mode is on, the Status Bar shows distance between the current cursor
position and the point on screen where the cursor was when Distance Measurement Mode was turned
on.

To Measure Distance with Distance Measure Mode:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the D key.

FixMaster marks the starting point on screen with a yellow X and goes into Distance Measure
Mode. The Status Bar begins displaying the distance between the starting point on screen and the
cursor position.

Distance Displayed in Status Bar

3. Move the cursor to the point on screen where you want to measure distance to.

The Status Bar displays the distance between the starting point on screen and the cursor position.
FixMaster remains in Distance Measurement mode until you press D again.

Menu: None

Button: None

Key: D



FixMaster User’s Guide

48

Using the Relative Origin
Ordinarily the Screen Toolbar shows the cursor’s X and Y coordinate position relative to the absolute
origin, X=0, Y=0. When the Relative Origin is turned on, the Screen Toolbar shows cursor’s dx and dy
position relative to the Relative Origin, dx=0, dy=0. The Relative Origin, dx=0, dy=0, is the point on
screen where the cursor was when the Relative Origin was turned on.

To Measure Distance with the Relative Origin:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the R key.

FixMaster switches to Relative Origin Mode. Instead of the normal X, Y coordinates, the Screen
Toolbar begins displaying the cursor position as the dx and dy coordinates relative to the position
on screen where Relative Origin Mode was turned on.

Absolute Origin Mode

Relative Origin Mode

3. Move the cursor to the point on screen where you want to measure distance to.

The Screen Toolbar displays the dx and dy distance between the Relative Origin and the cursor
position. FixMaster remains in Relative Origin mode until you press R again.

Menu: None

Button: None

Key: R
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Metric or English Units
FixMaster can convert units of measurement for the current job between English and metric units.

To Select Metric or English Units:

1. On the Screen Toolbar, click the Coordinate Units drop down  and select either
Inches or mm.

FixMaster prompts, “Convert all data and parameters to metric/English?”

2. Click Yes.

FixMaster converts the database to the new units.

Menu: None

Button:

Key: None

Using the Reference Frame
FixMaster features a Reference Frame, which is used by many commands to select elements for an
operation. You can reposition and resize the Frame using a mouse-operated Frame-drawing tool.

To Draw a New Reference Frame:

1. On the Screen toolbar, click the New Window  button.

The New Window button stays down and the Frame-drawing tool is selected.

2. Position the cursor where you want one corner of the Frame to be to be. Then click the mouse
and drag the cursor to where you want the opposite corner.

The Frame-drawing tool remains selected until you select another tool or press the Escape key.

Menu: None

Button:

Key: Shift+W
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Chapter 5
Set Up the Fixture Configuration

Fixture Configuration is defined by:

• Fixture Plates: Plate size and spacing, plate materials and material characteristics

• Fixture Grid:  Grid type and spacing

• Fixture Design Rules: Maximum allowed Pin Deflection, and Breakout Gap

• Fixture Probes: Probe characteristics and rules for how the plates will be drilled to
accommodate the probes

About Dual-Sided Testing
FixMaster supports dual-sided testing, including tower testers that have a fixture for each side of the
board. When you set up the fixture parameters, you set them up for the currently active board side,
CMP or SOL. Be sure the correct board side, shown in the Status Bar, is active before you set up the
fixture plates, grids, probes, and tooling.

Using Boilerplate Jobs
All fixture configuration settings can be saved in a .JOB file. If you typically have similar jobs, you
can open a previously saved boilerplate .JOB file, import the new PCB data, and begin processing
without having to reset all of the fixture configuration settings.

Lavenir Technical support has many sample fixture files available for download from the Lavenir FTP
site. For more information on how to get boilerplate fixture files to use as starting points for your own
fixture designs, contact Lavenir Technical support. See Lavenir Technical Support on page 4.
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Setting up the Fixture Plates
Plate size and spacing, plate materials and material characteristics are part of the fixture setup.

To Set up the Fixture Plates:
1. On the View Menu, click Active Side, and select the Active Board Side for which you want

to configure the fixture.

There are two fixture configuration tables, one for component-side fixtures and one for solder-side
fixtures. If you are setting up the two fixtures of a tower tester, set up one set for the currently
active side, then come back and set up the other side.

2. On the Setup Menu, click Fixture-Fixture Table .

3. On the Fixture Setup dialog, click the Fixture Plates tab.

4. Set the plate settings described below for each plate and space.

Fixture Plates Tab
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Item Number
There are two Fixture Plates tables, one for each board side. Each Fixture Plates table has 49 items.
The items are numbered sequentially from the top of the fixture.

To get the plate numbers referred to in the Plates Toolbar and elsewhere, plates are numbered
sequentially beginning with the top plate. Spaces and unused items are not counted.

Note: If you are using headless probes, begin the Fixture Plates table with the top plate.
If you are using probes with heads, begin the table with a space above the top plate. This
space represents the head lengths of your probes. Enter an S in the Type field for the space
above the fixture and enter the head length in the Thickness field.

Type
Each item can be a plate (P), a space (S), or an unused item (U). Enter an S or P for each sequential
space and plate in your fixture and leave the remaining Type fields marked U, for unused.

Thickness
For each plate or space in your fixture enter a value for the plate thickness or space height in the
Thickness field.

Drill Oversize
If you are going to have FixMaster automatically calculate drill sizes for probe drills by adding an
oversize factor to the probe Shaft Diameter on the Probe Setup tab of the Probe Setup dialog, enter a
value into the Drill Oversize field for each plate.

If you are going to manually assign drill sizes, or have FixMaster automatically assign hole sizes from
the drill bit table, the Drill Oversize value on this table has no meaning.

For information on different ways to set the drill size for probe drills, see Set up Drill Size for Probe
Drills  on page 73.

Tooling
When the drill files are exported, you have the option to export tooling holes imported in the PCB data
as drills in fixture plates. This feature is used to mount alignment pins on the fixture that match holes
drilled into the PCB. Tooling holes must be properly set up in the D Code Probe Map and the Probe
Table in order to be output correctly.

If you want to output tooling holes for a particular plate, enter a checkmark for the Tooling option,
otherwise leave the Tooling field blank for that particular plate.

For complete information on setting up Tooling Holes, see PCB Tooling Holes and Fixture Alignment
Pins on page 385.

Material
You can assign each plate a material with unique feed and spindle rates for different tool sizes. These
rates will be output in the drill files. If you want to output feed and spindle rates for each plate, enter a
material number (1-5) in the Material field and click the Materials Tab to set up the Material Table.
See Setting up Fixture Plate Materials on page 55.
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Breakout
FixMaster can check for breakouts between probe drills in each plate. If the edges of drills in a plate
are closer than the Breakout Gap set on the Cross Check Options dialog, FixMaster will flag the
breakout errors. For some plates, such as stiffener plates, you may not care about breakouts.

If you want to check a plate for breakouts, enter a checkmark in the Breakouts field for that plate and
set the Breakout Gap by going to the Setup menu and clicking Fixture-Cross Check. Otherwise leave
the Breakouts field for that plate blank.

For more information on setting the breakout gap, see Fixture Plate Breakout Gap on page 60. For
information on checking a job for breakout errors, see Check for Design Rule Errors on page 195.

Base Plate Holes
The locations for base plate hole drills can be calculated in three ways:

• On Grid:  Base plate holes can be drilled exactly at the grid point locations, in which case
drill locations for the other plates are calculated as though the probe were going to end at the
top of the base plate. This option is usually used if you are using a base plate that has been
pre-drilled on the grid interval.

• Off Grid:  Another way to calculate the position of the base plate holes is to consider the pins
to hang down beyond the base plate to contact the grid. In this case, the length of the pin hang
is used when calculating the drill locations for all plates, including the base plate, and the drill
is placed where the pin would go through the center of the plate. The pin hang is the space
below the bottom plate. To calculate the base plate hole positions using this method, select
Off Grid for the Base Plate Holes option. Then enter an S in the Type field for the space
below the fixture and enter the pin hang in the Thickness field.

• New Off Grid:  Another way to calculate the position of the base plate holes is to consider the
pins to stop at the bottom of the base plate and not to hang down below the plate. In this case,
the length of the pin hang is not used when calculating the drill locations and the drill is
placed where the pin would go through the center of the plate. To calculate the base plate hole
positions using this method, select New Off Grid for the Base Plate Holes option.

Height
FixMaster calculates and displays the height of your fixture, including all plates and space in use, in
the Height field.
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Setting up Fixture Plate Materials
You can assign each plate a material with unique feed and spindle rates for different tool sizes. These
rates will be output in the drill files. If you want to output feed and spindle rates for each plate, enter a
material number (1-5) in the Material  field of the Fixture Plates tab on the Fixture Setup dialog, and
then set up the Material Table. For information on the Fixture Plates tab, see Setting up the Fixture
Plates on page 52.

To Set up the Material Table:
1. On the Setup Menu, click Fixture-Fixture Table .

2. On the Fixture Setup dialog, click the Material Table tab.

3. Set the material settings described below for each material.

Fixture Setup Materials Tab

Material Number
The material number identifies the material that you are currently setting up on the Material Table.
This is also the number used to identify the material used for each plate in the Fixture Plates Table.
FixMaster allows you to configure as many as 5 materials per job. Change the material with which you
are currently working by clicking the Next Material or Previous Material buttons.
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Material Name
You may assign each material a unique name for your own use in the Material Name Field. The
material name is not output in the drill files.

Minimum and Maximum Size Range
In the Minimum and Maximum fields, enter the minimum and maximum drill diameters which you
want to assign to a particular feed and spindle rate for this material.

Feed Rate
In the Feed field, enter the feed rates assigned to the drill size range for this material.

For Excellon, the feed rate is in ipm

For Sieb & Meyer, the feed rate is in 0.1m/min.

Spindle Rate
In the Spindle field, enter the spindle rates assigned to the drill size range for this material.

Spindle speed is in 1000 rpm for both Excellon and Sieb & Meyer.
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Setting up the Fixture Pin Loading Plate
FixMaster can automatically generate drill files for Fixture Pin Loading Plates when exporting the drill
files for the fixture drills. The system generates one file for each probe used in the fixture, and extends
the file name with the letter B followed by the probe number.

To Set up the Fixture Pin Loading Plate:
1. On the Setup Menu, click Fixture-Fixture Table .

2. On the Fixture Setup dialog, click the Fixture Loading Plate tab.

3. Set the Fixture Loading Plate settings described below.

Fixture Loading Plates Tab

Output Fixture Loading Plates
To generate Fixture Pin Loading Plates when exporting the drill files, enter a checkmark for the Output
Fixture Loading Plates option.
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Plate Number
Enter the Plate Number of the plate that you want to set up as the Fixture Loading Plate. The Plate
Number corresponds to the Plate Number as it would appear on the on the Plates toolbar, not the Item
Number on the Fixture Plates tab.

To get the plate numbers referred to in the Plates Toolbar and elsewhere, plates are numbered
sequentially beginning with the top plate on the Plates tab. Spaces and unused items are not counted,
only plates.

Drill Oversize
When automatically calculating drill sizes, FixMaster adds the Drill Oversize value to the probe shaft
diameter.

Add Tooling
When the drill files are exported, you have the option to export tooling holes imported in the PCB data
as drills in Fixture Loading plates. If you want to output tooling holes for the Fixture Loading plates,
enter a checkmark for the Tooling option, otherwise leave the Tooling field blank. For more
information on tooling holes in FixMaster, see PCB Tooling Holes and Fixture Alignment Pins on page
385.
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Setting up the Fixture Design Rules
FixMaster allows you to set up certain design rules to use when the program calculates the position of
the fixture probes. You can set a maximum allowable pin deflection for each side of the board and a
minimum allowable breakout gap between probe holes in a plate.

To Set up the Fixture Design Rules:
1. On the Setup menu, click Fixture-Cross Check.

2. On the Cross Check Options dialog, set the following design rules settings:

Cross Check Options

Fixture Pin Deflection
Set the maximum allowable pin deflection for both sides of the board, CMP and SOL. A typical
maximum pin deflection is about 10% of the pin length.

In an operation called dropping pins, FixMaster calculates how to position probes in order to assign
test points to fixture grid points. The program assigns test points to the closest available grid point,
achieving the lowest possible pin deflection. As board density increases, FixMaster may have to
increase the pin deflection to find grid points for all test points.

If the only available grid points for a particular test point exceed the maximum allowed pin deflection,
FixMaster will not automatically assign that test point to the grid. You can correct this problem later
with the error checking and error correction procedures. See Check for Design Rule Errors on page
195. The maximum allowable pin deflection is also used when you are setting up drill sizes manually.
See Set up Drill Size for Probe Drills on page 73.
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Fixture Plate Breakout Gap
Set the breakout gap distance allowed between neighboring drills.

When FixMaster assigns test points to grid points, the program determines the location and size of the
probe drills. Breakouts can occur in fixture plates if the distance between two drills is too small. You
can set the breakout gap distance allowed between two neighboring drills. Breakout errors occur when
the distance between the edges of drills is smaller than the breakout gap distance you set. Breakout
errors can be found and corrected using the error checking and correction procedures. For information
on checking a job for breakout errors, see Check for Design Rule Errors on page 195.

For some plates, such as stiffener plates, you may not care about breakouts, so FixMaster gives you the
option to check for breakouts on a plate-by-plate basis.

To Check a Plate for Breakouts:
1. Enter a Breakout Gap distance here.

2. Then go to the Setup menu and click Fixture-Fixture Table .

3. On the Fixture Plates tab, click the Breakout column so that each plate you want to check
has a checkmark. Leave the Breakout field blank for plates that you do not want to check
(such as stiffener plates).
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Setting up the Fixture Grids
FixMaster allows you to set up tester grids for both sides of the board. The procedure for setting up the
grid depends on the type of grid you want to set up:

• Single-Density Grid

• Dual-Density Grid

• Quad-Density Grid

• Dedicated Fixture

• TTI 1400TG Shared Grid

Note: Setting up the Fixture Grid does not affect the Screen Grid.

Single-Density Grids
Single-density grids have the same grid interval over the entire grid field, generally .100 inches.

To Set up a Single-Density Grid:
1. On the Setup menu, click Fixture-Grid .

Customize Fixture Grid

2. On the Customize Grid dialog, select the side of the board to be tested on this grid.

There are two sets of grids that you can set up. One is for testing the component side of the PCB
and one for the solder side. You can set them up separately, or if they have the same parameters,
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you can set them up simultaneously. Select Component, Solder, or Both. Later, when the data is
written out, you map the component-side and solder-side to the top and bottom grids of the tester.

3. Select Manual and click OK .

Change Grid Dialog

4. On the Change Grid dialog, set up the single-density grid field and intervals.

FixMaster allows you to define up to 10 fixture grid fields and intervals for component-side and
solder-side fixture grids. For a single-density grid you will only need to set up one grid field per
side.

5. For a given Grid Field, enter the X and Y intervals between grid points in the Grid X  and
Grid Y  fields.

6. Define the dimensions of the grid field by entering the grid starting coordinates relative to the
absolute origin in the Start X, Y fields and the ending coordinates in the End X, Y fields.

The grid size must be an exact multiple of the grid interval. Be sure to enter the Grid X and Y
intervals first. Next enter the Start X, Y coordinates, and then the End X, Y coordinates. FixMaster
will recalculate the grid ending coordinates to exactly match the grid interval.

7. Turn the grid field on by clicking in the On field so that there is a checkmark. For all the other
grid fields that are not used for a single-density grid, click so that there is no checkmark.
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8. If you want FixMaster to reposition the PCB when you drop pins, click in the Move PCB
When Dropping Pins field so that there is a checkmark. Otherwise, click so that there is no
checkmark.

FixMaster can move the PCB when dropping pins so that the maximum number of through-hole
test points are directly above a grid point. This way the most through-hole test points can be
assigned to grid points with zero deflection.

At most this operation will move the PCB by one grid interval, so you should still use one of the
positioning routines to put the PCB approximately where you want it. If you position the PCB
exactly where you want it, and do not want it to move by even one grid interval, do not use this
option. For information on positioning the PCB data, see Position the PCB on page 119.

9. Click OK .
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Dual-Density Grids
Dual-density grids are like two single-density grids, with the same X and Y intervals, offset from each
other by half their X and Y intervals. This yields a grid with twice as many grid points as a single-
density grid. The interval is the distance from one grid point to the next grid point directly on the X
and Y axes. The closest grid point to any other grid point is on the diagonal.

For example, a typical dual-density grid would be set up as two single-density grids with .100-inch X
and Y intervals. The second grid would be offset from the first by .050 inches in both the X and Y
directions. Grid points would be separated by .070 inches on the diagonal.

Some testers do not have a dual-density grid over the entire grid field — they are single density for
much of the field and have a smaller region of dual density.

To Set up a Dual-Density Grid:
1. On the Setup menu, click Fixture-Grid .

Customize Fixture Grid

2. On the Customize Grid dialog, select the side of the board to be tested on this grid.

There are two sets of grids that you can set up. One is for testing the component side of the PCB
and one for the solder side. You can set them up separately, or if they have the same parameters,
you can set them up simultaneously. Select Component, Solder, or Both. Later, when the data is
written out, you map the component-side and solder-side to the top and bottom grids of the tester.

3. Select Manual and click OK .
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Change Grid Dialog

4. On the Change Grid dialog, set up the grid fields and intervals.

FixMaster allows you to define up to 10 fixture grid fields and intervals for component-side and
solder-side fixture grids. For a dual-density grid you will need to set up two grid fields.

5. For the first Grid Field, enter the X and Y intervals between grid points in the Grid X  and
Grid Y  fields.

6. Define the dimensions of the grid field by entering the grid starting coordinates relative to the
absolute origin in the Start X, Y fields and the ending coordinates in the End X, Y fields.

The grid size must be an exact multiple of the grid interval. Be sure to enter the Grid X and Y
intervals first. Next enter the Start X, Y coordinates, and then the End X, Y coordinates. FixMaster
will recalculate the grid ending coordinates to exactly match the grid interval.

7. Turn the grid field on by clicking in the On field so that there is a checkmark.

8. For the next grid field in the same board-side table, enter the Grid X, Y  intervals for the dual-
density portion of grid. This interval will be the same as the previous grid’s interval.
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9. Enter the Start X, Y coordinates and the End X, Y coordinates for the dual-density portion of
grid.

• If the entire grid field is dual density, the starting and ending coordinates will be offset
from the first grid by half the grid interval.

• If only part of the grid field is dual density, the starting and ending coordinates will be
offset from the first grid by the larger offset for the dual-density region plus half the grid
interval.

• The grid size must be an exact multiple of the grid interval.

10. Turn the second grid field on by clicking in the On field so that there is a checkmark. For all
the other grid fields that are not used for a dual-density grid, click so that there is no
checkmark.

11. If you want FixMaster to reposition the PCB when you drop pins, click in the Move PCB
When Dropping Pins field so that there is a checkmark. Otherwise, click so that there is no
checkmark.

FixMaster can move the PCB when dropping pins so that the maximum number of through-hole
test points are directly above a grid point. This way the most through-hole test points can be
assigned to grid points with zero deflection.

At most this operation will move the PCB by one grid interval, so you should still use one of the
positioning routines to put the PCB approximately where you want it. If you position the PCB
exactly where you want it, and do not want it to move by even one grid interval, do not use this
option. For information on positioning the PCB data, see Position the PCB on page 119.

12. Click OK .
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Quad-Density Grids
Quad-density grids have an interval that is half the interval of a single-density grid, in both the X and
Y directions, generally .050 inches. This yields a grid with four times the grid points of a single-
density grid.

To set up a quad-density grid over the entire field, set it up as one single-density grid with the tighter X
and Y intervals.

Some testers do not have a quad-density grid over the entire grid field. They are single density for
much of the field and have a smaller region of quad density.

To Set up a Quad-Density Grid over a Portion of the Grid Field:
1. On the Setup menu, click Fixture-Grid .

Customize Fixture Grid

2. On the Customize Grid dialog, select the side of the board to be tested on this grid.

There are two sets of grids that you can set up. One is for testing the component side of the PCB
and one for the solder side. You can set them up separately, or if they have the same parameters,
you can set them up simultaneously. Select Component, Solder, or Both. Later, when the data is
written out, you map the component-side and solder-side to the top and bottom grids of the tester.

3. Select Manual and click OK .
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Change Grid Dialog

4. On the Change Grid dialog, set up the grid fields and intervals.

FixMaster allows you to define up to 10 fixture grid fields and intervals for component-side and
solder-side fixture grids. For a quad-density grid you will need to set up two grid fields, the larger
single-density field and the smaller quad density portion.

5. In the first Grid Field, enter the Grid X  and Grid Y  intervals between grid points for the
larger single-density grid field.

6. Define the dimensions of the larger single-density grid field by entering the grid starting
coordinates relative to the absolute origin in the Start X, Y fields and the ending coordinates
in the End X, Y fields.

The grid size must be an exact multiple of the grid interval. Be sure to enter the Grid X and Y
intervals first. Next enter the Start X, Y coordinates, and then the End X, Y coordinates. FixMaster
will recalculate the grid ending coordinates to exactly match the grid interval.

7. Turn the larger single-density grid field on by clicking in the On field so that there is a
checkmark.

8. For the next grid field in the same board-side table, enter the Grid X, Y  intervals for the
quad-density portion of grid. This interval will be half the larger single-density grid’s interval
in each direction.
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9. Enter the Start X, Y coordinates and the End X, Y coordinates for the quad-density portion
of grid. Both the starting and ending coordinates need to be exact multiples of the grid interval
so that the quad-density portion will overlay the larger single-density portion

10. Turn the quad-density grid field on by clicking in the On field so that there is a checkmark.
For all the other grid fields that are not used for a quad-density grid, click so that there is no
checkmark.

The second grid will overlay the first. Grid points from the two grids that have exactly the same
coordinates are treated as one grid point, so that FixMaster sees a field of grid points at single
density with a portion at quad density.

11. If you want FixMaster to reposition the PCB when you drop pins, click in the Move PCB
When Dropping Pins field so that there is a checkmark. Otherwise, click so that there is no
checkmark.

FixMaster can move the PCB when dropping pins so that the maximum number of through-hole
test points are directly above a grid point. This way the most through-hole test points can be
assigned to grid points with zero deflection.

At most this operation will move the PCB by one grid interval, so you should still use one of the
positioning routines to put the PCB approximately where you want it. If you position the PCB
exactly where you want it, and do not want it to move by even one grid interval, do not use this
option. For information on positioning the PCB data, see Position the PCB on page 119.

12. Click OK .

Dedicated Fixtures
Dedicated fixtures are fixtures that sit on top of a grid of one interval and translate it into a grid of a
smaller interval. This creates a denser fixture grid and allows for testing denser parts.

The test fixture sits on top of the dedicated fixture and needs to be designed for the smaller grid
interval. The tester download files need to be generated for the larger grid interval. If you use dedicated
fixtures, call Lavenir Technical Support at (925) 680-7400 between the hours of 8 AM and 5 PM,
Pacific Standard Time, for a case-by-case analysis of your requirements.

TTI 1400TG Shared Grid
The TTI Model 1400TG Tester has a shared grid that is supported by FixMaster.

The two options, TTI 1400TG Type 1 and Type 2, are for this tester’s shared grid.

For these testers set the component side Start X and the Start Y values at (0,0), and set up the size of
the grid field and the intervals as you would for a single density grid. The solder side grid will
automatically be offset (.8, .8) from the component side grid.
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Setting up the Probes
Using the Probe Setup dialog, you define the parameters for the probes that will be used to test pads on
the currently active side of the board. This table is also used to set up tooling holes read in from the
PCB data.

Shaft and head diameters, air gaps, and stagger margins are used when running fixture-design rule
checks, staggering test points, and calculating drill sizes. These parameters must be defined before
staggering test points or dropping pins.

To Set up the Probes:
1. On the View Menu, click Active Side, and select the Active Board Side for which you want

to set up probes.

There are two Probe Setup tables, one for component-side fixtures and one for solder-side fixtures.
If you are setting up probes for the two fixtures of a tower tester, set up one set for the currently
active side, then come back and set up the other side.

2. On the Setup Menu, click Fixture-Probe.

3. On the Probe Setup tab of Probe Setup dialog, set the following settings.

Probe Setup Tab
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Probe Types
Each probe you set up may be appropriate to probe one kind of pad, but not another. Each D Code to
be tested will be mapped to a Probe Code, meaning that a probe having that Probe Code will be used to
test pads of that D Code.

FixMaster can map the PCB D Codes to the Probe Codes in this table automatically or you can map
them manually. For information on mapping D Codes to Probes, see Map D Codes to Probe Codes on
page 129.

If you are going to have FixMaster automatically map D Codes to Probe Codes, you must set up the
probe Types and Pad Min and Max size ranges. These settings are not important if you are manually
mapping D Codes to Probe Codes.

When FixMaster is mapping D Codes to Probe Codes automatically, the program takes each D Code
and looks for Probe Codes of the correct Type and then checks whether the Pad Min and Max size
range matches the D Code size. The first Probe Code in the list that matches the Type and Pad Min and
Max size criteria is mapped to the D Code.

• For probes for through-hole drills, enter H.

• For probes for surface-mount pads (SMD), enter S.

• For probes for both through-hole drills and surface-mount pads, enter B.

• For Tooling Holes, enter T.

Note: In addition to setting up Probes, the Probe Setup tab of the Probe Setup dialog is also
used to set up diameters for Tooling Holes read in from the PCB data. For a complete
discussion of tooling holes, see PCB Tooling Holes and Fixture Alignment Pins on
page 385.
For Tooling Holes, enter T in the Type field. A type-T probe isn't actually a probe.
FixMaster uses the diameter of the type-T probe as the Tooling Hole size. This will be the
size of the Tool Code in the drill output files.
Enter the size you want the tooling hole to be drilled to in the Shaft Dia field. The Drill
Oversize parameter on the Fixture Plates tab of the Fixture Setup dialog is not added to
this size.

Shaft Diameter
Enter the shaft diameter of each probe in the Shaft Dia field. The Shaft Diameter of the probe is used
to check for Pin Crossing and for automatically calculating probe drill sizes.

There are several ways to calculate the sizes of the probe drills and these are all explained in Set up
Drill Size for Probe Drills on page 73. When you select the option to have FixMaster automatically
calculates drill sizes for probes the program uses this Shaft Diameter. The Shaft Diameter and the Drill
Oversize parameter on the Fixture Plates tab of the Fixture Setup dialog are both used when calculating
the tool size needed to drill these holes.
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Head Diameter
Enter the head diameter of each probe in the Head Dia field. The Head Diameter of the probe is used
for Head Butt error checking. If the probe is headless, make the head diameter equal to its shaft
diameter. For information on Head Butt errors, see Check for Design Rule Errors on page 195.

Air Gap
Enter an air gap for each probe in the Air Gap  field. The Shaft Diameter and Head Diameter of each
probe is swelled by its Air Gap when checking for Crossed Pins and Head Butts. For information on
Crossed Pins and Head Butt errors, see Check for Design Rule Errors on page 195.

Margin
Enter a stagger margin for each probe in the Margin  field. The Margin is used when staggering test
points. For surface-mount pads, the margin is how much to set back the test point from the pad edge.
For through-hole pads, the margin is either the amount to stagger the test point inward from the hole
edge or the amount to stagger the test point outward from the hole center point. You can also enter a
negative margin and stagger the test point outward from the hole edge to probe the covering pad. The
option to measure from the edge or from the center point is set on Setup-Test Point-Stagger, along
with the option to stagger the test point toward the top, bottom, right or left of the pad. For more
information about staggering test points, see Stagger Test Points on page 165.

Pad Min and Max
If you are going to have FixMaster automatically map D Codes to Probe Codes, you must set up the
probe Types and Pad Min and Max size ranges. These settings are not important if you are manually
mapping D Codes to Probe Codes. For information on mapping D Codes to Probes, see Map D Codes
to Probe Codes on page 129.

Enter the smallest pad size that can be probed by each probe in the Pad Min field, and the largest in
Pad Max.
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Set up Drill Size for Probe Drills
One of the most important fixture-design features of FixMaster is its ability to generate drill files
for making the fixture plates. When test points are assigned to grid points, the program
automatically determines the locations of the drills needed in each plate to accommodate the
probes. FixMaster gives you several options for determining the drill sizes for each probe drill:

• Drill Bit Table:  Automatically pick the best hole size from a Drill Bit table based on a
formula for pin deflection. This is the recommended procedure. See Automatically Pick
Best Fit to Drill Bit Table on page 74.

• Manual Setup: Manually set up a plate-by-plate, probe-by-probe hole size table for a
range of pin deflections. This is an accurate, but time-consuming, method. See
Manually Set Up Probe Hole Size Table on page 78.

• Plate-by-Plate Oversize Factor: Automatically calculate hole size based on probe
diameter plus plate-by-plate oversize factor. This is convenient and quick, but not as
accurate as the other methods. See Automatically Calculate Hole Size Based on Plate
Oversize on page 81.
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Automatically Pick Best Fit to Drill Bit Table
FixMaster can automatically pick the best probe hole size from a Drill Bit table based on a formula for
pin deflection. To do this, FixMaster calculates the exact hole size needed to accommodate a probe of
the given diameter in a plate of the given thickness at a deflection of the given range. Then it adds a
Drill Oversize factor, if you specify. Then it searches the Drill Bit Table for the smallest drill bit that is
large enough to accommodate the hole.

To Automatically Pick Best Fit to Drill Bit Table:
1. If you want FixMaster to automatically pick the best probe hole size from a Drill Bit table

based on a formula for pin deflection, then you must first set up the Drill Bit table.

2. If you are in the Probe Setup dialog, click OK  to exit the dialog for now.

3. On the Setup menu, click Fixture-Drill Bit Table .

Drill Bit Table

4. On the Drill Bit  table, enter Drill Bit Sizes that you want to have available for drilling probe
holes in fixture plates.

5. Click the On/Off  check boxes so that the sizes you want to use for a given job are on and the
others are off. A checkmark indicates that a given drill bit is available. No checkmark means a
given drill bit will not be used.

6. Click Ok.
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7. On the Setup Menu, click Fixture-Probe.

8. On the Probe Setup tab of the Probe Setup dialog, click the Manual Drill Size option.

Probe Setup Tab

9. Click on the Manual Drill Size tab of the Probe Setup dialog.
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Manual Drill Size Tab

The numbers in the plate column represent the plates of the fixture, which you set up on the
Fixture Plates tab of the Fixture Setup dialog. Plates are numbered sequentially beginning with the
top plate. For more information on the Fixture Plates tab, see Setting up the Fixture Plates on page
52.

The percentages in the top row correspond to a percentage of the Maximum Pin Deflection, which
you set on the Cross Check Options dialog. See Fixture Pin Deflection on page 59.

The numbers in the body of the table are the hole sizes for the selected probe in each plate at each
deflection range.

10. On the Manual Drill Size tab, select the Probe Number you want to set up.

The Probe Number is the Probe Code with which you are currently working. You can select a
different Probe Code by clicking the Next Probe or Previous Probe buttons.
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11. On the Manual Drill Size tab, you may set a Probe Name for the probe you are working
with.

You may assign each probe a unique name for your own reference or accept the default name. The
probe name does not affect the output files, but if you would like to use probe names for your own
reference, enter them in the Probe Name field.

12. On the Manual Drill Size tab, you may set a Drill Oversize.

If you want FixMaster to enlarge the hole size that it calculates for the probe, enter a value for the
Drill Oversize.

The other two options for calculating probe holes sizes do not use this Drill Oversize value.

• If you are going to manually assign drill sizes, the Drill Oversize value has no meaning.
See Manually Set Up Probe Hole Size Table on page 78.

• If you are going to have FixMaster automatically calculate drill sizes for probe drills by
adding an oversize factor to the probe Shaft Diameter on the Probe Setup dialog, then do
not use this Drill Oversize setting. Instead, set up the Drill Oversize field for each plate
on the Fixture Plates table. For information on the Fixture Plates table, see Setting up the
Fixture Plates on page 52. For information on automatically calculating drill sizes for
probe drills, see Automatically Calculate Hole Size Based on Plate Oversize on page 81.

13. On the Drill Size Based on Pin Deflection Table, select a range of plates and pin deflections
for which you want to have FixMaster calculate hole sizes. Typically you would drag the
cursor to select all the plates in the fixture at all the deflection ranges.

14. Click on Find Drill Size.

FixMaster calculates the exact hole size needed to accommodate a probe of the given diameter in a
plate of the given thickness at a deflection of the given range. Then it adds the Drill Oversize, if
any. Then it searches the Drill Bit Table for smallest drill bit that is large enough to accommodate
the hole.

15. On the Manual Drill Size tab, select the next Probe Number you want to set up and repeat
the process.

16. When you are done setting up drill sizes for Probes, click Ok.
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Manually Set Up Probe Hole Size Table
You can manually set up the drill sizes for probe drills.

To Manually Set Up Probe Hole Size Table:
1. On the Setup Menu, click Fixture-Probe.

Probe Setup Tab

2. On the Probe Setup tab of Probe Setup dialog, click the Manual Drill Size option.

3. Click on the Manual Drill Size tab.
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Manual Drill Size Tab

4. On the Manual Drill Size tab, select the Probe Number you want to set up.

The Probe Number is the Probe Code with which you are currently working. You can set
parameters for a different Probe Code by clicking the Next Probe or Previous Probe buttons.

5. On the Manual Drill Size tab, you may set a Probe Name for the probe you are working
with.

You may assign each probe a unique name for your own reference or accept the default name. The
probe name does not affect the output files, but if you would like to use probe names for your own
reference, enter them in the Probe Name field.
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6. On the Drill Size Based on Pin Deflection Table, enter the drill sizes to be used for the
current probe for each deflection range in each plate.

The numbers in the plate column represent the plates of the fixture, which you set up on the
Fixture Plates tab of the Fixture Setup dialog. Plates are numbered sequentially beginning with the
top plate.  For more information on the Fixture Plates tab, see Setting up the Fixture Plates on
page 52.

The percentages in the top row correspond to a percentage of the Maximum Pin Deflection, which
you will set on the Cross Check Options dialog. See Fixture Pin Deflection on page 59.

7. Do not set the Drill Oversize.

8. Do not click on Find Drill Size.

9. On the Manual Drill Size tab, select the next Probe Number you want to set up and repeat
the process.

10. When you are done setting up drill sizes for Probes, click Ok.
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Automatically Calculate Hole Size Based on Plate Oversize
To Automatically Calculate Hole Size Based on Plate Oversize:
If you are going to have FixMaster automatically calculate the hole size by adding the Drill Oversize
factor for each plate to the Shaft Diameter of each probe, then you will have already set up the Drill
Oversize factor for each plate on the Fixture Plates dialog. See Setting up the Fixture Plates on page
52. And you will have set up the Shaft Diameter for each probe on the Probe Setup tab of the Probe
Setup dialog. See Setting up the Probes on page 70.

1. On the Setup Menu, click Fixture-Probe.

Probe Setup Tab, with Auto Drill Size Option

2. On the Probe Setup tab of Probe Setup dialog, click on the Auto Drill Size option.

3. You do not need to set up anything on the Manual Drill Size tab of the Probe Setup dialog.

4. Click Ok.
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Chapter 6
Set Up the Fixture Outside Tooling

FixMaster has features to help you set up the fixture outside tooling. You can import drill files, set up
Tool Codes, and edit drills in fixture plates.

Tool Codes
Each drill in the fixture is identified by its Tool Code. Tool Codes for fixture outside tooling are set up
in the Fixture Tool Table.

Setting up the Tool Codes for Outside Tooling
Set up the Tool Codes for outside tooling on the Fixture Tool Table.

To Set up the Tool Codes for Outside Tooling:
1. On the Setup menu, click Fixture-Tool Table.

Fixture Tool Table

2. On the Fixture Tool Table, for each Tool Code you intend to use, enter a diameter.

Menu: Setup-Fixture-Tool Table

Button: None

Key: None

The Fixture Tool Table displays the following information.

Tool Code
The number at the left of the table is the Tool Code used to identify the particular tool.
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Counts of Tool Codes
The Counts column of the Fixture Tool Table indicates how many times the Tool Code is used for
outside tooling in the fixture drills of the current .JOB file.

Tool Diameters
The diameter column of the Fixture Tool Table indicates the diameter of the hole drilled by the given
Tool Code.

Diameters are in inches or millimeters as indicated in the Units control on the Status Bar

If you change the diameter of a Tool Code that has been used already, FixMaster displays drills of that
Tool Code at the new size.

Tool Codes for Probe Drills
When you assign test points to grid points, FixMaster calculates the sizes and locations of the drills
needed to accommodate the probes in the fixture, but FixMaster does not map Tool Codes to the probe
drills until drill data is exported. When the drill files are exported, FixMaster assigns drills to existing
Tool Codes of the correct size. If there are no existing Tool Codes of the correct size, FixMaster
assigns drills to unused Tool Codes and makes them the correct size. This procedure is used regardless
of whether the drill sizes are calculated automatically or are entered manually.

Current Tool Code
Many commands, such as Insert Drill, refer to the Current Tool Code.

The Current Tool Code and its diameter are displayed in the Status Bar at the bottom of the FixMaster
application window.

You can set the Current Tool Code in several ways:

To Set the Current Tool Code on the Fixture Tool Table:
1. On the Setup menu, click Fixture-Tool Table.

2. On the Fixture Tool Table, click on the Tool Code you want.

3. Click OK .

Menu: Setup-Fixture-Tool Table

Button: None

Key: None

To Set the Current Tool Code from the Command Menus:
1. On the Edit  menu, click Fixture-Drill-Change Tool .

2. Enter the Tool Code you want.

3. Click OK .

Menu: Edit-Fixture-Drill-Change Tool

Button: None

Key: None
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Plate Toolbar
Only Active, Visible Plates are available for drill editing.

The Plate Toolbar indicates which plates are visible and which are active for drill editing.

Plate Toolbar

Plate Numbers
The Plate Toolbar has a row of plate numbers that indicate which plates are active and visible for
editing. Plates are numbered starting from the top of the fixture.

Plate 0
Plate 0 is a special global plate. Drills that go through all the fixture plates at the same size and
location should be put in Plate 0.

Plates 1-39
These are the individual fixture plates numbered starting from the top of the fixture. You can edit drills
in individual plates. Some fixture types require certain holes, such as alignment holes, to be on only
specific plates, and this option allows you to accomplish this.
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Active Plate
You can set a single active plate or have multiple active plates.

Single Active Plate
The plate number of the single active plate is outlined with a black rectangle.

To Make a Single Plate Active:
1. Click the button at the bottom of the Plate Toolbar so that it says One Active.

One Active Plate

2. Click on the Plate Number in the Plate Toolbar.

Menu: None

Button:

Key: None

Multiple Active Plates
If the button at the bottom of the Plate Toolbar says All Active, then all visible plates are active and
available for drill editing.

Note: When the Insert Drill command is activated with all visible plates active, drills are only
inserted into plates that already have drills.

To Make Multiple Plates Active:
1. Click the button at the bottom of the Plate Toolbar to so that it says All Active .

All Visible Plates Active

2. Double-click on the Plate Numbers in the Plate Toolbar so that only the plates you want to
be active are visible.

Menu: None

Button:

Key: None
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Plate Visibility
Only visible plates may be edited. Next to each Plate Number in the Plate Toolbar is a colored
rectangle which indicates if the plate is visible.

Visible Plates
If the rectangle is shown in solid color, the plate is visible, and drills in that plate are shown in that
plate color on screen.

Plates Not Visible
If the rectangle is shown in a crosshatched pattern, the plate is not visible, and drills in that plate are
not shown on screen.

Change Plate Visibility
To Change the Visibility of a Single Plate:
� Double-click on that plate in the Plate Toolbar.

To Toggle the Visibility of All Plates:

� Click the Toggle Visibility  button.

Menu: None

Button:

Key: None

To Make All Plates Visible:

� Click on the Make All Visible   button.

Menu: None

Button:

Key: None
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Plate Color
The color of the rectangle next to the Plate Number in the Plate Toolbar indicates the color in which
FixMaster displays each visible plate.

To Change the Plate Color:
1. Right-click  the Plate Number in the Plate Toolbar.

2. On the Context Menu, click Color.

3. On the Choose Color dialog, click the color you want for that plate.

4. Click OK .

Import Drill Data
If you have drill files for your outside tooling, you can import them into FixMaster. See Import Drill
Data  on page 314.

Drill Editing
Inserting Drills

You can insert drills into the fixture.

To Insert Drills:
1. Set the active, visible plates.

Note: This command also works with the All Visible Plates Active option, indicated when the
button at the bottom of the Plate Toolbar says All Active. However, the operation is
limited in that drills will only be added to active, visible plates that already have at least
one drill.

2. Set the Current Tool Code.

3. On the Edit  menu, click Fixture-Drill-Insert Drill .

4. Position the cursor at the desired insertion point.

5. Click  the mouse or press Enter.

FixMaster inserts a drill of the Current Tool Code in the active, visible plate at the cursor position.

The Insert Drill tool remains selected until you select another tool or press the Escape key, so you
can insert one drill after another.

Menu: Edit-Fixture-Drill-Insert Drill

Button:  then 

Key: Shift+L
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Deleting Drills
The Delete command deletes drills from the active, visible plates.

To Delete a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Delete Drill .

Delete Single Drill

3. On the Delete Drill dialog, click Single.

4. Click OK

The Delete Drill tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to delete and click the left mouse button.

The cursor hops to the drill.

6. Click  the left mouse button a second time.

FixMaster deletes the marked drill.

The Delete Drill tool remains selected until you select another tool or press the Escape key, so
you can delete one drill after another.

Menu: Edit-Fixture-Drill-Delete Drill

Button:  then 

Key: None
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To Delete a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around a group of drills you want to delete.

3. On the Edit  menu, click Fixture-Drill-Delete Drill .

4. On the Delete Drill dialog, click Group, and click All .

Delete a Group of Drills

5. Click OK

FixMaster prompts you to click the mouse to delete the drills.

6. Click  in the viewing area.

FixMaster deletes all drills in the active, visible plates inside the Frame.

Menu: Edit-Fixture-Drill-Delete Drill

Button:  then 

Key: None
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To Delete a Group of Drills of the Current Tool Code in the Frame:
1. Set the active, visible plates.

2. Position the Frame around a group of drills you want to delete.

3. On the Edit  menu, click Fixture-Drill-Delete Drill .

4. On the Delete Drill dialog, click Group, and click Tool Code.

Delete by D Code

5. Click OK

FixMaster prompts you to select an element.

6. Position the cursor near a drill that has the same Tool Code as the drills you want to delete.

7. Click  the left mouse button.

The cursor hops to the drill.

The Tool Code of the marked drill becomes the Current Tool Code.

FixMaster prompts you to click the mouse to delete the drills.

8. Click  in the viewing area.

FixMaster deletes all drills in the active, visible plates inside the Frame that have the current Tool
Code.

The Delete Drill tool is selected until you select another tool or press the Escape key, so you can
delete drills inside the Frame of one Tool Code after another.

Menu: Edit-Fixture-Drill-Delete Drill

Button:  then 

Key: None
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Copying Drills
Copy commands copy drills in the active, visible plate to another location in the same plate. The
original drills remain at their original location. Copies are positioned relative to the originals.

To Copy a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Copy Drills .

3. Click Single.

Copy a Single Drill

4. Click OK .

The Copy Drill tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to copy and click the left mouse button.

The cursor hops to the drill.

FixMaster prompts for a destination position.

6. Position the cursor at the destination position.

7. Click  the left mouse button or press Enter.

The original drill remains in its original location, and FixMaster copies the drill to the new
position.

The Copy Drill tool remains selected until you select another tool or press the Escape key, so you
can copy one drill after another.

Menu: Edit-Fixture-Drill-Copy Drill

Button:  then 

Key: None
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To Copy a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to copy.

3. On the Edit  menu, click Fixture-Drill-Copy Drills .

4. Click Group.

Copy a Group of Drills

5. Click OK .

FixMaster prompts for a reference position.

6. Position the cursor at the reference position.

7. Click  the left mouse button or press Enter.

FixMaster marks the reference position with a yellow crosshair and prompts for a destination
position.

8. Position the cursor at the destination position.

9. Click  the left mouse button or press Enter.

The original drills within the Frame remain at their original location, and FixMaster copies them
to the new position.

Menu: Edit-Fixture-Drill-Copy Drill

Button:  then 

Key: None
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Moving Drills
The Move command repositions drills in the active, visible plate to a new position in the same plate.

To Move a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Move Drills .

3. Click Single.

Move a Single Drill

4. Click OK .

The Move Drill tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to move and click the left mouse button.

The cursor hops to the drill.

FixMaster prompts for a destination position.

6. Position the cursor at the destination position.

7. Click  the left mouse button or press Enter.

FixMaster moves the drill to the new position.

The Move Drill tool remains selected until you select another tool or press the Escape key, so you
can move one drill after another.

Menu: Edit-Fixture-Drill-Move Drill

Button:  then 

Key: None
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To Move a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to move.

3. On the Edit  menu, click Fixture-Drill-Move Drills .

4. Click Group.

Move a Group of Drills

5. Click OK .

FixMaster prompts for a reference position.

6. Position the cursor at the reference position.

7. Click  the left mouse button or press Enter.

FixMaster marks the reference position with a yellow crosshair and prompts for a destination
position.

8. Position the cursor at the destination position.

9. Click  the left mouse button or press Enter.

FixMaster moves the drills inside the Frame to the new position.

Menu: Edit-Fixture-Drill-Move Drill

Button:  then 

Key: None
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Mirroring Drills
The Mirror commands mirror a single drill or a group of drills within the Frame in the active, visible
plates.

The Mirror X command flips the selected drills in the X direction so that left becomes right.

The Mirror Y command flips the selected drills in the Y direction so that up becomes down.

Note: These commands can be used to simulate different drill language versions. For instance
Excellon Version 1 and Version 4 measure drill coordinates as though they were mirrored
versions of each other. The mirror commands allow you to insert drills using one coordinate
system, then automatically change them to a different version.

To Mirror a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Mirror X or Mirror Y .

3. Click Single.

Mirror a Single Drill

4. Click OK .

FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to mirror and click the left mouse button.

The cursor hops to the drill.

FixMaster displays a yellow line that follows the cursor.
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Mirror Axis Line

6. Place the yellow line at a position around which you want to mirror the drill.

7. Click  the left mouse button.

FixMaster flips the selected drill to the opposite side of the yellow line at an equal distance.

Menu: Edit-Fixture-Drill-Mirror X or Mirror Y

Button:  then  or 

Key: None
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To Mirror a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to Mirror.

3. On the Edit  menu, click Fixture-Drill-Mirror X or Mirror Y .

4. Click Group.

Mirror a Group of Drills

5. Click OK .

6. Click  the mouse.

FixMaster displays a yellow line that follows the cursor.
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Mirror Axis Line

7. Place the yellow line at a position around which you want to mirror the drills.

8. Click  the left mouse button.

FixMaster flips the selected drills to the opposite side of the yellow line at an equal distance.

Menu: Edit-Fixture-Drill-Mirror X or Mirror Y

Button:  then  or 

Key: None
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Rotating Drills
The Rotation command rotates drill data in the active, visible plates. Rotation is clockwise in multiples
of 90 degrees.

To Rotate a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Rotate Drills .

3. Click Single.

Rotate a Single Drill

4. Click OK .

FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to rotate and click the left mouse button.

The cursor hops to the drill.

6. Position the cursor at the center of rotation.

7. Click  the left mouse button or press Enter.
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Rotate around Cursor

8. On the Rotate dialog, enter the Angle of rotation.

9. Select to Rotate Around Cursor. The other option, Rotate Around Center of Selection, does
not really have any meaning for a single selected drill and is for rotating a group of drills.

10. Click Ok.

Menu: Edit-Fixture-Drill-Rotate

Button:  then 

Key: None
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To Rotate a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to rotate.

3. On the Edit  menu, click Fixture-Drill-Rotate Drills .

4. Click Group.

Rotate a Group of Drills

5. Click OK .
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6. If you want to rotate the drills around a specific cursor location:

• Position the cursor at the center of rotation.

• Click  the left mouse button or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Cursor.

• Click Ok

Rotate around Cursor
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If you want to rotate the drills around the center of the selection:

• Click  the left mouse button or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Center of Selection.

• Click Ok

Rotate around Center of Selection

Menu: Edit-Fixture-Drill-Rotate

Button:  then 

Key: None
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Stepping and Repeating Drills
FixMaster allows you to step and repeat a group of drills selected by the Frame. This operation makes
multiple copies of the drills within the Frame, in all active, visible plates, and positions the copies at
the step intervals you specify.

To Step and Repeat Drills:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to step and repeat.

3. On the Edit  menu, click Fixture-Drill-Step/Repeat.

Step and Repeat

4. On the Step and Repeat Config dialog, enter the following step and repeat parameters:

• Step X and Step Y: Enter the distance to step each copied drill in the X and Y directions.

• Copies X and Copies Y: Enter how many copies of the selected drills to make in the X
and Y directions.

5. Click OK .

Menu: Edit-Fixture-Drill-Step/Repeat

Button:  then 

Key: None



FixMaster User’s Guide

106

Replicating Drills
Replicate commands copy and transfer drills to a destination plate at a new position. The original drills
remain at their original position in the original plate. FixMaster replicates copies of the selected drills
at the new position in the destination plate.

To Replicate a Single Drill:
1. Set the active, visible plates.

Note: The active, visible plate determines the plate from which the replicated drills will be
selected, not the plate to which they will be replicated.

2. On the Edit  menu, click Fixture-Drill-Replicate Drills .

3. Click Single.

Replicate a Single Drill

4. Click OK .

The Replicate Drill tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to replicate and click the left mouse button.

The cursor hops to the drill.

FixMaster prompts for a destination position.

6. Position the cursor at the destination position.

7. Click  the left mouse button or press Enter.
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FixMaster prompts for a destination plate.

Destination Plate

8. Type the plate number you want to replicate the drill to.

9. Click OK .

The original drill remains in its original plate at its original location, and FixMaster replicates the
drill to the destination plate at the new position.

The Replicate Drill tool remains selected until you select another tool or press the Escape key, so
you can replicate one drill after another.

Menu: Edit-Fixture-Drill-Replicate Drill

Button:  then 

Key: None
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To Replicate a Group of Drills in the Frame:
1. Set the active, visible plates.

Note: The active, visible plate determines the plate from which the replicated drills will be
selected, not the plate to which they will be replicated. Regardless of how many plates
drills are selected from, all drills are transferred to the single destination plate.

2. Position the Frame around the drills you want to replicate.

3. On the Edit  menu, click Fixture-Drill-Replicate Drills .

4. Click Group.

Replicate Group

5. Click OK .

FixMaster prompts for a reference position.

6. Position the cursor at the reference position.

7. Click  the left mouse button or press Enter.

FixMaster marks the reference position with a yellow crosshair and prompts for a destination
position.

8. Position the cursor at the destination position.

9. Click  the left mouse button or press Enter.
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FixMaster prompts for a destination plate.

Destination Plate

10. Type the plate number you want to replicate the drills to.

11. Click OK .

The original drills within the Frame remain in their original plates at their original location, and
FixMaster replicates them to the destination plate at the new position.

Menu: Edit-Fixture-Drill-Replicate Drill

Button:  then 

Key: None
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Transferring Drills
Transfer commands remove drills in the active, visible plate and insert them into a destination plate at
the same X and Y position.

To Transfer a Single Drill:
1. Set the active, visible plates.

Note: The active, visible plate determines the plate from which the transferred drills will be
selected, not the plate to which they will be transferred.

2. On the Edit  menu, click Fixture-Drill-Transfer Drills .

3. Click Single.

Transfer a Single Drill

4. Click OK .

The Transfer Drill tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to transfer and click the left mouse button.

The cursor hops to the drill.

6. Click  the mouse again.
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FixMaster prompts for a destination plate.

Destination Plate

7. Type the plate number you want to transfer the drill to.

8. Click OK .

FixMaster transfers the drill to the destination plate at the same position.

The Transfer Drill tool remains selected until you select another tool or press the Escape key, so
you can transfer one drill after another.

Menu: Edit-Fixture-Drill-Transfer Drill

Button:  then 

Key: None



FixMaster User’s Guide

112

To Transfer a Group of Drills in the Frame:
1. Set the active, visible plates.

Note: The active, visible plate determines the plate from which the transferred drills are
selected, not the plate to which they are transferred. Regardless of how many plates
drills are selected from, all drills are transferred to the single destination plate.

2. Position the Frame around the drills you want to transfer.

3. On the Edit  menu, click Fixture-Drill-Transfer Drills .

4. Click Group.

Transcode a Group of Drills

5. Click OK .
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FixMaster prompts for a destination plate.

Destination Plate

6. Type the plate number you want to transfer the drills to.

7. Click OK .

FixMaster transfers the drill inside the Frame to the destination plate at the same position.

Menu: Edit-Fixture-Drill-Transfer Drill

Button:  then 

Key: None
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Transcoding Drill Tool Codes
The Transcode command changes the Tool Code of drills in the active, visible plates.

To Transcode the Tool Code of a Single Drill:
1. Set the active, visible plates.

2. On the Edit  menu, click Fixture-Drill-Transcode .

3. Click Single.

Transcode a Single Drill

4. Click OK .

The Transcode Tool is selected and FixMaster prompts you to select an element.

5. Position the cursor near a drill you want to transcode and click the left mouse button.

The cursor hops to the drill.

6. Click  the left mouse button again.

New Tool Code

7. On the Transcode dialog, enter the new Tool Code.
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8. Click OK

FixMaster transcodes the Tool Code of the selected drill and shows the drill at the size of the new
Tool Code.

The Transcode Tool remains selected until you select a new tool or press the Escape key, so you
can transcode the Tool Code of one drill after another.

Menu: Edit-Fixture-Drill-Transcode Drill

Button:  then 

Key: None

To Transcode the Tool Code of a Group of Drills in the Frame:
1. Set the active, visible plates.

2. Position the Frame around the drills you want to transcode.

3. On the Edit  menu, click Fixture-Drill-Transcode .

4. Click Group.

Transcode a Group of Drills

5. Click OK .

The Transcode Tool is selected and FixMaster prompts you to select an element.

6. Position the cursor near a drill that has the Tool Code you want to transcode and click the
left mouse button.

The cursor hops to the drill.

The Tool Code of the selected drill becomes the current Tool Code in the Status Bar.

7. Click  the left mouse button again.
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New Tool Code

8. On the Transcode dialog, enter the new Tool Code.

9. Click OK

FixMaster transcodes all the drills in the Frame that have the same Tool Code as the selected drill
and shows the transcoded drills at the size of the new Tool Code.

The Transcode Tool remains selected until you select a new tool or press the Escape key, so you
can transcode drills of one Tool Code after another.

Menu: Edit-Fixture-Drill-Transcode Drill

Button:  then 

Key: None
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Chapter 7
Set up a Flip Test

A flip test is a test in which the two sides of the board, CMP and SOL, are tested separately. When you
run the Flip Test operation, FixMaster finds a common via between sides for each net, saves the test
points assigned to the via and any surface mounts, and deletes other test points. This minimizes the
number of test points for common vias between sides and maintains a high level of testing with the
fewest number of test points.

Note: No method of testing only one board side at a time can assure that nets that go from one side
to the other are continuous. This is because the continuity of the vias between layers cannot
be tested by only testing one side at a time. The Flip Test assures a high level of test by testing
those types of nets for continuity to a common via on both board sides, but this does not test
the continuity of the via itself.

If you are going to do a flip test, you should use the Flip Test command before panelizing, deleting,
rotating, moving or mirroring the PCB.

There are two types of flip tests.

One-Fixture Flip Test
The two sides can be tested on a single fixture in a one-fixture flip test. In this case one side is tested,
and then the board is flipped over and the other side is tested on another offset portion of the same
fixture.

For a one-fixture flip test, FixMaster copies the non-current side data to the current side, CMP or SOL,
and offsets the copied data. The data will be tested on the current side grid. FixMaster does not actually
flip the data that is offset for a one-fixture flip test, so you need to either import one side of the data in
a flipped orientation or mirror it after import.

Two-Fixture Flip Test
Another kind of flip test is the two-fixture flip test in which one side of the board is tested on one
fixture, and the other side is tested on another fixture.

In the two-fixture flip test, the data is not copied from one side to another or offset. You process the
job just as you would for any two-sided job, processing each side separately. The advantage of doing
the Flip Test operation in this case is that the operation still reduces the number of test points for
common vias between sides and maintains a high level of testing with the fewest number of test points.
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Running the Flip Test Operation
To Run the Flip Test Operation:
1. After the PCB data have been imported and the test points are generated, but before you

mirror, move, rotate or step/repeat the PCB, go to the Action menu and click Flip Test.

Flip Test Dialog

2. Select whether to do a one-fixture flip test or a two-fixture  flip test.

3. If you selected a one-fixture flip test, enter the distance to offset corresponding points on the
two sides in the X and Y Offset.

4. Select whether you want Extra Single Nodes on the component or solder side. This option
assures that all netlists have at least one test point on each board side after the test point
reduction. This is to ensure a complete test for shorts.

5. Click OK .
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Chapter 8
Position the PCB

After you import the PCB data, you must position the PCB data within the fixture. FixMaster has a
feature for automatically centering the PCB in the fixture tooling and several commands for mirroring,
moving, rotating and stepping and repeating the PCB data.

Before you position the PCB data you should also consider whether you want to automatically move
the PCB when dropping pins, or if you want to wait to position the PCB until after dropping pins.

Automatically Moving the PCB when Dropping Pins
You have the option to automatically move the PCB when dropping pins so that the maximum number
of pins are directly over fixture grid points. At most this option will move the PCB by one fixture grid
interval, so you should still use one of the positioning commands to put the PCB approximately where
you want it. If you position the PCB exactly where you want it and don’t want it to move by even one
fixture grid interval, do not use the option.

To Automatically Move the PCB when Dropping Pins:
1. On the Setup menu, click Fixture-Grid .

2. On the Customize Grid dialog select the type of fixture grid you have and click OK .

3. If you want FixMaster to reposition the PCB when you drop pins, then on the Change Grid
dialog, click the Move PCB When Dropping Pins option so that there is a checkmark.
Otherwise, click so that there is no checkmark.

Change Grid Dialog, with Move PCB Option Selected

For more information on setting the other fixture grid options, see Setting up the Fixture Grids on page
61.
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Waiting to Position the PCB until After Dropping
Pins

If you wait to position the PCB until after dropping pins and use the positioning commands on a part
that already has pin assignments, FixMaster attempts to keep the pin assignments. In order for this to
work, the new part position must be similar relative to the fixture grid points:

• If you step and repeat or move PCB data with pin assignments, the distance must be a
multiple of the fixture grid interval.

• If you rotate PCB data with pin assignments, the pivot point must be on a fixture grid point.

• If you mirror PCB data with pin assignments, the flip axis must be on a fixture grid point.

The only advantage to waiting to position the PCB is if you plan to step and repeat a complex part. If
you are going to do a lot of manual test point assignments, it makes sense to do it only once and then
panelize the part with the pin assignments intact. However, even if you plan to step and repeat after
dropping pins, you should position the original part. Position the original image where you want the
lower left corner of the step and repeat pattern.
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Automatically Centering the PCB in the Fixture
Tooling

You can automatically center all PCB data, both the component-side and solder-side layers, within the
fixture tooling or the tester grid.

To Center the PCB:
1. Go to the Edit  menu and click PCB Data-Center PCB.

2. In the Place PCB dialog, select whether to center within the Fixture  or the Grid .

Place PCB Dialog

Menu: Edit-PCB Data-Center PCB

Button:

Key: Ctrl+B
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Mirroring the PCB
The Mirror command flips PCB data for the current board side in either the X or Y directions.

Note: You typically orient the data to the tester grid when you import the PCB data, so be sure that
you leave the data oriented properly when you use the Mirror command. For information on
orienting the data on import, see Import PCB Files into the Job on page 299.

Pin Assignments
If pins have not yet been assigned to the fixture grid before mirroring, the flip axis is the center of the
selected data.

If pins have been assigned to the fixture grid before mirroring, the flip axis is the fixture grid point
closest to the center of the selected data. This allows pin assignments to be preserved.

To Mirror the PCB:
1. Set the current Board Side.

2. Position the Frame around the data you want to mirror.

3. On the Edit  menu, click PCB Data-Mirror .

4. Select the direction to flip the data.

None: The data is not flipped.

Flip X:  The data is flipped horizontally, along the X axis, so that left becomes right.

Flip Y:  The data is flipped, vertically, along the Y axis, so that up becomes down.

5. Click OK .

Menu: Edit-PCB Data-Mirror

Button:  then  or 

Key: None
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Moving the PCB
The Move command moves PCB data for both board sides.

One use of this feature is for optimizing pin drops. If you position the board so that the part with the
highest density is between fixture grid coordinates, you will have equal deflection for pins assigned to
the highest-density test points.

Pin Assignments
If you move a part that already has pin assignments, FixMaster attempts to keep the pin assignments.
In order for this to work, the distance moved must be a multiple of the fixture grid interval.

To Move the PCB:
1. Position the Frame around the data you want to move.

2. On the Edit  menu, click PCB Data-Move.

FixMaster prompts for a reference location.

3. Position the cursor at the reference location.

4. Click  or press Enter.

FixMaster marks the reference position with a yellow crosshair and prompts for a destination
position.

5. Position the cursor at the destination location.

6. Click  or press Enter.

FixMaster moves the data in the Frame as a group so that the reference location moves to the
destination location.

Menu: Edit-PCB Data-Move

Button:  then 

Key: None
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Rotating the PCB
The Rotate command rotates PCB data for both board sides.

Direction
Rotation is clockwise in multiples of 90 degrees.

D Codes
FixMaster transcodes the asymmetrical pads to existing D Codes of the correct size or to new D Codes
defined to match the rotated pads.

Pin Assignments
If you rotate a part that already has pin assignments, FixMaster attempts to keep the pin assignments.
In order for this to work, the pivot point must be on a fixture grid point.

To Rotate the PCB:
1. Position the Frame around the PCB data you want to rotate.

2. Go to the Edit  menu and click PCB Data-Rotate.

3. If you want to rotate the PCB data around a specific cursor location:

• Position the cursor at the center of rotation.

• Click  the left mouse button or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Cursor.

• Click Ok

Rotate Around Cursor
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If you want to rotate the PCB data around the center of the selection:

• Click  the left mouse button or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Center of Selection.

• Click Ok

Rotate Around Center

FixMaster rotates the data within the Frame around the designated pivot point. FixMaster
transcodes the asymmetrical pads to existing D Codes of the correct size or to new D Codes
defined to match the pads.

Menu: Edit-PCB Data-Rotate

Button:  then 

Key: None
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Step and Repeat the PCB
The Step/Repeat command steps and repeats PCB data for both board sides.

Direction of Step and Repeat
The original image is the lower left copy in the pattern and the new copies are stepped up to the right
and above the original.

Net Numbers after Step and Repeat
Each net in the original PCB data is assigned a unique new net number in each new copy of the data.

Pin Assignments after Step and Repeat
If you step and repeat a part that already has pin assignments, FixMaster attempts to keep the pin
assignments in the repeated images. In order for this to work, the step distances must be a multiple of
the fixture grid interval. This technique can save a lot of work in jobs that require a lot of manual pin
assignments. See Waiting to Position the PCB until After Dropping Pins on page 120.

To Step and Repeat the PCB:
1. Position the Frame around the data you want to step and repeat.

2. On the Edit  menu, click PCB Data-Step/Repeat.

Step and Repeat Dialog

3. On the Step and Repeat dialog, enter the following:

• Copies X, Y: Enter the number of copies you want in the X and Y directions.

• Step X, Y: Enter the distance to step the image in the X and Y directions. This is the
distance from the lower left corner of one image to the lower left corner of the next
image.
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4. Click OK .

FixMaster makes multiple copies of the data in the Frame and positions them to the right and
above the original by the distances you specified. Each net in the original PCB data is assigned a
unique new net number in each new copy of the data.

Menu: Edit-PCB Data-Step/Repeat

Button:  then 

Key: None
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Chapter 9
Map D Codes to Probe Codes

D Code to Probe Mapping Table
The D Code to Probe Mapping Table is where you map D Codes in the imported PCB data to Probe
Codes that you have set up in the Probe Table.

D Code to Probe Map Table

You tell FixMaster how to handle pads of each D Code in the PCB data. Each D Code can be set to
represent one of the following types of pad:

• A pad that is going to be probed.

• A pad that is not going to be probed.

• A PCB tooling hole to be transferred to the fixture. For a complete discussion of tooling
holes, see PCB Tooling Holes and Fixture Alignment Pins on page 385.

After each pad is given a type:

• Each pad that is to be probed must be mapped to a specific Probe Code. The Probe Code
identifies the probe used to test that pad and contains the drill diameter information for that
probe.

• Pads that are not going to be probed do not need any further processing.

• Each PCB tooling hole transferred to the fixture needs to be assigned to a specific Probe
Code. The tooling hole Probe Code identifies the tooling hole diameter for that pad. For a
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complete discussion of tooling holes, see PCB Tooling Holes and Fixture Alignment Pins on
page 385.

The D Code to Probe Mapping Table contains the following information.

D Code
The D Code column contains all the D Codes found in the imported PCB data.

Count
The Count column shows how many pads of each D Code are in the imported PCB data.

X/Y Size
The X and Y Sizes show the dimensions of the each D Code in the imported PCB data.

Shape
The Shape column shows the shape of the each D Code in the imported PCB data. The letters that
identify each shape are consistent with those used in the Lavenir CAM software (CAMMaster,
ViewMaster PRO, And ViewMaster). Elements that were obrounds or rounded rectangles in the
original file are imported as circles, squares or rectangles and are shown as surface mounts.

Type
The Type column identifies how the particular D Code is to be handled in FixMaster. The procedures
that follow describe how to enter these values. You may already know how each D Code is to be
handled, or you may be able to determine this from the Size and Shape values.

Type-0 D Code: Unprobed pad.

• No test points will be generated for type-0 pads.

• No drill data will be generated when the drill files are generated.

Type-1 D Code: Probed pad.

• Test points will be generated for type-1 pads.

• Drill data will be generated for the probe drills. The Probe Code parameters for the Probe
Codes mapped to type-1 D Codes will be used to generate the Tool Codes when drill files are
generated.

Type-2 D Code: Tooling hole, not probed.

• No test points will be generated for type-2 pads.

• Drill data will be generated for these tooling holes. The shaft diameter of the type-T Probe
Codes mapped to the type-2 D Codes will be used as the tooling hole diameter and will be
used as the Tool Code size when drill files are generated. For a complete discussion of tooling
holes, see PCB Tooling Holes and Fixture Alignment Pins on page 385.
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Probe
The Probe column identifies the Probe Code that is mapped to the corresponding D Code. Probe Code
Values are set up in the Probe Table. For information on the Probe Table, see Setting up the Probes on
page 70. Here you select a Probe for each pad that is appropriate to the D Code Type, shape and size.

Type-0 D Code: Don’t map a Probe Code for type-0 pads. These are unprobed pads.

Type-1 D Codes: Map each type-1 D Code to an appropriate Probe Code from the Probe Setup table.
A probe having that Probe Code will be used to test pads of that D Code.

• For surface-mount pads, use a type-S or type-B Probe Code.

• For through-hole pads, use a type-H or type-B Probe Code.

Type-2 D Codes: Map each type-2 D Code to an appropriate type-T Probe Code from the Probe Setup
Table. The type-T Probe Code isn't actually a probe. FixMaster uses the shaft diameter of the type-T
probe as the tooling hole size. For a complete discussion of tooling holes, see PCB Tooling Holes and
Fixture Alignment Pins on page 385.

The procedures that follow show how you can have FixMaster automatically map the D Codes to
Probe Codes, or how you can do this manually.
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Automatically Mapping D Codes to Probe Codes
FixMaster can automatically map D Codes to Probes based on type and size.

To Automatically Map D Codes to Probe Codes:
1. Set the current board side.

2. You may have already set up the Probe Code parameters in the fixture configuration
procedure. If not, go to the Setup menu, click Fixture-Probe, and set the following settings:

• Type

• Pad Min and Max

See Setting up the Probes on page 70.

The other settings on the Probe Setup Table are not required for mapping the D Codes to Probe
Codes, but it may help guide your choices for Probe Codes later in the procedure and will be
necessary for generating test points and exporting probe drill files.

3. On the Action menu, click D Code to Probe.

D Code to Probe Map Table
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4. For each D Code, enter a Type.

Type-0 D Code: Unprobed pad.

• No test points will be generated for type-0 pads.

• No drill data will be generated when the drill files are generated.

Type-1 D Code: Probed pad.

• Test points will be generated for type-1 pads.

• Drill data will be generated for the probe drills. The Probe Code parameters for the Probe
Codes mapped to type-1 D Codes will be used to generate the Tool Codes when drill files
are generated.

Type-2 D Code: Tooling hole, not probed. For a complete discussion of tooling holes, see PCB
Tooling Holes and Fixture Alignment Pins on page 385.

• No test points will be generated for type-2 pads.

• Drill data will be generated for these tooling holes. The shaft diameter of the type-T
Probe Codes mapped to the type-2 D Codes will be used as the tooling hole diameter and
will be used as the Tool Code size when drill files are generated.

5. In the Layer group box, select whether you want to map D Codes to Probe Codes for Both the
component board side and solder board side or just the Current  board side.

6. Click the Auto Assign button.

FixMaster automatically maps D Codes to Probe Codes for type-1 and type-2 D Codes.

Type-0 D Codes: The program skips the type-1 D Codes because they are unprobed pads.

Type-1 D Codes:

• For each type-1 D Code, FixMaster looks for Probe Codes of the correct type in the
Probe Setup table.
For surface-mount pads, FixMaster looks for a type-S or type-B Probe Code.
For through-hole pads, FixMaster looks for a type-H or type-B Probe Code.

• When FixMaster finds a probe of the correct type, the program then checks whether the
pad-size range for the Probe Code matches the D Code size. The first Probe Code in the
Probe Setup Table that matches the type and pad minimum and maximum size criteria is
mapped to the D Code.

• A probe having that Probe Code will be used to test pads of that D Code.

Type-2 D Codes: For a complete discussion of tooling holes, see PCB Tooling Holes and Fixture
Alignment Pins on page 385.

• For each type-2 D Code, FixMaster looks for a type-T Probe Code in the Probe Setup
Table.

• When FixMaster finds a type-T Probe Code, the program then checks whether the pad-
size range for the Probe Code matches the D Code size. The first type-T Probe Code in



FixMaster User’s Guide

134

the Probe Setup Table that matches the pad minimum and maximum size criteria is
mapped to the D Code.

• The type-T Probe Code isn't actually a probe. FixMaster uses the shaft diameter of the
type-T probe as the tooling hole size.

7. Check the automatic assignments to make sure everything is correct. You can manually
change any D Code to Probe Code assignment using the Manually Map D Codes to Probes
procedure. See Manually Map D Codes to Probe Codes on page 135.

8. When all D Codes are mapped to Types and Probe Codes, click OK .

9. If you have mapped D Codes to Probe Codes for one board side and need to map them for the
other side you can go back and do it now.

Menu: Action-D Code to Probe

Button:

Key: F5
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Manually Map D Codes to Probe Codes
You can manually map D Codes to Probes.

To Manually Map D Codes to Probe Codes:
1. Set the current board side.

2. You may have already set up the Probe Code parameters in the fixture configuration
procedures by going to the Setup menu, and clicking Fixture-Probe. This step is not
required for mapping the D Codes to Probe Codes, but it may help guide your choices for
Probe Codes later in the procedure and will be necessary for generating test points and
exporting probe drill files. See Setting up the Probes on page 70.

3. On the Action menu, click D Code to Probe.

D Code to Probe Map Table

4. For each D Code, enter a Type.

Type-0 D Code: Unprobed pad.

• No test points will be generated for type-0 pads.

• No drill data will be generated when the drill files are generated.
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Type-1 D Code: Probed pad.

• Test points will be generated for type-1 pads.

• Drill data will be generated for the probe drills. The Probe Code parameters for the Probe
Codes mapped to type-1 D Codes will be used to generate the Tool Codes when drill files
are generated.

Type-2 D Code: Tooling hole, not probed. For a complete discussion of tooling holes, see PCB
Tooling Holes and Fixture Alignment Pins on page 385.

• No test points will be generated for type-2 pads.

• Drill data will be generated for these tooling holes. The shaft diameter of the type-T
Probe Codes mapped to the type-2 D Codes will be used as the tooling hole diameter and
will be used as the Tool Code size when drill files are generated.

5. For each type-1 or type-2 D Code, enter a Probe Code.

Type-0 D Code: Don’t map a Probe Code for type-0 pads. These are unprobed pads.

Type-1 D Codes: Map each type-1 D Code to an appropriate Probe Code from the Probe Setup
table. A probe having that Probe Code will be used to test pads of that D Code.

• For surface-mount pads, use a type-S or type-B Probe Code.

• For through-hole pads, use a type-H or type-B Probe Code.

Type-2 D Codes: Map each type-2 D Code to an appropriate type-T Probe Code from the Probe
Setup Table. The type-T Probe Code isn't actually a probe. FixMaster uses the shaft diameter of
the type-T probe as the tooling hole size. For a complete discussion of tooling holes, see PCB
Tooling Holes and Fixture Alignment Pins on page 385.

6. When all D Codes are mapped to Types and Probe Codes, click OK .

7. If you have mapped D Codes to Probe Codes for one board side and need to map them for the
other side, you can go back and do it now.

Menu: Action-D Code to Probe

Button:

Key: F5
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Chapter 10
Add Test Points

A test point is a location in the PCB data that is to be probed during the test. In FixMaster a test point
is defined by its X and Y location, the component it is in, the grid point it is assigned to, and the Probe
Code it is mapped to. This chapter describes how to automatically generate test points and to edit test
points in FixMaster.

Generating Test Points
FixMaster can automatically generate test points for Gerber and netlist data.

Generating Test Points for Gerber Data
FixMaster generates test points for all pads mapped as probeable (Type-1 D Codes) in the D Code to
Probe map.

To Generate Test Points for Gerber Data:
1. Set the Current Board Side.

2. To determine which pads are probeable and what types of probes can be used for each pad,
map D Codes to Probe Codes. See Map D Codes to Probe Codes on page 129.

3. On the Edit  Menu, click Test Point-Insert-All Test Points.

FixMaster generates the test points for the current board side as you specified.

Test points are represented by blue crosshairs.

FixMaster highlights pads for which test points have been generated.

4. If you need to generate test points for the opposite board side, repeat the procedure.

Menu: Edit-Test Point-Insert-All Test Points

Button:

Key: None
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Generating Test Points for Netlist Data
FixMaster can generate test points for all pads mapped as probeable (Type-1 D Codes) in the D Code
to Probe map, or for only selected probeable pads limited by the options you set.

To Generate Test Points for Netlist Data:
1. Set the Current Board Side.

2. To determine which pads are probeable and what types of probes can be used for each pad,
map D Codes to Probe Codes. See Map D Codes to Probe Codes on page 129.

3. Go to the Setup menu and click Test Point-Generate.

Set Up Test Point Generation

4. On the Generate Config dialog, set up the additional options for generating test points for
netlists. These options are described in detail in the sections that follow this procedure.

Options Group Box: You may select any of these options when generating test points for netlist
data of any format. Not all options are compatible with other options.

• Test Single pt Nets: See Test Points for Single-Point Nets on page 140.

• Use Gerber Soldermask: See No Test Points Covered by Gerber Soldermask on page
143.

• Use Gerber Silkscreen: See No Test Points Covered by Gerber Silkscreen on page 144.

• Balanced Through-Holes: See Equal Number of Through-Hole Test Points Per Board
Side on page 141.
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• One Test Point Per Net: See One Test Point Per Net on page 141.

• Component Side Through-Hole Only: See All Through-Hole Test Points on One Board
Side on page 142.

• Barrel Optimize:  See Through-Hole Test Points on Opposite Board Side from Incoming
Trace on page 143

IPC Options Group Box: You may select any of these options when generating test points for
IPC format netlists with the appropriate records (including Lavenir formats .F02 and .F04). Not all
options are compatible with other options.

• SMD: Test Endpoints Only: See Surface-Mount Pads: Test Points for Endpoints Only
on page 145.

• Through-Holes: Test Endpoints Only: See Through-Hole Pads: Test Points for
Endpoints Only on page 146.

• Test Vias: See Test Points for Vias on page 146.

• Vias: Test Endpoints Only: See Vias: Test Points for Endpoints Only on page 146.

• Use IPC Soldermask: See No Test Points for Pads with IPC Soldermask Flags on page
147.

When you have set the options you want, click OK .

5. On the Edit  Menu, click Test Point-Insert-All Test Points.

FixMaster generates the test points for the current board side as you specified.

Test points are represented by blue crosshairs.

FixMaster highlights pads for which test points have been generated.

6. If you need to generate test points for the opposite board side, repeat the procedure.

Menu: Setup-Test Point-Generate

Button: None

Key: None
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Set Up Test Point Generation Options for Netlists

Set Up Test Point Generation

You may select any of the following options when generating test points for netlist data of any format.

Test Points for Single-Point Nets
FixMaster can either generate test points for single-point nets or ignore single-point nets when
generating test points.

FixMaster looks at the net designation in the netlist data to determine if a net is a single-point net, and
does not actually count the number of nodes in each net. Nets that have a net number of zero or are
designated with an N/C are considered to be pads with no connections. If your netlist format does not
designate non-connected pads this way, the option will not work.

• To generate test points for single-point nets, click the Test Single Pt Nets option so that it has
a checkmark.

• To ignore single-point nets when generating test points for netlists, click this option so that it
does not have a checkmark.
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One Test Point Per Net
If you are only testing for shorts between nets, and not testing for continuity, then you need only one
test point per net.

• To generate a test point for only one node of each net, click the One Test Point Per Net
option so that it has a checkmark.

• To generate test points for more than one node per net, click this option so that it does not
have a checkmark.

Note: This option can not be selected if any of the through-hole options are selected.

Equal Number of Through-Hole Test Points Per Board Side
FixMaster can balance the number of test points generated for through holes on each side of the board.

• To generate an equal number of test points through holes on each side of the board, click on
the Balanced Through Holes option so that it has a checkmark.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Balanced
Through Holes option so that it does not have a checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at
time, and they can not be used if the One Test Point Per Net option is selected. If none of
these options are selected, then through-hole test points will be generated for the current
board side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.
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All Through-Hole Test Points on One Board Side
FixMaster has an option that can be used to force through-hole test points to one side of the board.
Generally if you are using this option, you want the through-hole test points on the component side, so
this option is called Component Side Through-Holes Only. This option generates test points for
through-holes on the current side only for through-holes that do not already have test points on the
other side.

• If you want to use this option, click on the Component Side Through-Holes Only option so
that it has a checkmark, and generate test points for the side that you want to have the
through-hole test points. FixMaster puts test points everywhere that it can, including all
probeable through-holes on the current side. Then when you generate test points for the other
board side, FixMaster will not put a test point on the through-holes that received test points on
the first board side.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Component
Side Through-Holes Only option so that it does not have a checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at
time, and they can not be used if the One Test Point Per Net option is selected. If none of
these options are selected, then through-hole test points will be generated for the current
board side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.
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Through-Hole Test Points on Opposite Board Side from Incoming Trace
FixMaster can place test points generated for through-holes on the opposite side of the board from an
incoming trace. This allows the integrity of the through-hole to be tested.

Note: This option is for dual-sided testers.

• To generate through holes on the opposite side of the board from the incoming trace, click the
Barrel Optimize option so that it has a checkmark.

If you have turned on both the Barrel Optimize option and the Test Single Point Nets option, then
when you generate test points, FixMaster will prompt for extra information regarding where to test
single-point nets that are also through holes. A single-point through hole has no incoming trace, so
you need to tell FixMaster where to place the test point. To place all test points for through-hole
pads that are single-point nets on one side of the board, select either CMP for the component side
or SOL for the solder side. To divide the number of test points for these pads equally between the
two sides, select BAL  for balance.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Barrel
Optimize option so that it does not have a checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at
time, and they can not be used if the One Test Point Per Net option is selected. If none of
these options are selected, then through-hole test points will be generated for the current
board side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.

No Test Points Covered by Gerber Soldermask
To avoid having a probe hit soldermask instead of a pad, you may want to generate test points only for
pads that are completely cleared of soldermask. FixMaster can compare PCB data to imported Gerber
soldermask layers (MSU and MSL) to determine if PCB pads are completely cleared of soldermask.
To import Gerber soldermask layers, see Import Supplemental Gerber Files into the Job on page 312.

• To generate test points only for pads that are completely cleared of Gerber soldermask, click
the Use Gerber Soldermask option so that it has a checkmark.

FixMaster does not generate test points for pads that are touched at all by soldermask and marks
such pads as possibly probable, possibly covered pads. You can inspect the possibly covered pads
manually and decide whether or not to add test points for these pads. See Possibly Probeable,
Possibly Covered Test Points on page 148.

• To ignore the Gerber soldermask data when generating test points and to generate test points
even for pads that may be touched by soldermask, click the Use Gerber Soldermask option
so that it does not have a checkmark.

Another option for using soldermask data when generating test points is to use the soldermask flag in
IPC format netlists with soldermask records (including Lavenir formats .F02 and .F04). See No Test
Points for Pads with IPC Soldermask Flags on page 147.
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No Test Points Covered by Gerber Silkscreen
To avoid having a probe hit silkscreen instead of a pad, you may want generate test points only for
pads that are completely cleared of silkscreen. FixMaster can compare PCB data to imported Gerber
silkscreen layers (SKU and SKL) to determine if PCB pads are completely cleared of silkscreen. For
information on importing Gerber silkscreen layers, see Import Supplemental Gerber Files into the Job
on page 312.

• To generate test points only for pads that are completely cleared of Gerber silkscreen, click
the Use Gerber Silkscreen option so that it has a checkmark.

FixMaster does not generate test points for pads that are touched at all by silkscreen and marks
such pads as possibly probable, possibly covered pads. You can inspect the possibly covered pads
manually and decide whether or not to add test points for these pads. See Possibly Probeable,
Possibly Covered Test Points on page 148.

• To ignore the Gerber silkscreen data when generating test points and to generate test points
even for pads that may be touched by silkscreen, click the Use Gerber Silkscreen option so
that it does not have a checkmark.
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IPC Options Group Box

Set Up Test Point Generation

You may select any of these options when generating test points for IPC format netlists with the
appropriate records (including Lavenir formats .F02 and .F04).

Surface-Mount Pads: Test Points for Endpoints Only
In order to reduce the number of probes, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), FixMaster allows you
to limit test point generation for surface-mount pads to endpoints only or to generate test points for all
surface-mount pads.

• For surface-mount pads, to generate test points only for netlist endpoints, click the SMD:
Test Endpoints Only option so that it has a checkmark.

• To generate test points for all surface-mount pads, click the SMD: Test Endpoints Only
option so that it does not have a checkmark.
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Through-Hole Pads: Test Points for Endpoints Only
In order to reduce the number of probes, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), FixMaster allows you
to limit test point generation for through-hole pads to endpoints only or to generate test points for all
through-hole pads.

• For through-hole pads, to generate test points only for netlist endpoints, click the Through-
Holes: Test Endpoints Only option so that it has a checkmark.

• To generate test points for all through-hole pads, click the Through-Holes: Test Endpoints
Only option so that it does not have a checkmark.

Vias: Test Points for Endpoints Only
In order to reduce the number of probes, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), FixMaster allows you
to limit test point generation for vias to endpoints only or to generate test points for all vias.

• For vias, to generate test points only for netlist endpoints, click the Vias: Test Endpoints
Only option so that it has a checkmark.

• To generate test points for all vias, click the Vias: Test Endpoints Only option so that it does
not have a checkmark.

Test Points for Vias
In IPC format netlists with via records (including Lavenir formats .F02 and .F04), FixMaster allows
you to control test point generation for vias.

• To generate test points for elements that are labeled as vias in the netlist data, click the Test
Vias option so that it has a checkmark.

• If you do not want to generate test points for elements that are labeled as vias in the netlist
data, click the Test Vias option so that it does not have a checkmark.
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No Test Points for Pads with IPC Soldermask Flags
To avoid having a probe hit soldermask instead of a pad, you may want generate test points only for
pads that are completely cleared of soldermask. FixMaster can use the soldermask flag in IPC format
netlists with soldermask records (including Lavenir formats .F02 and .F04) to generate test points for
pads that are not flagged as covered by soldermask.

FixMaster can compare PCB data to imported Gerber soldermask layers (MSU and MSL) to determine
if PCB pads are completely cleared of soldermask.

• To generate test points only for pads that are not flagged in the IPC data as covered by
soldermask, click the Use IPC Soldermask option so that it has a checkmark.

FixMaster does not generate test points for pads that are flagged in the IPC data as covered by
soldermask and marks such pads as possibly probable, possibly covered pads. You can inspect the
possibly covered pads manually and decide whether or not to add test points for these pads. See
Possibly Probeable, Possibly Covered Test Points on page 148.

• To ignore the IPC soldermask records when generating test points and to generate test points
even for pads that may be covered by soldermask, click the Use IPC Soldermask option so
that it does not have a checkmark.

Another option for using soldermask data when generating test points is to use imported Gerber
soldermask layers (MSU and MSL) to determine if PCB pads are completely cleared of soldermask.
See No Test Points Covered by Gerber Soldermask on page 143.
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Possibly Probeable, Possibly Covered Test Points
When you have FixMaster generate test points using the options that look at soldermask or silkscreen
data, FixMaster will identify pads that are partially covered by silkscreen or are not fully cleared of
soldermask. Because these pads might be covered in such a way that makes them unprobeable,
FixMaster does not give them a test point and highlights them in magenta.

FixMaster has a command that allows you to find each pad that may be probeable but was not
automatically assigned test points.

After you activate the command and go to the possibly probeable pad, you decide if the pad should
have a test point. If you are viewing Gerber soldermask or silkscreen data you can see if the pad is
covered. If you are using an IPC-D-356 netlist, the soldermask data is a digital switch in the file that
indicates the pad is covered or clear, and you will not be able to see the soldermask. If you determine
the pad is probeable, you can insert a test point; otherwise, leave it unprobed.

For information on importing Gerber soldermask and silkscreen data, see Import Supplemental Gerber
Files into the Job on page 312.

For information on using the soldermask and silkscreen data when generating test points, see No Test
Points Covered by Gerber Soldermask on page 143, No Test Points Covered by Gerber Silkscreen on
page 144 and No Test Points for Pads with IPC Soldermask Flags on page 147.

To Highlight Possibly Probeable, Possibly Covered Test Points:
� If the magenta highlighting for possibly probeable, possibly covered test points is not being

displayed, go to the Action menu and click Soldermask.

To Go to Each Possibly Probeable, Possibly Covered Test Points:
1. On the View menu, click Go To-Probeable TP.

The Probeable Test Point Tool is selected.

2. Click  the mouse.

The cursor hops to the next possibly probeable, possibly covered element. The element is marked
with a green cross, indicating it is selected. Pads that are possibly probeable, but possibly covered
are displayed in magenta.

3. If you determine the pad should be probed, use one of the commands for inserting test points.
See Insert Test Points on page 149.

The Probeable Test Point Tool remains selected until you select another tool or press the Escape
key, so you can find one possibly probeable, possibly covered element after another by clicking
the mouse.

Menu: View-Go To-Probeable TP

Button:

Key: None
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Edit Test Points Manually
The following commands allow you to edit test points in FixMaster.

Insert Test Points
FixMaster has several commands for inserting test points manually.

To Insert Test Points Individually:
1. On the Edit  Menu, click Test Point-Insert-Insert Single Test Point.

The Insert Test Point tool is selected, and FixMaster prompts you to select an element.

2. Position the cursor inside a pad exactly where you want to insert the test point.

Tip: To place the test point at an exact location, you can use the Select Pad command, S, to
put the test point in the center of the pad, or use the mouse or the cursor positioning
commands, X and Y, then press Enter.

3. With the cursor positioned where you want the test point, click the mouse or press Enter.

FixMaster inserts a test point at the cursor position.

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert one test point after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Single Test Point

Button:  then 

Key: Shift+I
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To Insert Test Points in Pads in the Frame:
1. Position the Frame around a group of pads into which you want to insert test points.

2. On the Edit  Menu, click Test Point-Insert-Insert Test Point (D Code).

Insert Test Points in all Pads in Frame

3. On the Insert Test Point dialog, select Group and select All .

4. Click OK .

5. After the dialog disappears, click the mouse in the viewing area.

FixMaster inserts test points in all the pads within the Frame.

Menu: Edit-Test Point-Insert-Insert Test Point (D Code)

Button: None

Key: None
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To Insert Test Points in Pads of Current D Code in Frame:
1. Position the Frame around a group of pads into which you want to insert test points.

2. On the Edit  Menu, click Test Point-Insert-Insert Test Point (D Code).

Insert Test Points in Pads of Current D Code in Frame

3. On the Insert Test Point dialog, select Group and select D Code.

4. Click OK .

The Insert Test Point tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor in a pad that has the D Code to which you want to insert test points.

6. Click  the mouse or press Enter.

The cursor hops to the center of the pad, and the D Code of pad becomes the current D Code
shown in the Status Bar.

7. Click  the mouse or press Enter.

FixMaster inserts test points in all the pads within the Frame that have the current D Code.

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert test points in pads of one D Code after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Test Point (D Code)

Button: None

Key: None



FixMaster User’s Guide

152

To Insert Test Points in a Single Net:
1. On the Edit  Menu, click Test Point-Insert-Insert Test Point (Net).

Insert Test Points in a Single Net

2. On the Insert Test Point by Net dialog, select Single, and select whether to insert on only the
Current  board side or Both sides.

3. Click OK .

The Insert Test Point tool is selected, and FixMaster prompts you to select an element.

4. Position the cursor in a pad of the net to which you want to insert test points.

The cursor hops to the center of the pad, and the Net Number of pad becomes the current Net
Number shown in the Status Bar.

5. Click  the mouse or press Enter.

FixMaster inserts test points in all pads that have the current Net Number .

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert test points in one net after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Test Point (Net)

Button: None

Key: None
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To Insert Test Points in a Group of Nets in the Frame:
1. Position the Frame around a group of pads that all belong to the nets into which you want to

insert test points.

Note: The Frame establishes which nets will have test points inserted, not which pads. Every
net that has a pad inside the Frame will have test points inserted in pads that are both
inside and outside the Frame.

2. On the Edit  Menu, click Test Point-Insert-Insert Test Point (Net).

Insert Test Points in a Group of Nets in the Frame

3. On the Insert Test Point by Net dialog, select Group, and select whether to insert on only the
Current  board side or Both sides.

4. Click OK .

5. When the dialog disappears, click the mouse or press Enter.

FixMaster inserts test points in all pads that have the same Net Number as the pads inside the
Frame.

Menu: Edit-Test Point-Insert-Insert Test Point (Net)

Button: None

Key: None
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Delete Test Points
FixMaster has several commands for deleting test points.

To Delete Test Points Individually:
1. On the Edit  Menu, click Test Point-Delete-Delete Single Test Point.

The Delete Test Point tool is selected, and FixMaster prompts you to select an element.

2. Position the cursor near a test point you want to delete.

3. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a yellow cross.

4. Click  the mouse or press Enter.

FixMaster deletes the marked test point.

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete one test point after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Single Test Point

Button:  then   then select Single on the dialog.

Key: None
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To Delete Test Points in Frame:
1. Position the Frame around a group of pads from which you want to delete test points.

2. On the Edit  Menu, click Test Point-Delete-Delete Test Point (D Code).

Delete Test Points from all Pads in Frame

3. On the Delete Test Point dialog, select Group and select All .

4. Click OK .

5. When the dialog disappears, click the mouse.

FixMaster deletes test points from all the pads within the Frame.

Menu: Edit-Test Point-Delete-Delete Test Point (D Code)

Button:  then 

Key: None
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To Delete Test Points from Pads of Current D Code in Frame:
1. Position the Frame around a group of pads from which you want to delete test points.

2. On the Edit  Menu, click Test Point-Delete-Delete Test Point (D Code).

Delete Test Points from Pads of Current D Code in Frame

3. On the Delete Test Point dialog, select Group and select D Code.

4. Click OK .

The Delete Test Point tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor in a pad that has the D Code from which you want to delete test points.

6. Click  the mouse or press Enter.

The cursor hops to the test point in the pad, and the test point is marked with a green cross. The D
Code of pad becomes the current D Code shown in the Status Bar.

7. Click  the mouse or press Enter.

FixMaster deletes test points from all the pads within the Frame that have the current D Code.

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete test points from pads of one D Code after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Test Point (D Code)

Button:  then 

Key: None
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To Delete Test Points from a Single Net:
1. On the Edit  Menu, click Test Point-Delete-Delete Test Point (Net).

Delete Test Points from a Single Net

2. On the Delete Test Point by Net dialog, select Single and select whether to delete on only the
Current  board side or Both sides.

3. Select whether to keep one test point in each net for which you delete test points, or to delete
all test points in each net.

4. Click OK .

The Delete Test Point tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor in a pad of the net from which you want to delete test points.

The cursor hops to the center of the pad, and the Net Number of pad becomes the current Net
Number shown in the Status Bar.

6. Click  the mouse or press Enter.

FixMaster deletes test points in all pads that have the current Net Number .

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete test points from one net after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Test Point (Net)

Button: None

Key: None
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To Delete Test Points from a Group of Nets in the Frame:
1. Position the Frame around a group of pads that all belong to the nets from which you want to

delete test points.

Note: The Frame establishes which nets will have test points deleted, not which pads. Every net
that has a pad inside the Frame will have test points deleted from pads that are both
inside and outside the Frame.

2. On the Edit  Menu, click Test Point-Delete-Delete Test Point (Net).

Delete Test Points from a Group of Nets in the Frame

3. On the Delete Test Point by Net dialog, select Group and select whether to delete on only the
Current  board side or Both sides.

4. Select whether to keep one test point in each net for which you delete test points, or to delete
all test points in each net.

5. Click OK .

6. Click  the mouse or press Enter.

FixMaster deletes test points from all pads that have the same Net Number as the pads inside the
Frame.

Menu: Edit-Test Point-Delete-Delete Test Point (Net)

Button: None

Key: None
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Move Test Points
You can move an assigned test point within its pad.

To Move an Assigned Test Point:
1. On the Edit  Menu, click Test Point-Move-Assigned Test Point.

2. Position the cursor near a test point that has been assigned to a point on the tester grid.

3. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a green cross.

4. Position the cursor where you want to move the test point to.

5. Click  the mouse or press Enter.

If the new test point position will not cause problems, the test point is moved to the new position
and remains assigned to the same fixture grid point.

If the new test point position will create crossed pins or breakouts or exceed the maximum pin
deflection, FixMaster displays a dialog describing the problem and prompts whether to proceed.

This Test Point Moving Tool remains selected until you select another tool or press the Escape
key, so you can move one test point after another before quitting the operation.

Menu: Edit-Test Point-Move-Assigned Test Point

Button: None

Key: None
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To Move a Single Unassigned Test Point:
1. On the Edit  Menu, click Test Point-Move-Unassigned Test Point.

Move a Single Unassigned Test Point

2. On the Move Unassigned Test Point dialog, select Single.

3. Click OK .

The Move Unassigned Test Point tool is selected, and FixMaster prompts you to select an element.

4. Position the cursor near a test point that has not been assigned to a point on the tester grid.

5. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a green cross.

6. Position the cursor where you want to move the test point to.

7. Click  the mouse or press Enter.

The test point moves to the new position.

The Move Unassigned Test Point tool remains selected until you select another tool or press the
Escape key, so you can move one test point after another before quitting the operation.

Menu: Edit-Test Point-Move-Unassigned Test Point

Button:  then 

Key: None
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To Move Unassigned Test Points in the Frame:
1. Position the Frame around a group of unassigned test points that you want to move.

2. On the Edit  Menu, click Test Point-Move-Unassigned Test Point.

Move Unassigned Test Points in the Frame

3. On the Move Unassigned Test Point dialog, select Group and select All .

4. Click OK .

5. Position the cursor near one of the test points you want to move.

6. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a green cross.

7. Position the cursor where you want the marked test point to move to.

8. Click  the mouse or press Enter.

All the unassigned test points in the Frame move as a group so that the marked test point moves to
the new position.

The Move Unassigned Test Point tool does not remain selected.

Menu: Edit-Test Point-Move-Unassigned Test Point

Button:  then 

Key: None
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To Move Unassigned Test Points in Pads of Current D Code in Frame:
1. Position the Frame around a group of unassigned test points that you want to move.

2. On the Edit  Menu, click Test Point-Move-Unassigned Test Point.

Move Unassigned Test Points in Pads of Current D Code

3. On the Move Unassigned Test Point dialog, select Group and select D Code.

4. Click OK .

The Move Unassigned Test Point tool is selected, and FixMaster prompts you to select an element.

5. Position the cursor near a test point in a pad that has the D Code for which you want to move
test points.

6. Click  the mouse or press Enter.

The cursor hops to the test point in the pad, and the test point is marked with a green cross. The D
Code of pad becomes the current D Code shown in the Status Bar.

7. Position the cursor where you want the marked test point to move to.

8. Click  the mouse or press Enter.

All the unassigned test points in the Frame that have the same D Code move as a group so that the
marked test point moves to the new position.

The Move Unassigned Test Point tool remains selected until you select another tool or press the
Escape key, so you can move test points in pads of one D Code after another before quitting the
operation.

Menu: Edit-Test Point-Move-Unassigned Test Point

Button:  then 

Key: None
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Transfer Test Point to other Side of Board
FixMaster allows you to transfer a single through-hole test point or a group of through-hole test points
selected by the Frame to the other side of the board. If you are doing a dual sided test, this can help to
alleviate density problems by moving a test point from the denser side to the less dense side.

To Transfer a Single Through-Hole Test Point to the Opposite Side:
1. On the Edit  Menu, click Test Point-Move-Xfer Thru Hole Test Point.

Transfer a Single Through-Hole Test Point to the Opposite Side

2. On the Transfer Test Point dialog, select Single.

3. Click OK .

The Transfer Test Point tool is selected, and FixMaster prompts you to select an element.

4. Position the cursor near a through hole test point that you want to transfer to the other side of
the board.

5. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a green cross.

6. Click  the mouse or press Enter.

The test point transfers to the other side of the board.

The Transfer Test Point tool remains selected until you select another tool or press the Escape
key, so you can transfer one test point after another before quitting the operation.

Menu: Edit-Test Point-Move-Xfer Thru Hole Test Point

Button: None

Key: None
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To Transfer All Through-Hole Test Points in the Frame to the Opposite Side:
1. Position the Frame around the through-hole test points you want to transfer to the other side

of the board.

2. On the Edit  Menu, click Test Point-Move-Xfer Thru Hole Test Point.

Transfer All Through-Hole Test Points in the Frame to the Opposite Side

3. On the Transfer Test Point dialog, select Group.

4. Click OK .

5. Click  the mouse or press Enter.

FixMaster transfers all through-hole test points within the Frame to the other side of the board.

The Transfer Test Point tool does not remain selected.

Menu: Edit-Test Point-Move-Xfer Thru Hole Test Point

Button: None

Key: None
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Stagger Test Points
FixMaster can stagger test points for rectangular surface-mount pads and for through-hole pads. There
are automatic features for staggering groups of test points, or you can stagger individual test points
manually.

Why Stagger Surface-Mount Pads?
By staggering test points for rectangular surface-mount pads, you can relieve some of the problems of
testing dense boards, such as head butts.

Why Stagger Through-Hole Pads?
By staggering test points for through-hole pads, you can have the probe hit the pad instead of the hole.
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Distance a Test Point is Staggered
The distance a test point is staggered depends on the probe that is associated with that test point. Each
Probe Code has a Margin value that determines the distance that test points associated with that Probe
Code will be staggered. For information on the other entries on the Probe Setup dialog, see Setting up
the Probes on page 70.

Set up the Probe Stagger Margin:
1. Set the Current Board Side.

2. Click Setup-Fixture-Probe.

Probe Setup Tab

3. On the Probe Setup Tab, enter a Margin  for each probe.

Margin for Surface-Mount Pads
For surface-mount pads, the Margin is measured from the end of the pad. So a staggered test point will
be positioned at a distance from the end of the pad that is equal to the Margin.

Margin for Through-Holes
For through-hole pads, the Margin is measured outward from the hole center or inward from the hole
edge, as selected on the Stagger dialog. In order to stagger a test point beyond the edge of the hole and
probe the covering pad, the Margin factor should be negative, and the distance should be measured
from the edge of the hole.
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Surface-Mount Pads Stagger Options
Options for how to stagger test points for surface-mount pads are set on the SMD tab of the Stagger
Setup dialog. This dialog can be displayed by clicking Setup-Test Point-Stagger, but it is also
displayed in many of the procedures for staggering described in the sections that follow.

Stagger Setup SMD Tab

Stagger Threshold
Enter a minimum pad size to determine which rectangular surface-mount pads will have staggered test
points. Any rectangular SMD pad with a side less than or equal to the Stagger Threshold value will
have its test point staggered.

Two/Three-Point Stagger
Select the option for either a two-point or three-point stagger. A two-point stagger puts a test point at
either of the two extremes of the pad. A three-point stagger puts a test point at either of the two
extremes of the component or in the middle of the component.
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Through Hole Stagger Options
Options for staggering test points for through-hole pads are set on the Hole Stagger From tab of the
Stagger Setup dialog. This dialog can be displayed by clicking Setup-Test Point-Stagger, but it is also
displayed in many of the procedures for staggering described in the sections that follow.

Stagger Setup Dialog, Hole Stagger From Tab

Hole Stagger To
Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From
Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max
Set the minimum  and maximum size through-hole pads for which you want to stagger test points.
Through-holes smaller than the minimum or larger than the maximum will not have test points
staggered.
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Staggering All Test Points Automatically
FixMaster can stagger all surface-mount and through-hole test points on the current board side
automatically.

Note: This operation unassigns all staggered test points.

To Stagger All Test Points Automatically:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the fixture configuration
procedures.

If not, click Setup-Fixture-Probe and set up the Margin  for each probe. See Distance a Test
Point is Staggered on page 166.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The Margin is measured outward from the hole center or inward from
the hole edge, as selected on the Stagger dialog. In order to stagger a test point beyond
the edge of the hole and probe the covering pad, the Margin factor should be negative,
and the distance should be measured from the edge of the hole.

3. On the Edit  Menu, click Test Point-Stagger-All.

4. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

5. On the Hole Stagger From tab of the Stagger dialog, set options for staggering test points for
through-hole pads:

Hole Stagger To: Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From: Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max:  Set the minimum  and maximum size through-hole pads for which you
want to stagger test points. Through-holes smaller than the minimum or larger than the maximum
will not have test points staggered.

6. Click OK .

FixMaster automatically staggers the test points as you specified.

7. If you need to stagger test points for the opposite side of the board, repeat the procedure.

Menu: Edit-Test Point-Stagger-All

Button:

Key: Ctrl+Shift+F9
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Manually Staggering Individual Test Points
FixMaster allows you to manually stagger individual surface-mount test points on the current board
side.

Note: This operation does not unassign staggered test points the way that automatically staggering
all test points and staggering test points in the Frame does.

To Manually Stagger Individual Test Points:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the fixture configuration
procedures.

If not, click Setup-Fixture-Probe and set up the Margin  for each probe.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The single stagger operation does not stagger test points for through
holes.

3. On the Setup Menu, click Test Point-Stagger.

4. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

5. The single stagger operation does not stagger test points for through holes, so the settings on
the Hole Stagger From tab of the Stagger dialog are unimportant.

6. Click OK .

7. On the Edit  Menu, click Test Point-Stagger-Single.

8. Click on the Test Point you want to stagger.

9. Click on the stagger position that you want to move the test point to, at either of the two
extremes of the component or in the middle of the component.

FixMaster staggers the test point to the position you specified.

Menu: Edit-Test Point-Stagger-Single

Button: None

Key: Shift+F9
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Staggering Test Points in the Frame
FixMaster can stagger all surface-mount and through-hole test points on the current board side inside
the Frame.

Note: This operation unassigns all staggered test points in the Frame.

To Stagger Test Points in the Frame:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the fixture configuration
procedure.

If not, click Setup-Fixture-Probe and set up the Margin  for each probe.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The Margin is measured outward from the hole center or inward from
the hole edge, as selected on the Stagger dialog. In order to stagger a test point beyond
the edge of the hole and probe the covering pad, the Margin factor should be negative,
and the distance should be measured from the edge of the hole.

3. Position the Frame around the test points that you want to stagger.

4. On the Edit  Menu, click Test Point-Stagger-Window.

5. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

6. On the Hole Stagger From tab of the Stagger dialog, set options for staggering test points for
through-hole pads:

Hole Stagger To: Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From: Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max:  Set the minimum  and maximum size through-hole pads for which you
want to stagger test points. Through-holes smaller than the minimum or larger than the maximum
will not have test points staggered.

7. Click OK .

FixMaster staggers the test points inside the Frame as you specified.

Menu: Edit-Test Point-Stagger-Window

Button: None

Key: None

Swapping the Stagger Position of Staggered Points in the Frame
FixMaster can swap the stagger position of staggered test points for surface mount pads on the current
board side in the Frame.

Note: This operation unassigns all staggered test points in the Frame.

To Swap the Stagger Position of Staggered Test Points in the Frame:
1. Set the Current Board Side.

2. Position the Frame around the staggered test points for which you want to swap stagger
positions.

3. On the Edit  Menu, click Test Point-Stagger-Swap Stagger.

FixMaster swaps the stagger position of all staggered test points for surface mount pads inside the
Frame. Staggered test points that were at one end of the pad are staggered to the other end. Test
points in the center of the pad remain there.

Menu: Edit-Test Point-Stagger-Swap Stagger

Button: None

Key: Ctrl+F9
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Window Stagger with Margin
This command staggers a group of test points inside the Frame using a new Margin value, without
resetting the margin in the Probe Setup dialog. For information about staggering a group of test points
in the Frame without setting a unique margin value, see Staggering Test Points in the Frame on page
173. For information about setting the Margin value on the probe Setup dialog, see Setting up the
Probes on page 70.

Stagger Margin

Menu: Edit-Test Point-Stagger-Window Stagger with Margin

Button: None

Key: None
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Microstagger for Luther Maelzer Testers
The microstagger feature is unique to Luther Maelzer testers. When the microstagger feature is used,
every other SMD test point is moved by the selected amount in a random up, down, left, or right
direction. The movement of those test points is saved in the Luther Maelzer export files. The Luther
Maelzer machine can use the information to check for false opens by moving the test plate.

To Microstagger the Test Points for Luther Maelzer Testers:
1. On the Edit  menu, click Test Point-Stagger-Microstagger.

Microstagger

2. On the Micro Stagger dialog, enter the distance to microstagger the test points.

3. Click OK .

FixMaster indicates the microstagger by showing a small blue arrow next to the test points that
have been microstaggered.

4. When you export the files, select the QSA option to include the microstagger information in
the export. See Export Luther & Maelzer Test Files on page 330.

Menu: Edit-Test Point-Stagger-Mocrostagger

Button: None

Key: None
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Chapter 11
Assign Test Points to Tester Grid Points

In a fixture, probes connect test points on the board to tester grid points. The primary function of
FixMaster is to assign test points to tester grid points. Once this is done, the program can then export
drill files for making the fixture and output tester download files for testing the boards.

FixMaster has features that automatically assign test points to tester grid points. When automatically
assigning test points to grid, FixMaster can give priority to certain areas of the board or to certain types
of probes.  In addition to the automatic features, FixMaster has features for manually editing test point
assignments.

Assigning All Test Points to Tester Grid Points
FixMaster has a feature that attempts to automatically assign all test points on the current board side to
tester grid points. The operation uses the grid configuration and pin deflection settings set up in the
fixture configuration procedure. See Set Up the Fixture Configuration on page 51. Within those rules,
FixMaster attempts to assign as many test points as possible to grid points.

Note: This command un-assigns any previously assigned test points before beginning. So, if you
have test point assignments that you want to keep, use one of the other test point-assignment
routines, such as Assign Test Points in the Frame to Tester Grid Points. See Assigning Test
Points in the Frame to Tester Grid Points on page 179.

To Assign All Test Points to Tester Grid Points:
1. Set the current board side.

2. On the Edit  menu, click Test Points-Assign to Grid-All (Drop Pins).

FixMaster assigns as many test points as possible to grid points.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Menu: Edit-Test Point-Assign to Grid-All (Drop Pins)

Button:

Key: Ctrl+Shift+J
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Assigning All Test Points to Tester Grid Points
Based on Density

FixMaster has a feature that calculates dense areas of the board and attempts to automatically assign all
test points on the current board side to tester grid points, starting with the densest regions. The
operation uses the grid configuration and pin deflection settings set up in the fixture configuration
procedure. See Set Up the Fixture Configuration on page 51. Within those rules, and starting with the
densest areas first, FixMaster attempts to assign as many test points as possible to grid points.

To Assign All Test Points to Tester Grid Points Based on Density:
1. Set the current board side.

2. On the Edit  menu, click Test Points-Assign to Grid-Density Drop.

FixMaster calculates the densest areas of the board, then assigns as many test points as possible to
grid points, starting with the densest areas.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Menu: Edit-Test Point-Assign to Grid-Density Drop

Button: None

Key: None



Chapter 11 Assign Test Points to Tester Grid Points

179

Assigning Test Points in the Frame to Tester Grid
Points

FixMaster has a feature that attempts to automatically assign all test points within the Frame and on the
current board side to tester grid points. The operation uses the grid configuration and pin deflection
settings set up in the fixture configuration procedure. See Set Up the Fixture Configuration on page 51.
Within those rules, FixMaster attempts to assign as many test points as possible to grid points.

Note: This operation can be useful for correcting the fixture design rule errors automatically. For
information on the design rule checks, see Check for Design Rule Errors on page 195.

To Assign Test Points in the Frame to Tester Grid Points:
1. Set the current board side.

2. Position the Frame around the test points you want to assign. Be sure to enclose both the test
points you want to assign and the tester grid points you want available.

3. On the Setup menu, click Configuration .

Shake ‘em Up Options on Operations Configuration Tab
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4. On the Operations Configuration tab, set the Shake 'em Up settings:

Keep Matched Test Point: Determines whether the operation keeps or reassigns previously
assigned test points.

• To keep, and not reassign, previously assigned test points within the Frame, click this
option so that it has a checkmark.

• To un-assign and reassign previously assigned test points within the Frame, click this
option so that it does not have a checkmark.

Grab Unused Test Point Beyond Frame: Determines whether the operation includes tester grid
points beyond the edge of the Frame or only grid points inside the Frame.

• To use the closest available tester grid points including those outside the Frame when
assigning test points within the Frame, click this option so that it has a checkmark.

• To use only tester grid points inside the Frame when assigning test points within the
Frame, click this option so that it does not have a checkmark.

5. On the Edit  menu, click Test Points-Assign to Grid-By Window (Shake ‘Em Up).

FixMaster assigns as many test points in the Frame as possible to grid points.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check on the Frame area and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Menu: Edit-Test Point-Assign to Grid-By Window (Shake ‘Em Up)

Button:

Key: None
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Assigning Test Points in a Priority Region to Tester
Grid Points

FixMaster can give priority to designated regions of the PCB when automatically assigning test points
to grid points.

By assigning high-density regions of the board to the tester grid before assigning the rest of the test
points, you increase the chance of having the entire high-density region assigned on the first try. Use
this technique to assign ball grid arrays and other high-density regions.

Note: This operation does not unassign any assigned test points before making the new test point
assignments.

To Assign Test Points in a Priority Region to Tester Grid Points:
1. Set the current board side.

2. On the Edit  menu, click Test Points-Assign to Grid-Priority Drop.

3. On the Priority Drop dialog, select By Region and click OK .

Priority Drop by Region

4. Click and drag the mouse to select the area for priority drop the same way you would make a
Frame selection.

FixMaster shows the priority region with a green box.

5. The region selection function remains active so that you can designate more than one priority
region by dragging the mouse over as many priority areas as you want.
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6. After you have designated all of the priority regions, double-click the mouse button to start
the operation.

FixMaster assigns the priority regions first, and then assigns as many of the rest of the test points
as possible.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Menu: Edit-Test Point-Assign to Grid-Priority Drop

Button: None

Key: Ctrl+J
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Assigning Test Points from a Priority Centerpoint
FixMaster can give priority to a designated centerpoint of the PCB when automatically assigning test
points to grid points. The operation assigns the test points sequentially depending on how close they
are to the centerpoint, beginning with the points closest to the centerpoint and working outward.

By assigning high-density regions of the board to the tester grid before assigning the rest of the test
points, you increase the chance of having the entire high-density region assigned on the first try. Use
this technique to assign ball grid arrays and other high-density regions.

Note: This operation does not unassign any assigned test points before making the new test point
assignments.

To Assign Test Points from a Priority Centerpoint Outward:
1. Set the current board side.

2. On the Edit  menu, click Test Point-Assign to Grid-Priority Drop .

3. On the Priority Drop dialog, select From Point and click OK .

Priority Drop from Point
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4. Position the cursor at the priority centerpoint and click the mouse button to start the
operation.

FixMaster assigns test points, working outward from the centerpoint.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Menu: Edit-Test Point-Assign to Grid-Priority Drop

Button: None

Key: Ctrl+J
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Assigning Test Points for a Priority Probe Code to
Tester Grid Points

FixMaster can automatically assign test points of a single Probe Code to tester grid points.

By selecting a specific probe to be assigned to the tester grid before assigning the rest of the probes,
you ensure that the priority probe has the smallest possible pin deflection.

To Assign Test Points for a Priority Probe Code to Tester Grid Points:
1. Set the current board side.

2. On the Edit  menu, click Test Point-Assign to Grid-Priority Drop .

3. On the Priority Drop dialog, select By Probe and click OK .

Priority Drop by Probe
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4. In the Probe dialog, enter the Probe Code for which you want to assign test points to tester
grid points and click OK .

Select Probe Code

FixMaster assigns as many test points of the selected Probe Code as possible to tester grid points.

In the viewing area, probes (shown as blue lines) connect tester grid points (shown as red
crosshairs) to test points (shown as blue crosshairs).

FixMaster automatically runs a fixture design rule check and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

For information on the design rule checks, see Check for Design Rule Errors on page 195.

Note: FixMaster does not go on to assign any other test points that do not have the selected
probe code and does not un-assign any existing test point assignments. So you can repeat
the process for another probe and still maintain the order of priority.
After you have assigned test points for all of the priority probes, you can assign the rest
of the test points using the Assign Test Points in the Frame to Tester Grid Points
procedure, selecting the Keep Matched Test Point option. See Assigning Test Points in
the Frame to Tester Grid Points on page 179.
Do not use the Assign All Test Points to Tester Grid Points procedure, because this will
disconnect the priority assignments.

Menu: Edit-Test Point-Assign to Grid-Priority Drop

Button: None

Key: Ctrl+J
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Automatically Transcode to Smaller Probes to
Assign Test Points

FixMaster has a feature that will automatically try transcoding to smaller probes if larger probes
prevent test points from being assigned due to crossed pins. This Jiggle Pins feature allows FixMaster
to try the larger pins first and transcode to smaller ones as needed.

To Automatically Transcode to Smaller Probes to Assign Test Points:
1. Set up the Probe Table with two or more surface mount probes that have the same D Code

size range. Start with the largest diameter probe first, and put the smaller probes in descending
size order. FixMaster will go down the list, trying the probes in order. For information on how
to set up the Probe Table, see Setting up the Probes on page 70.

2. On the Edit  menu, click Test Point-Assign to Grid-Jiggle Pins.

Jiggle Pins

3. On the Jiggle Pins dialog, select Smooth or Rough.

• Smooth: Transcodes all crossed pins to a smaller probe code to attempt to assign test
points to grid.

• Rough: Transcodes every other crossed pin to a smaller probe code. Fewer test points are
transcoded this way.

4. Click OK .

FixMaster begins to assigns test points to grid. As it finds crossed pins, the program transcodes
those test points to smaller probe codes in an attempt to eliminate the crossed pins.
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Manually Assigning Individual Test Points to Tester
Grid Points

FixMaster allows you to manually assign test points to tester grid points. By manually assigning test
points to grid points, you can often fix problem areas of the board that have un-assigned test points,
crossed pins or breakouts which the program is unable to solve.

Assignment Aid
FixMaster has an optional Assignment Aid to assist you when you are manually assigning test points to
tester grid points.

When you select a test point to assign to grid, the Assignment Aid shows you the following
information.

Points within Allowable Deflection
A circle around the selected test point indicates which tester grid points are within the allowable
deflection. FixMaster prompts you before allowing you to select a point outside the circle.
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Previously Assigned Points
Tester grid points within the circle that are already assigned to other test points are shown in yellow.
You may assign a test point to a tester grid point that is already assigned to another test point. This
disconnects the other test point.

Points in Error
Tester grid points within the circle that would cause a design rule violation, such as crossed pins, or a
breakout, are shown in magenta. FixMaster will prompt you before allowing you to select a tester grid
point that would cause a design rule violation.

Available Points
Tester grid points within the circle that are available with no restrictions are colored green.
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To Manually Assign Individual Test Points to Tester Grid Points:
1. Set the current board side.

2. To use the optional Assignment Aid, go to the Setup menu, click Configuration , and on the
System Configuration tab, click Assign Aid On so that the option has a checkmark.

If you do not want to use the Assignment Aid, click the option so that it has no checkmark.

The Assignment Aid shows you:

• Points within Allowable Deflection

• Previously Assigned Points

• Points in Error

• Available Points

Assignment Aid Option On

3. On the Edit  menu, click Test Point-Assign to Grid-Single.

The test point assigning tool is selected.

4. Click  close to the test point you want to assign to a grid point.

FixMaster marks the test point to be assigned with a green cross.

If the Assignment Aid function is on, FixMaster indicates which points are within the allowable
deflection, which tester grid points are already assigned, which tester grid points would cause
errors, and available tester grid points.
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5. Click  on the tester grid point you want to assign the selected test point to.

If the new test point assignment will not cause problems, the test point is assigned to that tester
grid point. This is shown as a light blue line joining the two points.

If the new test point assignment will create crossed pins or breakouts or exceed the maximum pin
deflection, FixMaster displays a dialog describing the problem and prompts whether to proceed.

The test point assignment tool remains selected until you select a new tool or press the Escape
key, so you can assign one test point after another.

Menu: Edit-Test Point-Assign to Grid-Single

Button:

Key: Shift+J
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Manually Un-Assigning Individual Test Points from
Tester Grid Points

You can manually un-assign individual test points from grid points.

To Manually Un-Assigning Individual Test Points from Tester Grid Points:
1. Set the current board side.

2. On the Edit  menu, click Test Point-Unassign.

Un-assign Single Test Point

3. On the Unassign dialog, select: Single and click OK .

The Un-assign tool is selected.

4. Click  on the assigned test point you want to un-assign from the tester grid.

A green cross marks the test point to be un-assigned.

5. Click  the mouse button again.

FixMaster un-assigns the selected test point from the tester grid point. The blue line connecting
the points is removed, and the pad is shown in white to indicate it is unassigned.

The Un-assign tool remains selected until you select another tool or press the Escape key, so you
can un-assign one test point after another before quitting the operation.

Menu: Edit-Test Point-Unassign

Button: None

Key: None
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Un-Assigning Test Points in the Frame from Tester
Grid Points

You can un-assign a group of test points inside the Frame from grid points.

To Un-Assigning Test Points in the Frame from Tester Grid Points:
1. Set the current board side.

2. Position the Frame around the test points you want to un-assign from the tester grid.

3. On the Edit  menu, click Test Point-Unassign.

Un-assign a Group of Test Points

4. On the Unassign dialog, select Group and click OK .

5. Click  the left mouse button.

FixMaster un-assigns all test points within the Frame from the tester grid points. The blue lines
connecting the points are removed, and the pads are shown in white to indicate they are
unassigned.

Menu: Edit-Test Point-Unassign

Button: None

Key: None
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Chapter 12
Check for Design Rule Errors

FixMaster automatically runs a design rule check when you assign test points to tester grid points. See
Assign Test Points to Tester Grid Points on page 177. In addition you can run a design rule check at
any time.

Running a Design Rule Check
Running a Design Rule Check on the Whole PCB

You can run a design rule check on the whole PCB.

To Run a Design Rule Check on the Whole PCB:
1. Set the Current Board Side

2. On the Action menu, click Cross Check-All.

FixMaster checks the design rules and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

Menu: Action-Cross Check-All

Button:

Key: Ctrl+C
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Running a Design Rule Check Inside the Frame
You can run a design rule check on only a part of the PCB by using the Reference Frame.

To Run a Design Rule Check Inside the Frame:
1. Set the Current Board Side.

2. Position the Frame around the area you want to check for design rules.

3. On the Action menu, click Cross Check-Window.

FixMaster checks the design rules inside the Frame and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

Menu: Action-Cross Check-Window

Button: None

Key: Non
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e

Unassigned Test Points
Unassigned test points are test points that are not assigned to tester grid points. On screen, pads with
unassigned points are displayed in white.

Unassigned Test Points

FixMaster has a feature that allows you to go to each sequential unassigned test point.
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To Inspect Unassigned Test Points:
1. On the View menu, click Go To-Unassigned TP.

The Unassigned Test Point Tool is selected.

2. Click  the mouse.

The cursor hops to the next unassigned test point. The test point is marked with a green cross,
indicating it is selected. Pads with unassigned test points are displayed in white.

3. To correct the error, use one of the commands for assigning test points to tester grid points.
See Assign Test Points to Tester Grid Points on page 177.

The Unassigned Test Point Tool remains selected until you select another tool or press the Escape
key, so you can find one unassigned test point after another by clicking the mouse.

Menu: View-Go To-Unassigned TP

Button:

Key: None
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Crossed Pins and Head Butts
Crossed pins and head butt errors represent probes that would probably be in contact with each other.
Crossed pins occur when the way that test points are assigned to tester grid points brings two probes so
close together that the probes are likely to be in contact. Head butts are a little different in that they
occur when the test points are so close together that the heads of the probes are likely to be in contact;
so, for head butts, the test point-to-grid point assignments are not important.

FixMaster finds crossed pins and head butt errors by checking the arrangement of the probes that
results from the Assign Test Point to Tester Grid Points procedures. FixMaster calculates the distance
between the probes then checks the probe diameters, head diameters and air gaps set in the Probe
Table. See Setting up the Probes on page 70.

On screen, pads with crossed pins or head butts are displayed in yellow.

Crossed Pins

FixMaster has a feature that allows you to go to each sequential crossed pin error and head butt.
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To Inspect Crossed Pins and Head Butts:
1. On the View menu, click Go To-Cross Pins.

The Crossed Pin Tool is selected.

2. Click  the mouse.

The cursor hops to the next crossed pin or head butt. The test point is marked with a green cross,
indicating it is selected. Pads with crossed pins or head butts are displayed in yellow.

The Crossed Pin Tool remains selected until you select another tool or press the Escape key, so
you can find one crossed pin or head butt after another by clicking the mouse.

Menu: View-Go To-Crossed Pins

Button:

Key: None



Chapter 12 Check for Design Rule Errors

201

Breakouts
Breakout errors represent probe drills in fixture plates that are close enough that they are likely to
break through to each other.

FixMaster finds breakouts in fixture plates by checking the locations of the probe drills that result from
the Assign Test Point to Tester Grid Points procedures. FixMaster calculates the distance between the
probe drills and compares it to the breakout gap parameter set in the Fixture Configuration procedure.
See Setting up the Fixture Design Rules on page 59. You control which plates are checked for
breakouts when you set up the fixture plates. See the description of the Breakout field in Setting up
the Fixture Plates on page 52.

On screen, pads with breakouts are displayed in green.

Breakouts

FixMaster has a feature that allows you to go to each breakout error.
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To Inspect Breakouts:
1. On the View menu, click Go To-Break Outs.

The Breakout Tool is selected.

2. Click  the mouse.

The cursor hops to the next breakout error. The test point is marked with a green cross, indicating
it is selected. Pads with breakouts are displayed in green.

The Breakout Tool remains selected until you select another tool or press the Escape key, so you
can find one breakout error after another by clicking the mouse.

Menu: View-Go To-Breakouts

Button:

Key: None
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Correcting Design Rule Errors
There are several manual and automatic techniques for correcting design rule errors.

Manually Change Test Point Assignments for Test Points with Errors
Most Unassigned Test Points, Crossed Pins and Breakouts can be corrected by changing the test point-
to-grid point assignments.

The Assignment Aid is a valuable feature for manually correcting errors. The assignment aid shows
you which tester grid points are within the allowable pin deflection of the selected test point, which
tester grid points are already assigned, which tester grid points would cause errors, and available tester
grid points.

This technique is not useful for correcting Head Butts.

To Manually Change Test Point Assignments for Errors:
1. Go to the errors.

• Inspect Unassigned Test Points. See Unassigned Test Points on page 197.

• Inspect Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Inspect Breakouts. See Breakouts on page 201.

2. Manually assign individual test points to tester grid points using the Assignment Aid. See
Manually Assigning Individual Test Points to Tester Grid Points on page 188.
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Automatically Correcting Design Rule Errors
FixMaster also has some commands that can automatically correct some types of errors.

Automatically Assign Test Points inside the Frame to Grid Points
Often, instead of manually inspecting and reassigning test points that have Unassigned Test Points,
Crossed Pins or Breakouts, you can automatically assign test points inside the Frame to correct the
errors automatically.

This technique is not useful for correcting Head Butts.

To Correct Errors by Automatically Assigning Test Points inside the Frame to Grid
Points:
1. Look for locations on the board with groups of errors.

2. Position the Frame around the test points that are in error. Be sure to enclose both the test
points you want to re-assign and the tester grid points you want available.

3. On the Setup menu, click Configuration .

4. On the Operations Configuration tab, set the Shake 'em Up settings to the following:

• Click Keep Matched Test Point so that does not have a checkmark.

• Click Grab Unused Grid Point Outside Frame so that it has a checkmark.

5. On the Edit  menu, click Test Points-Assign to Grid-By Window (Shake ‘Em Up).

FixMaster assigns as many test points in the Frame as possible to grid points and automatically
runs a fixture design rule check on the Frame area and reports:

• Number of Unassigned Test Points. See Unassigned Test Points on page 197.

• Number of Crossed Pins. See Crossed Pins and Head Butts on page 199.

• Number of Breakouts. See Breakouts on page 201.

6. If FixMaster does not correct all of the errors automatically, position the Frame a little
differently and try again, or try one of the other error-correction techniques.

Stagger Test Points to Correct all Types of Errors
Sometimes staggering test points can correct all types of errors, including Head Butts.

• Stagger Test Points in the Frame: See Staggering Test Points in the Frame on page 173.

• Swap the Stagger Position of Staggered Test Points in the Frame: See Swapping the
Stagger Position of Staggered Points in the Frame on page 174.

• Manually Stagger Individual Test Points: See Manually Staggering Individual Test Points
on page 172.

Remove Padstacks to Correct Head Butts
Head Butts that appear to have two tester grid points assigned to a single test point are due to stacked
pads. Removing stacked pads helps to eliminate stacked test points that can cause Head Butt errors.
See Remove Padstacks on page 368.
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Transcode Probe Codes to Correct Head Butts
Head butts, and sometimes other types of errors, can be corrected by transcoding probe codes to
smaller-diameter probes. The smaller diameter probes are less likely to contact each other in dense area
of the board. See Transcode Probe Codes on page 362.
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Chapter 13
Inspect Netlist Mode

There may be times when you want to view individual nets and edit test points one net at a time. While
the automatic test point generating command and manual test point editing commands allow you to
edit test points with a view of the entire board and fixture, Netlist Inspection mode allows you to view
individual nets and edit test points for a single displayed net. This is useful for assuring that each net is
tested properly, and for dealing with special situations such as ring nets.

The normal command menus are not available in Netlist Inspection mode. You use the commands on
the Netlist Inspection toolbar and some special keyboard commands. Netlist Inspection mode has some
unique commands for locating and displaying specific nets. Many of the Netlist Inspection mode
commands for editing test points are the same as the test point editing commands in the normal editing
mode; however, there are some unique commands also.

Netlist Inspection Toolbar

Netlist Inspection Toolbar



FixMaster User’s Guide

208

Color System in Netlist Inspection Mode
To aid in the netlist inspection process, FixMaster uses the following color system to identify specific
elements in Netlist Inspection mode.

• Green Pads: Solder Side SMD

• Gray Pads: Component Side SMD

• Yellow Traces: Solder Side Traces

• Gray Traces: Component Side Traces

• Blue Traces: Internal Traces

• Yellow +: Solder Side Test Point

• Gray X:  Component Side Test Point

Netlist Inspection Mode Color System

Green Pad:  Solder Side SMD

Yellow +:  Solder Side Test Point

Yellow Trace:  Solder Side SMD

Gray Pads:  Comp. Side SMD

Gray Trace:  Comp. Side Trace

Gray X:  Comp. Side Test Point
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Entering and Exiting Netlist Inspection Mode
Netlist Inspection Mode is a separate editing mode from the normal editing mode.

To Enter Netlist Inspection Mode:
� On the Action menu, click Inspect Netlist.

Menu: Action-Inspect Netlist

Button:

Key: None

To Exit Netlist Inspection Mode and Return to Normal Editing:
� On the Netlist Inspection toolbar, click the Exit  button.

Or

� On the Netlist Inspection mode Action menu, click Quit .

Menu: Action-Quit

Button:

Key: None
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Displaying Nets
Netlist Inspection Mode has several options for displaying nets.

Displaying a Specific Net
You can select a specific net to display.

To Display a Specific Net:

1. On the Netlist Inspection toolbar, click the Display a Net  button.

FixMaster prompts you for a net number.

Display a Specific Net

2. Type the net number of the net you want to inspect and click OK .

FixMaster displays the selected net and adjusts the zoom level so that the selected net fills the
screen. In the Message Line, FixMaster displays the net number and the number of pads in the net,
for the current layer.

Menu: None

Button:

Key: None
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Displaying the First, Next or Previous Net in the File
FixMaster has commands to display nets in numerical order according to their net numbers in the file.
You can display the first net in the file or the next or previous net. When FixMaster displays the
selected net, the program adjusts the zoom level so that the net fills the screen. In the Message Line,
FixMaster displays the net number and the number of pads in the net, for the current board side.

To Display the First, Next or Previous Net in the File:

� On the Netlist Inspection toolbar, click the First Net , the Next Net   or the Previous

Net   button.

Menu: None

Button:  or  or 

Key: Shift+F or Shift+N. or Shift+B
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Displaying Nets that Do Not Have Enough Test Points
Multi-point nets can sometimes end up with only one test point because of the options selected when
automatically generating test points. For instance, the pads on ring nets which are connected by traces
that form a closed loop or pads on filled areas which are intersected by many fill traces may not
receive test points if you are only generating test points for endpoints. Such nets cannot be tested
properly for continuity. In some cases a net may not have any test points. Such nets can not be tested
for shorts to other nets. FixMaster has a command that allows you to identify nets that have less than
one or two test points.

You select whether to find nets that do not have at least one test point or to find nets that do not have at
least two test points. When the command is activated, FixMaster displays the next net that has less than
the designated number of test points and adjusts the zoom level so that the selected net fills the screen.
In the message area of the Status Bar, FixMaster displays the net number and the number of pads in the
net, for the current layer. When the net is displayed, you can decide whether to add a test point.

FixMaster also has a command for automatically generating test points for some of these nets. See
Adding Test Points to Nets that Do Not Have Enough Test Points on page 219. If you identify a large
number of these nets, then rather than manually adding test points, you may want to have FixMaster
try to generate test points for them. Then you can manually correct any remaining nets with too few
test points.

To Displaying Nets that Do Not Have Enough Test Points:
1. To set up the operation you need to be in the regular editing mode, so if you are already in

Netlist Inspection Mode, exit by clicking the Exit  button on the Netlist Inspection toolbar.

2. In the regular editing mode, go to the Setup menu and click Configuration .
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3. On the Operations Configuration tab, go to the group box labeled Define No TP Nets as
Nets With, and set the number of test points to look for in each net:

• No Test Points: If this option is selected, the No TP Nets command will display only
nets that do not have at least one test point.

• Less Than 2 TP: If this option is selected, the No TP Nets command will display nets
that do not have at least two test points.

4. Enter Netlist Inspection mode by going to the Action menu and clicking Inspect Netlist.

5. On the Netlist Inspection toolbar, click the No TP Nets  button.

FixMaster displays the first sequential net with less than the designated number of test points and
adjusts the zoom level so that the selected net fills the screen. In the message area of the Status
Bar, FixMaster displays the net number and the number of pads in the net, for the current layer.
FixMaster also displays the total number of nets with less than the specified number of test points.

6. To display the next sequential nets with less than the designated number of test points click

the No TP Nets  button again.

Menu: None

Button:

Key: None
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Options for How to Display Nets
Display Test Points with a Large X

FixMaster has a command to display a large X mark at each test point, making test points easier to
spot. This feature can be turned off by activating the command a second time.

To Toggle the Display of a Large X at Each Test Point:

� On the Netlist Inspection toolbar, click the Toggles TP  button.

Menu: None

Button:

Key: None
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Test Points Shown with the Large X Turned Off

Test Points Shown with the Large X Turned On
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Inspecting Ring Nets
Ring nets are nets in which traces form closed loops. Filled areas generally form ring nets. Pads on the
ring portion of the net may be designated as midpoints during netlist extraction. If you generate test
points for endpoints only, then you will not be testing the ring portion of the net for continuity.
FixMaster gives you two ways to display ring nets for inspection.

Check Nets With Less Than One or Two Test Points to Find Rings
You can sequentially inspect all nets that have less than one or two test points, as explained earlier. See
Displaying Nets that Do Not Have Enough Test Points on page 212. This command will display many
ring nets, along with other nets that are not rings. The advantage to this method is that it does not
require any time-consuming preprocessing to identify ring nets. The disadvantage is that it shows you
some nets that are not ring nets, and it will not show you nets that have many endpoints but also have a
ring portion. Still, this is generally the method that most people prefer.
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Display Ring Net Command
FixMaster has a command that displays the next sequential ring net. The advantage to this method is
that it will show you all ring nets, even those that do have a few endpoints, and it does not show you
any nets that are not ring nets. The disadvantage is that before using this feature you must first run an
operation to identify all of the ring nets in the loaded data, and that operation can take some time. Most
people generally prefer the other method.

To Display Ring Nets:
1. To run the operation that identifies the ring nets, you need to be in the regular editing mode,

so if you are already in Netlist Inspection Mode, exit by clicking the Exit   button on the
Netlist Inspection toolbar.

2. In the regular editing mode, go to the Action menu and click Ring Net.

3. On the Max Traces dialog, enter the largest size net you want to check for ring nets. Nets
that have more traces than the Max Traces value are not checked.

Max Traces Dialog

FixMaster identifies all of the ring nets in the loaded data. This can take a little while.

4. Enter Netlist Inspection mode by going to the Action menu and clicking Inspect Netlist.

5. On the Netlist Inspection toolbar, click the Ring  button.

FixMaster displays the first sequential ring net and adjusts the zoom level so that the selected ring
net fills the screen. In the message area of the Status Bar, FixMaster displays the net number and
the number of pads in the ring net, for the current layer.

6. To display the next sequential ring net, click the Ring  button again.

Menu: None

Button:

Key: None
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Edit Test Points
Many of the Netlist Inspection mode commands for editing test points are the same as the test point
editing commands in the normal editing mode; however, there are some unique commands also.

Switch the Active Board Side
You can switch the active board side between the component side and the solder side. The active side
is shown in the Status Bar, CMP and SOL. Unlike in the normal editing mode, both sides of the board
are shown in Netlist Inspection mode; however, commands for selecting or editing pads or test points
still operate only on elements in the active board side.

To Switch the Active Side between Component Side and Solder Side:

� In the Status Bar, click the Active Side  button.

Menu: None

Button:

Key: None

Selecting a Test Point or Pad
Selecting an element causes the cursor to hop to the nearest element, and the D Code, net number and
probe number of the selected element is displayed on the Status Bar.

To Select a Pad or Test Point:
� Position the cursor next to the test point or pad and press the S key.

Menu: None

Button: None

Key: S

Inserting Test Points
You can insert individual test points for single pads, groups of test points for all pads within the Frame,
or groups for pads of a selected D Code within the Frame. These commands are operated just as in the
normal editing mode except that they are activated from the Netlist Inspection toolbar by clicking the

Insert TP  button. See Insert Test Points on page 149.

Menu: None

Button:

Key: None
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Deleting Test Points
You can delete individual test points one at a time, delete groups of all test points within the Frame, or
delete groups of test points from pads of a selected D Code within the Frame. These commands are
operated just as in the normal editing mode except that they are activated from the Netlist Inspection

toolbar by clicking the Del TP  button.  See Delete Test Points on page 154.

Menu: None

Button:

Key: None

Adding Test Points to Nets that Do Not Have Enough Test Points
Netlist Inspection mode has a unique command that can be used to correct ring nets and other nets that
do not have enough test points to test for continuity.

This command overrides the test point generation options set on the Generate Config dialog when you
are automatically generating test points, and it allows FixMaster to add test points to nets that have less
than two test points.

This command also has a unique feature that determines if a net endpoint is covered by soldermask,
and if so, it searches the net for an open test point.

The command is a global command that affects some of the nets that you could eventually inspect by
clicking the No TP Nets command. It does not affect only the one net that can be displayed in Netlist
Inspection mode.

To Add Test Points to Nets that Do Not Have Enough Test Points:

� On the Netlist Inspection toolbar, click the Add TP to NTP  button.

Menu: None

Button:

Key: None
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Chapter 14
Split Nets

Some parts are too dense to test all nets simultaneously on fixtures of a given grid density or given
fixture height. In this case, you can split out some nets to be tested at an offset location on the same
fixture. You can also split nets to a separate job that is to be tested on a separate fixture or processed in
ProbeMaster and tested on a moving probe tester.

Split nets are shown highlighted in red. As the nets are split out, one test point from each of the split
nets is copied and left on the board with the unsplit nets. This allows you to test the unsplit nets for
shorts to the split nets.

You split nets after generating test points and dropping pins.

The operation is carried out in two steps:

1. Setting up where you want the split nets to be moved to (either to an offset location or to a
separate .JOB file). See Set Up Split Net Options on page 222.

2. Selecting the nets to be split out. See Split the Nets on page 225.

In addition, you may want to:

• Copy tooling hole information to the offset split nets. See Tooling Holes and Split Nets on
page 230.

• Copy and split one node from each unsplit net. See Test for Shorts between Split and Unsplit
Nets on page 231.

• Test densely packed components separately. See Testing Densely Packed Components
Separately on page 232. This procedure is not technically a Split Net operation, but it does
allow for testing different parts of a board separately.
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Set Up Split Net Options
The first part of the Split Net procedure is to configure the options for splitting nets:

Splitting Nets to an Offset Location on the Same Fixture
If you are going to test the split nets on the same fixture, split the nets to an offset location.

Note: Do not use this procedure or change the following options if you have already split out any
nets in this job.

To Split Nets to an Offset Location on the Same Fixture:
1. After generating test points and dropping pins, go to the Setup menu and click Split Net.

FixMaster displays the Split Net Configuration dialog.

Split Nets to the Same Job

2. In the Split Net group box, select Same Job.

3. Click the Offset option so that it has a checkmark.

4. In the X and Y offset fields, enter the distance to offset the split nets from the unsplit nets.

5. In the Layer group box, select whether you want to split nets for only the Current  board side
or for Both board sides.

6. Click OK .

7. Split the nets. See Split the Nets on page 225.

Note: Because you are offsetting split nets on the same fixture, after you split out the nets, you
should also Offset Tooling Holes. See Tooling Holes and Split Nets on page 230.
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Splitting Nets to a Different FixMaster Job or ProbeMaster Job
If you are going to test the split nets on a separate fixture or on a moving probe tester, split the nets to a
separate job.

Note: Do not use this procedure or change the following options if you have already split out any
nets in this job.

To Split Nets to a Different Job file for Testing on a Different Fixture or for Processing
in ProbeMaster:
1. After generating test points and dropping pins, go to the Setup menu and click Split Net.

FixMaster displays the Split Net Configuration dialog.

Split Nets to a Different Job

2. In the Split Net group box, select Different Job.

3. In the New Job File field, enter the name of the new job file that will contain the split nets.

Specifying the New Job name and closing this dialog does not save the .JOB file. When you are
done actually splitting the nets, then save a .JOB file. FixMaster will save two .JOB files, one for
the current job and one for the split nets. See Save a Job File on page 296.
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4. It is not necessary to offset split nets saved in a different .JOB file the way it is with nets split
to the same job, and generally you would not offset the nets, but it is an option.

If you do not want to offset nets, click the Offset option so that it has no checkmark.

To offset nets:

• Click the Offset option so that it has a checkmark.

• In the X and Y offset fields, enter the distance to offset the split nets from the unsplit
nets.

5. In the Layer group box, select whether you want to split nets for only the Current  board side
or for Both board sides.

6. In the Keep All Elements in Split Net File checkbox, select whether you want to copy all the
elements of the file to the split job. Later, when you actually split out the nets, you select
specific types of nets to split to the new job. See Split the Nets on page 225. This option
allows you to copy the rest of the elements that you did not specifically select to the split job.

• If Keep All Elements in Split Net File has a checkmark, then all elements will be copied
to the split job. This is recommended.

• If Keep All Elements in Split Net File does not have a checkmark, then only the
elements of the split nets will be copied to the split job. The other elements will not be
copied.

7. Click OK .

8. Split the nets. See Split the Nets on page 225.



Chapter 14 Split Nets

225

Split the Nets
Now that you have set up the options for the split-net operation, the second part of the procedure is to
actually split out the nets that you want to test separately. There are several ways to go about splitting
the nets, and each is outlined below.

Splitting Single Nets One at a Time
You can manually split nets one at a time.

To Split Single Nets One at a Time:
1. After the Split Net Options are set, go to the Action menu and click Split Net.

Split Single Nets

2. On the Split Netlist dialog, select Single Net and click OK .

The Net Splitting tool is selected, and FixMaster prompts you to select an element.

3. Position the cursor near a pad that is in a net you want to split.

4. Click  the mouse or press Enter.

The net containing the selected pad is split. The split net is highlighted in red.

The Net Splitting tool remains selected until you select another tool or press the Escape key, so
you can split or unsplit one net after another. To unsplit a split net, click on the red, highlighted
net with the Net Splitting tool.
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Splitting a Group of Nets that Have Pads in the Frame
You can split a group of nets that have pads inside the Reference Frame.

To Split a Group of Nets that Have Pads in the Frame:
1. After the Split Net Options are set, position the Frame around a group of pads that belong to

the nets you want to split.

2. On the Action menu, click Split Net.

Split a Group of Nets

3. On the Split Netlist dialog, select Group Nets and click OK .

Every net that has a pad inside the Frame is split. The split nets are highlighted in red.

The Net Splitting tool becomes selected, so you can split or unsplit single nets one at a time by
clicking on pads of the desired net. The Net Splitting tool remains selected until you select another
tool or press the Escape key, so you can split or unsplit one net after another.
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Splitting All Nets with Unassigned Test Points
Note: This is the most common form of net splitting.

This feature allows you to make your best effort to get all test points in the PCB assigned to the tester
grid, and have FixMaster automatically split out the nets of the remaining test points.

To Split All Nets with Unassigned Test Points:
1. On the Action menu, click Split Net.

Split All Nets with Unassigned Points

2. On the Split Netlist dialog, select All Unassigned and click OK .

Every net that has a pad with an unassigned test point is split. The split nets are highlighted in red.
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Splitting Nets with Unassigned Test Points in the Frame
This feature allows you to make your best effort to get all test points in a dense area assigned to the
tester grid, and have FixMaster automatically split out the nets of the remaining test points.

To Split Nets with Unassigned Test Points in the Frame:
1. Position the Frame around the pads with unassigned test points that are in the nets that you

want to split.

2. On the Action menu, click Split Net.

Split a Group of Nets with Unassigned Points

3. On the Split Netlist dialog, select Group Unassigned and click OK .

Every net that has a pad with an unassigned test point inside the Frame is split. The split nets are
highlighted in red.
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Split Flip
This feature allows you to split out unassigned test points, but instead of copying the entire net
containing the unassigned point, it copies the unassigned point and only one other point of that net.

To Do a Split Flip:
1. On the Action menu, click Split Net.

Split Flip

2. On the Split Netlist dialog, select Split Flip  and click OK .
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Tooling Holes and Split Nets
D Codes mapped as tooling holes are automatically saved with nets that are split out to a different
.JOB file. But when you split nets to an offset position on the same fixture, you also need to have
FixMaster copy and offset the D Codes mapped as tooling holes. For more information about Tooling
Holes, see PCB Tooling Holes and Fixture Alignment Pins on page 385.

Copy and Offset Tooling Holes for Split Nets:
1. After splitting nets, go to the Action menu, and click Split Net.

Offset Tooling Holes

2. On the Split Net dialog, select Offset Tooling Holes and click OK .

FixMaster automatically copies and offsets the D Codes mapped as tooling holes to the same
offset as the split nets.
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Test for Shorts between Split and Unsplit Nets
As nets are split out, one test point from each of the split nets is copied and left on the PCB with the
unsplit nets. This allows you to test the unsplit nets for shorts to the split nets. In order to do a
redundant test for shorts the other way, you can copy and split one node from each unsplit net.

Copy and Split One Node from each Unsplit Net:
1. After splitting nets, go to the Action menu, and click Split Net.

Split Extra Single Nodes

2. On the Split Net dialog, select Extra Single Nodes and click OK .

FixMaster copies and splits one node from each unsplit net.
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Testing Densely Packed Components Separately
In addition to splitting nets, there is another option in FixMaster and ProbeMaster for testing densely
packed components separate from the rest of a PCB. The Isolated Component Test feature allows for
an efficient way to completely test the nets associated with a densely packed component in two
different jobs.

In this case test points inside the densely packed component belong to nets that also have test points in
less densely packed areas. All the test points that are outside the densely packed area are tested as
usual along with the rest of the PCB. The test points that are inside the densely packed area are tested
separately using a test methodology that can handle the high density (a denser grid or a flying probe).
For every net that has a test point inside the densely packed area, one test point in that net that is
outside the densely packed area is also tested. That test point is the “bridge” between the two jobs
because it is tested with the densely packed region, and it is also tested along with the rest of the PCB.
The Isolated Component Test feature generates the “bridge” test points for the densely packed
component.

Note: The Isolated Component Test feature is not a Split Net operation because FixMaster does not
generate the two split jobs. You must save the two jobs separately. In one job you generate
test points for all but the densely packed component, and in the other job you generate test
points for the component and then use the Isolated Component Test feature to generate the
“bridge” test points outside the component.
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To Insert “Bridge” Test Points for a Single Net in a Densely Packed Component:
1. Position the Frame around the densely packed component.

2. On the Action Menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test Dialog, select Single.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net.

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net.

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net.

5. Click OK .

FixMaster prompts you to select an element.

6. Click inside a pad of the component that belongs to the net that you want to generate a
“bridge” test point for.

FixMaster inserts test points in the pads of the selected net that are inside the Frame. And if the net
has test points outside the Frame, FixMaster also inserts a test point in one (or all endpoints)
outside the Frame.
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To Insert “Bridge” Test Points for All Nets in a Densely Packed Component:
1. Position the Frame around the densely packed component.

2. On the Action Menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test Dialog, select Group and select All.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net(s).

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net(s).

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net(s).

5. Click OK .

6. Click inside the Frame.

FixMaster inserts test points in all the pads inside the Frame. And if the nets of the component
have test points outside the Frame, then for each net FixMaster also inserts a test point in one pad
(or all endpoints) outside the Frame.
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To Insert “Bridge” Test Points for Nets with a Specific D Code in a Densely Packed
Component:
1. Position the Frame around the densely packed component.

2. On the Action Menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test Dialog, select Group and select D Code.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net(s).

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net(s).

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net(s).

5. Click OK .

6. Click a pad inside the Frame that has the D Code you want to select.

7. Click again.

FixMaster inserts test points in all the pads inside the Frame that have the selected D Code. And if
the nets of the component have test points outside the Frame, then for each net FixMaster also
inserts a test point in one pad (or all endpoints) outside the Frame.
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Chapter 15
Wire Wrapping

In FixMaster wire wrapping is used to set up testing for several types of testers that do not rely
exclusively on conventional test fixtures. In some cases, such as clamshell testers, test points are wire
wrapped to pins on the fixture that then contact the test grid. In other cases, such as dedicated testers,
test points are wire wrapped directly to the tester without going through the grid. In both cases the
concept and the procedure is the same in FixMaster.

Wire Wrapping Outline:
1. First you set up a block of drills and tag them as a translation block. The drills of the

translation block represent the locations to which the test points will be wire wrapped.
FixMaster also has some preloaded translation blocks for specific testers. See Translation
Blocks below.

2. After the translation block is created, you automatically or manually assign each test point to
a translation block location. See Wire Wrap Test Points on page 243.

3. Before writing out the files, edit the road map for clarity. See Edit the Appearance of the
Wire Wrap Road Map on page 257.

4. Along with the other test and fixture files, export the wire wrap road map. See Export a
Gerber Road Map for Wire Wrapping on page 350.

Translation Blocks
The first step to wire wrapping is to create and tag the translation blocks. FixMaster will give an error
message if you attempt to go into Wire Wrap Mode without first creating a translation block. A
translation block is a block of drills that represent the locations to which the test points will be wire
wrapped. Each translation block is highlighted in a separate color, and the same color will be used to
represent the wire wrap path for test points wrapped to that block.

If you are using one of the testers for which FixMaster has pre-loaded translation blocks, you can use
the Custom Block command to automatically generate translation blocks for your tester.

If you are not using one of the testers for which FixMaster has pre-loaded translation blocks, you must
create a block of drills and use the Tag command to tag them as translation holes. You can also untag a
block by using the Untag command.
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Using Pre-Loaded Translation Blocks
FixMaster has pre-loaded translation blocks for some Everett Charles testers, for the TTI model 1400
and for some Utron testers. If you are using these testers you can use the pre-loaded translation blocks.

To Use Pre-Loaded Translation Blocks:

Note: Do not set up the pre-loaded translation blocks if you are not going to be using one of the
testers listed on the dialog box. This setup affects the format of the drill files and the tester
download files. If you open this dialog and are planning to use a different type of tester, select
None for the tester type.

1. On the Action menu, click Wire Wrapping-Custom Block.

FixMaster displays the Custom Block Dialog.

Custom Block Dialog

2. In the Custom Machine Type drop down list, select the tester you are using:

• ECT4K:  Generates new translation blocks for Everett Charles tester with 4096 test
points and deletes previously built translation blocks.

• ECT8K:  Generates new translation blocks for Everett Charles tester with 8192 test
points and deletes previously built translation blocks.

• ECT10K:  Generates new translation blocks for Everett Charles tester with 10240 test
points and deletes previously built translation blocks.

• TTI1400: Generates translation blocks for the TTI model 1400 tester. FixMaster uses
Unicated Translation Type 14 for addressing the top side fixture via the rear connectors.

• ECT4KBOTH:  Generates new translation blocks for Everett Charles tester with 4096
test points and deletes previously built translation blocks. Displays and wraps data for
both sides of the part.

• ECT8KBOTH:  Generates new translation blocks for Everett Charles tester with 8192
test points and deletes previously built translation blocks. Displays and wraps data for
both sides of the part.
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• UTRON/READ/KYOEI:  Generates new translation blocks for Utron, Read and Kyoei
testers and deletes previously built translation blocks.

• UTRONBOTH/KYOEIBOTH:  Generates new translation blocks for Utron, Read and
Kyoei testers and deletes previously built translation blocks. Displays and wraps data for
both sides of the part.

3. In the Tool Code field, enter the Tool Code to be used for the translation block drills.

4. In the Output Drill Holes checkbox, select whether the holes for the translation blocks are to
be exported in the drill files. Some testers wire wrap directly to the tester, not the fixture, so
translation holes do not need to be exported and drilled.

• To export all wired translation holes when writing drill files, click the Output Drill
Holes checkbox so that it has a checkmark.

• To select not to export translation holes when writing drill files, click the Output Drill
Holes checkbox so that it does not have a checkmark.

5. Click OK .

FixMaster prompts, “Existing translation blocks will be deleted. Continue?”

6. Click Yes.

7. If you are creating a TTI1400 custom block, you must enter the number of the first sequential
drill in the translation block. Subsequent drills are counted starting from this number.

FixMaster deletes any existing translation blocks and generates the new pre-loaded custom
translation blocks.

Menu: Action-Wire Wrap-Custom Block

Button: None

Key: None
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Creating Translation Blocks for Wire Wrapping
If you are not using one of the preloaded translation blocks for specific testers, you will have to create
your translation blocks manually.

To Create Translation Blocks for Wire Wrapping:
1. Make plate 0 the active, visible plate. Translation holes must be in plate 0.

2. On the Edit  menu, click Drill-Fixture-Change Tool  and select the Tool Code you want to
use for the translation block drills.

3. On the Edit  menu, click Drill-Fixture-Insert Drill .

4. Position the cursor where you want the lower left corner of the translation block and align
with the fixture grid.

5. Insert a drill by pressing the Enter key.

6. Position the Reference Frame around the drill.

7. On the Edit  menu, click Fixture-Drill-Step/Repeat.

FixMaster displays the step and repeat input box.

8. In the Copies X and Y fields, enter the number of drills you want in the translation block in X
and Y directions.

9. In the Step X and Y fields, enter the interval between drills in the X and Y directions. The
interval of the translation block must match the interval of the fixture grid.

10. On the Step/Repeat dialog, click OK .

FixMaster steps and repeats the drill as you specified.

11. Position the Reference Frame around the stepped-and-repeated pattern.

12. On the Action menu, click Wire Wrap-Tag .

FixMaster displays the translation block Sort Setup dialog.
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Translation Block Sort Setup

13. In the Direction group box, select a starting point and direction for your hole sort.

14. Select either a Serpentine or Straight sort.

Serpentine: Sorts translation holes in a forward and backward motion. When FixMaster reaches
the end of the row, it moves over by one band width, and sorts in the opposite direction. Not as
commonly used as the straight sort.

Straight:  Sorts translation holes only in one direction. When FixMaster reaches the end of the
row, it returns to the beginning of the row, moves over by one band width, and sorts again in the
same direction. The straight sort is recommended over the serpentine sort

15. Set the Band Width to a number less than the interval you specified in the Step and Repeat
operation. The Band Width is the width of the channel used in the sorting process.

16. In the Start Num field, set the number of the first sequential drill in the translation block.
Subsequent drills are counted starting from this number.

17. Click OK

FixMaster sorts the translation holes and tags the pattern as a translation block.

The translation block is shown in a unique color, and the wire wrap path for test points wrapped to
this translation block will have the same color.

Once the translation blocks are set up, you are ready to wire wrap.

Menu: Action-Wire Wrap-Tag (Block)

Button: None

Key: None
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Untagging a Translation Block
You can “untag” a group of drills that have been tagged as a translation block.

To Untag a Translation Block:
1. Position the Reference Frame around the tagged translation block.

2. On the Action menu, click Wire Wrap-Untag .

The colored highlighting is removed from the drills as they are untagged.

Menu: Action-Wire Wrap-Untag (Block)

Button: None

Key: None
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Wire Wrap Test Points
After you have tagged the translation blocks, it is time to wire wrap the test points to the translation
holes. You have the option of having FixMaster automatically wire wrap test points to translation holes
or of wire wrapping manually in Manual Wire Wrapping mode.

Wire Wrap All Test Points Automatically
In order to wire wrap test points automatically, you first set some parameters for how to sort the test
points. It is not necessary to enter Wire Wrapping mode to start the automatic wire wrapping function;
however, you may later have to manually add or delete some points or edit the wire wrap road map.

To Wire Wrap All Test Points Automatically:
1. On the Setup menu, click Wire Wrap .

FixMaster displays the Auto Wire Wrap Config dialog where you set the parameters for sorting
the test points. The direction of this sort is automatically matched to the sort direction of the
translation holes, which you have already set when creating the translation blocks. See Translation
Blocks on page 237.

2. Select whether you want FixMaster to sort test points using a closest neighbor sort or a band
sort.

Closest Neighbor: The next closest test point will be the next test point wrapped.

Band Width:  The next test point in the sort row will be the next test point wrapped.

3. If you select a Band Width sort, then you must also enter a Band Width to define the width of
the sort row.

4. On the Auto Wire Wrap Config  dialog, click OK .

5. On the Action menu, click Wire Wrap-Auto .

FixMaster automatically maps each test point to a translation hole. Translation blocks at the top of
the PCB are used first, then the blocks to the bottom, the right and finally the left side.

Each sequential wire wrapped test point is shown connected to the next by a line. The line
represents the wire wrap path and is shown in the same color as the translation block.

Menu: Action-Wire Wrap-Auto

Button: None

Key: None
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Wire Wrap Test Points Manually
All manual wire wrapping is carried out in Wire Wrap mode. In this mode you can edit an existing
wire wrap job that you generated using the automatic wire wrapping feature, or you can set up an
entire wire wrap job by hand.

Entering and Exiting Wire Wrapping Mode
To Enter Wire Wrap Mode:
� In the Action menu, click Wire Wrap-Manual .

The normal editing toolbars and menus disappear and are replaced by the Wire Wrapping Toolbar.

Menu: Action-Wire Wrap-Manual

Button: None

Key: None

To Exit Wire Wrap Mode and Return to Normal Editing:
� In the Action menu, click Quit .

Or

� Click the Exit  button on the Wire Wrapping Toolbar.

Menu: Action-Quit

Button:

Key: None
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Wire Wrap Toolbar
In Wire Wrapping mode, the normal editing toolbars and menus disappear and are replaced by the
Wire Wrapping Toolbar. There are also unique keyboard commands in Wire Wrapping mode that are
different than the key commands in the normal editing mode.

Wire Wrap Toolbar
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Select Translation Block
Because most wire wrapping commands add or remove wire wrapping to test points for only the
selected block, the most important step for most manual wire wrapping commands is to select the
translation block you want to work with. All test points wire wrapped to a translation block are shown
on a wire wrap path of the same color as the translation block.

To Select Translation Block:

1. In the Wire Wrapping  Toolbar, click the Select Translation Block  button.

2. Click near the translation block you want to use.

In the Message Line, FixMaster displays which translation block is selected, the number of holes
available in that block for wire wrapping, and the total number of holes in that block. You may
now wire wrap test points to the selected translation block.

Menu: None

Button:

Key: None

Wire Wrapping Test Points One at a Time
You can manually wire wrap test points one at a time.

To Wire Wrap Test Points One at a Time:
1. Select a translation block.

2. If you are using another wire wrapping tool, disengage it by pressing the Escape key or by
right-clicking  and selecting Abort  from the context menu.

3. Position the cursor near the test point you want to wire wrap and press the Spacebar.

A green cross marks the test point, and a line the color of the selected translation block connects it
to the previously wrapped test point, indicating the wire wrap path.

Menu: None

Button: None

Key: Spacebar
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Wire Wrapping a Group of Test Points onto the End of the Sequence
You can wire wrap a whole group of test points onto the end of the wire wrap sequence.

To Wire Wrap a Group of Test Points onto the End of the Sequence:
1. Select a translation block.

2. On the Wire Wrap  toolbar, click the WinWrap   button.

3. Click where you want the first corner of the Frame and drag to the other corner so that the
points you want to wire wrap are inside the Frame.

FixMaster displays options for how to sort the test points in the Frame.

Wire Sort Type Dialog

4. Select whether to sort test points in the Frame using a closest neighbor or a band sort.

Closest: The sort path will go from the last wrapped point to the next closest point in the Frame.

Up, Down, Left, and Right Arrows: The sort path will go from the last wrapped point to the next
point in the selected direction.

5. To add points to the end of the existing wire wrap sequence, click the Insert After Last Wire
Wrapped Test Point option so that the option has a checkmark.

FixMaster prompts you to select the first test point to wrap

6. Click near the test point inside the Frame with which you want to start.

FixMaster wire wraps all the test points in the Frame, starting with the one you selected.

This tools remains selected until you select another tool or press the Escape key. You can wrap
one Frame region after another.

Menu: None

Button:

Key: None
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Wire Wrapping a Group of Test Points into the Middle of the Sequence
You can wire wrap a whole group of test points into the middle of the wire wrap sequence.

To Wire Wrap a Group of Test Points into the Middle of the Sequence:
1. Select a translation block.

2. On the Wire Wrap  toolbar, click the WinWrap   button.

3. Click where you want the first corner of the Frame and drag to the other corner so that the
points you want to wire wrap are inside the Frame.

FixMaster displays options for how to sort the test points in the Frame.

Wire Sort Type Dialog

4. Select whether you want FixMaster to sort test points in the Frame using a closest neighbor
sort or a band sort.

Closest: The sort path will go from the last wrapped point to the next closest point in the Frame.

Up, Down, Left, and Right Arrows: The sort path will go from the last wrapped point to the next
point in the selected direction.

5. To add points to the middle of the existing wire wrap sequence, click the Insert After Last
Wire Wrapped Test Point option so that the option does not have a checkmark.

In the message line FixMaster prompts you to pick the existing wire wrapped test point after
which to insert the new wire wrapped points.

6. Click the left mouse button near the wire-wrapped test point that you want to be before the
new points you want to add.

The cursor snaps to the selected point. FixMaster will break the sequence after the point you
selected. Then, after you have wrapped the new points, FixMaster will resume the sequence after
the point where it was broken.

FixMaster prompts you to select the first test point to wrap
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7. Click near the test point inside the Frame with which you want to start.

FixMaster automatically wire wraps all the test points within the Frame, starting with the test point
you selected.

This tools remains selected until you select another tool or press the Escape key. You can wrap
one Frame region after another.

Menu: None

Button:

Key: None

Unwrapping the Last Test Point in the Wire Wrap Sequence
You can undo the wire wrapping for the last point in the wire wrap sequence.

To Undo Wire Wrapping for Last Wire Wrapped Test Point:
1. Select a translation block.

2. Press the Backspace key.

The last wrapped test point of the selected translation block is now unwrapped. The green cross
moves to the previously wrapped test point. The wire wrap path line is removed from the
unwrapped test point.

You can sequentially unwrap one test point after another by simply activating the command
repeatedly.

You can also designate another translation block and sequentially unwrap test points from it.

Menu: None

Button: None

Key: Backspace
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Unwrapping a Single Test Point Anywhere in the Sequence
FixMaster has a tool that allows you to undo wire-wrapped test points one at a time for the selected
translation block. Once the feature is activated, you click on the points you want to unwrap. This
feature allows you to break into a sequence of wire-wrapped test points, and remove wire-wrapped
points from the middle of the sequence.

To Undo Wire Wrapping for a Group of Test Points:
1. Select a translation block for which you want to undo wire-wrapped test points.

2. On the Wire Wrap  toolbar, click the Unwrap  button.

3. On the Unwrap dialog, click Single and click OK .

4. Click on the test point you want to unwrap. The selected test points can be anywhere in the
wire-wrap sequence, not just at the end.

The cursor snaps to the test point.

5. Click again.

FixMaster undoes the wire wrapping for the test point. If the test point was in the middle of the
wire-wrap sequence, the sequence now skips from the wire-wrapped point before the removed
point to the wire-wrapped point after it.

This tool remains selected until you select another tool or press the Escape key, so you can
unwrap one test point after another.

Menu: None

Button:

Key: None
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Unwrapping a Group of Test Points
FixMaster has a tool that allows you to undo the wire-wrapped test points within an area for the
selected translation block. Once the feature is activated, you create a Reference Frame around the
points you want to unwrap. This feature allows you to break into a sequence of wire-wrapped test
points, and remove wire-wrapped points from the middle of the sequence.

To Undo Wire Wrapping for a Group of Test Points:
1. Select a translation block for which you want to undo wire-wrapped test points.

2. On the Wire Wrap  toolbar, click the Unwrap  button.

3. On the Unwrap dialog, click Group and click OK .

4. Click where you want the first corner of the Frame and drag to the other corner so that the
points you want to unwrap are inside the Frame. The selected test points can be anywhere in
the wire-wrap sequence.

5. When the Reference Frame is positioned, click again.

FixMaster automatically undoes the wire wrapping for all the test points within the Frame and
wire wrapped to the selected translation block. If the test points were in the middle of the wire-
wrap sequence, the sequence now skips from the wire-wrapped point before the removed points to
the wire-wrapped point after them.

This tool remains selected until you select another tool or press the Escape key, so you can
unwrap one group of test points after another.

Menu: None

Button:

Key: None
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Smooth Region
FixMaster has a command that attempts to automatically reorder the wire wrap path to remove areas
where the path crosses over itself. This makes the wire wrap path easier to read.

To Automatically Smooth Areas where the Wire Wrap Path Crosses Itself:
1. Select a translation block for which you want to smooth the wire wrap path.

2. On the Wire Wrap  toolbar, click the Smooth Region  button.

3. Click where you want the first corner of the Frame and drag to the other corner so that the
points you want to smooth are inside the Frame. The selected test points can be anywhere in
the wire-wrap sequence.

4. When the Reference Frame is positioned, click again.

FixMaster automatically reorders the wire wrap path to remove areas where the path crosses over
itself.

This tool remains selected until you select another tool or press the Escape key, so you can
smooth one region after another.

Menu: None

Button:

Key: None
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Before the Smooth Region Operation the Path Crosses Over Itself

After the Smooth Region Operation the Path Does Not Cross Over Itself
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Copy Block
This command copies a segment of the wire wrap path to another identical block of test points. For
instance, if a part is wrapped in a particular way, and that part appears elsewhere on the same board,
the Copy Block command allows you to wrap the second block in exactly the same way that the first
was wrapped.

Menu: None

Button:

Key: None

Swap Test Points
FixMaster has a command to swap the order of two points in the wire wrap path.

To Swap the Order of Two Points in the Wire Wrap Path:
1. Select a translation block for which you want to swap points in the wire wrap path.

2. On the Wire Wrap  toolbar, click the Swap Test Points  button.

3. Click near one of the points you wan to swap.

4. Click near the other point you wan to swap.

FixMaster reorders the wire wrap path so that the two points trade position in the path.

Menu: None

Button:

Key: None
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Before the Swap Points Command

After the Swap Points Command
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Go To First, Next, or Previous Wrapped Test Point
FixMaster has commands to move the cursor to the first, next, or previous wrapped test point of the
selected translation block respectively. If the indicated test point is on the screen, the cursor hops to it
and marks it with a green cross. If it is not on the screen, FixMaster redraws the data at the present
zoom level with the test point placed at screen center and marks it with a green cross.

The sequence is the same as that indicated by the colored wire wrap path. Use these commands
together to find every wrapped test point of the selected translation block in sequence.

To Go To the First, Next, or Previous Wrapped Test Point:
1. Select a translation block.

2. Press the F, N, or B keys.

Menu: None

Button: None

Key: F, N or B keys
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Edit the Appearance of the Wire Wrap Road Map
The wire wrap road map aids in the actual physical wire wrapping of test points to translation blocks.
In FixMaster the road map is represented on screen by test points, test point numbers, the colored wire
wrap path, and colored translation blocks. The colored wire wrap path indicates the sequence of the
wire wrapped points for each translation block. The test point numbers appear periodically on the wire
wrap path to help keep track of the sequence. The road map can be output from FixMaster in Gerber
format and later plotted for hard copy.

In order to be a helpful tool during the actual wire wrapping, the road map must be clear and easy to
read. The manual wire wrapping mode has commands for editing the representation of test point
numbers and the wire wrap path to make easy-to-read road maps.

Set up Test Point Number Parameters
Each wire wrapped test point is linked to a specific numbered hole in the translation block. You can
display the test point numbers that correspond to the numbered translation block points. There are
several options for how to display the test point numbers on the road map.

To Set up Test Point Number Parameters:

1. On the Wire Wrap  toolbar, click the Setup  button.

FixMaster displays the Wire Wrap text setup dialog where you set the parameters for displaying
the road map test point numbers.

Wire Wrap Road Map Text Setup Dialog

2. In the Size field, enter the size of the digits to be used for test point numbers.

3. In the Offset field, enter the distance the test point numbers will be offset from the test point.
The offset allows the number to be set away from the wire wrap path.
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4. In the Step Number field, enter how often you want a test point number to be displayed on
the wire wrap path.

All test points are counted in the number sequence, but the number does not need to be displayed
for every test point. For example, entering 1 would display every test point number, while entering
10 would display numbers for every tenth test point.

5. In the Mirror Text  checkbox, select whether to mirror the text of the test point numbers or to
show the test point numbers in the normal orientation.

• To display the digits in reverse, as if in a mirror, click the Mirror Text  option so that it
has a checkmark. This is useful if the road map is going to be output to film and used in
the reverse orientation.

• To display the digits in the normal orientation, click the Mirror Text  option so that it
does not have a checkmark.

6. If you want the system to redraw the wire wrap path as you add new test points, select the
Redraw option. If this option is not checked, the system may not immediately display the
new test point numbers as you add new test points to the path, but the numbers will be
displayed as soon as the screen is redrawn by zooming or panning. If this option is selected,
the numbers will be displayed as soon as you add new test points to the path.

7. Click OK .

Menu: None

Button:

Key: None
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Adding a Test Point Number
The test point parameters include a setting for how frequently FixMaster will automatically display a
test point number on the wire wrap path. However, you may want to add numbers to test points that are
important reference points but which were not automatically numbered. FixMaster allows you to
display the number of a test point whose number was not previously shown.

To Add a Test Point Number:

1. On the Wire Wrap  toolbar, click the Add Number  button.

2. Click on the test point for which you want to add the number.

The test point is marked with a green cross and the number is displayed. A white line that
represents the number offset connects the cursor to the test point.

Added Number at Initial Position

3. Move the cursor to where you want the number to be positioned and click the left mouse
button again.
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The test point number moves to the cursor location.

Added Number at Final Position

The Add Number tool remains selected until you select another tool or press the Escape key, so
you can add one test point number after another.

Menu: None

Button:

Key: None



Chapter 15 Wire Wrapping

261

Deleting a Single Test Point Number
You can delete a test point number from the wire wrap Road Map.

To Delete a Test Point Number:

1. On the Wire Wrap  Toolbar, click the Delete  button.

2. On the Delete Text dialog, click Single and click OK .

3. Click on the test point for which you want to delete a test point number.

The cursor snaps to the test point.

Before Deleting Number

4. Click again.
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The test point number is deleted

After Deleting Number

The Delete Number tool remains selected until you select another tool or you press the Escape
key, so you can delete more than one test point number.

Menu: None

Button:

Key: None
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Deleting a Group of Test Point Numbers
You can delete a group of test point numbers from the wire wrap Road Map.

To Delete a Group of Test Point Numbers:

1. On the Wire Wrap  Toolbar, click the Delete  button.

2. On the Delete Text dialog, click Group and click OK .

3. Click where you want one corner of the Frame and then drag the Frame across all the test
points for which you want to delete numbers.

Frame Positioned to Delete Numbers

4. Click again.
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The test point numbers inside the Reference Frame are deleted.

After Numbers are Deleted for Test Points Inside Frame

The Delete Number tool remains selected until you select another tool or you press the Escape
key, so you can delete more than one group of test point numbers.

Menu: None

Button:

Key: None
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Change Test Point Number Offset
The test point parameters include a setting for how far FixMaster will automatically offset a test point
number from the wire wrap path. However, you can manually change the offset in order to move the
numbers out of the way of the wire path.

To Change Test Point Number Offset:

1. On the Wire Wrapping  toolbar, click the Offset Text  button.

2. Click on the test point for which you want to offset the number.

The test point is marked with a green cross and a white line representing the new offset connects
the test point to the cursor.

The Test Point is Selected and the White Line Represents a New Offset

3. Move the cursor to the new offset.

4. Click the left mouse button.
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The numbers moves to the new offset position.

The Number Moves to the New Offset

The Change Offset tool remains selected until you select another tool or press the Escape key, so
you can change the offset of more than one test point number.

Menu: None

Button:

Key: None
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Rotating the Text of Test Point Numbers to New Orientations
The text of the test point numbers can be displayed at different orientations. Each orientation is a
multiple of a 90-degree angle. You may want to change the orientation of a test point number in order
to move the number out of the way of the wire-wrap path.

To Rotate the Text of a Test Point Number to New Orientation:

1. On the Wire Wrapping  toolbar, click the Rotate Number  button.

2. Click near the test point that has a number you want to rotate.

The cursor hops to the test point.

The Selected Test Point Number Before Rotation

3. Click again.
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FixMaster displays the Rotate Number dialog.

Rotate Number Dialog

4. Select the Rotation Angle and click OK .

FixMaster rotates the text of the test point number to the new orientation.

The Number is Rotated

The Rotate Number tool remains selected until you select another tool or press the Escape key, so
you can rotate the text of one number after another.

Menu: None

Button:

Key: None
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Optimizing Test Point Number Offset
FixMaster has a feature that attempts to position all test point numbers away from the wire wrap path.
This operation does not change the length of the offset, just the angle. Double-check the test point
numbers after you use this command to make sure they are positioned the way that you want them.

To Optimize Test Point Number Offset:

� On the Wire Wrap  toolbar, click the Optimize Path  button.

Menu: None

Button:

Key: None
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Changing the Size of the Test Point Number Text
You can change the size of the text used to display the test point numbers.

To Change the Size of the Test Point Number Text:

1. On the Wire Wrap  toolbar, click the Change Number Size  button.

2. Select Single and click OK .

3. Click near the test point for which you want to change the size of the number text.

The cursor hops to the test point.

Before the Number’s Size has Changed

4. Click again.

5. On the Size dialog, enter the size that you want the number to be and click OK .
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The text of the test point number changes to the new size.

The Number Changes to the New Size

The Change Size tool remains selected until you select a new tool or press the Escape key, so you
can change the size of more than one number.

Menu: None

Button:

Key: None
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Edit the Route of the Wire Wrap Path
By default FixMaster shows the wire wrap path as straight-line segments between consecutive wire
wrapped points. FixMaster allows you to put an elbow in a segment of the path and make it into two
segments. With this feature you can reroute the path so that it is not as cluttered.

Adding an Elbow to a Segment of Wire-Wrap Path
You can add an elbow to the wire wrap path so that the straight-line segment does not pass directly
over other elements.

To Add an Elbow to a Segment of Wire-Wrap Path:

1. On the Wire Wrap  toolbar, click the Add Path  button.

Wire Wrap Path Before the Elbow is Inserted

2. Click near the path segment you want to change.
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The path segment is broken into two segments and the elbow is selected.

The Elbow is Selected

3. Position the elbow where you want it and click the left mouse button again.
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The path segment is replaced by the two segments that meet in an elbow.

The Wire Wrap Path is Rerouted

The Add Path tool remains selected until you select a new tool or press the Escape key, so you
can edit other path segments.

After you have rerouted a path segment using the Add Path command, you can restore the original
straight-line path segment or add a new elbow.  See Restoring the Original Straight-Line Segment
on page 275.

Menu: None

Button:

Key: None
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Restoring the Original Straight-Line Segment
To Restore the Original Straight-Line Segment:

1. On the Wire Wrap  toolbar, click the New Path  button.

2. Click near an endpoint of the path segment you want to restore.

The straight-line path segment that was broken into multiple segments is restored. At the same
time, the path segment is broken into two new segments and the elbow is selected.

3. If you want to leave the restored straight-line path segment connecting the two test points as it
is, press the Escape key.
Or
If you want to reposition the elbow, move it to where you want it and click.

The path segment is replaced by the two segments that meet in an elbow. And the Add Path tool
that allows you to break path segments two segments that meet in an elbow is now selected. This
tool remains selected until you select a new tool or press the Escape key, so you can edit other
path segments.

Menu: None

Button:

Key: None
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Hide a Segment of the Wire Wrap Path
FixMaster allows you to hide segments of the wire wrap path so that they are not shown on screen or
exported in the Gerber road map. FixMaster automatically displays the test point numbers for the
endpoints of the hidden segment so that the sequence will not be lost. You can use this feature to hide
long segments that cut across other portions of the plot.

To Hide Wire-Wrap Path Segment:

1. On the Wire Wrap  toolbar, click the Hide Number  button.

2. Click near the path segment you want to hide.

The path segment is selected.

Before the Path Segment is Hidden

3. Click again.
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The path segment is hidden.

After the Path Segment from Point 716 to 717 is Hidden

The Hide Path tool remains selected until you select another tool or press the Escape key, so you
hide one segment after another.

After you have hidden a segment of the wire wrap path with the Hide command, you can always
restore its visibility using the Unhide Number button. See Restoring Visibility to Hidden Segments
of Wire-Wrap Path on page 278.

Menu: None

Button:

Key: None
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Restoring Visibility to Hidden Segments of Wire-Wrap Path
If you have hidden segments of the wire wrap path, you can restore visibility to those segments.

To Restore Visibility to Hidden Segments of Wire-Wrap Path:

1. On the Wire Wrap  toolbar, click the Unhide Number  button.

2. Click near the first test point of the path segment you want to restore. When the path segment
was hidden, FixMaster automatically displayed the test point numbers for the endpoints of the
hidden segment. You must select the first endpoint of the hidden segment.

The cursor snaps to the test point.

Before the Hidden Segment between Points 716 and 717 is Restored

3. Click again.
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The path segment is restored.

After the Segment is Restored

The Unhide Number tool remains selected until you select another tool or press the Escape key, so
you can restore other hidden path segments.

Menu: None

Button:

Key: None
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Chapter 16
Add Spacers, Air Holes and Guter Holes

When all the test points are assigned and all the design rule errors are corrected, you can add spacers
air holes and Guter holes to the fixture before outputting the drill and tester files.

Spacers
When spacers are installed in a fixture, they may require different size drills for different fixture plates.
Also the actual spacer will be larger than the drill used for mounting it. FixMaster has a feature that
allows you to configure spacers to have different drill diameters and different spacer diameters for
different plates. When you insert a spacer, FixMaster will display the largest spacer diameter so you
can see if the spacer will fit. When the drill files are output, FixMaster will output the proper drill
diameter for each plate.

This feature allows you to configure several types of spacers to be used for stiffening the fixture. These
spacers will probably be different from those used for outside tooling. For outside tooling you can set
up a stack of drills with appropriate drill sizes for each plate in Drill mode, and then copy the whole
stack to each outside tooling location. See Set Up the Fixture Outside Tooling on page 83.

Fixture with Spacers
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Set Up Spacers
Before you insert spacers, you must set up the parameters for the spacers that you want to use.

To Set Up Spacers:
1. On the Setup menu, click Fixture-Spacers.

FixMaster displays the Spacer/Guter Setup dialog table. On the Spacer Config tab, there is a
table that allows you to set up six different spacers with display diameters and drill diameters for
each plate.

Guter/Spacer Dialog, Spacer Config Tab

2. For the first spacer, enter the diameter to display the actual spacer in the Display table.

For a given spacer, there is only one spacer Display diameter, regardless of the plate. The spacer
will be shown on screen at this Display diameter for visual inspection purposes. This way you can
determine visually if the spacer is going to interfere with any other element of the fixture. To give
yourself some extra margin, you can make this diameter a little larger than the size of the actual
spacer.

3. For the first spacer, go to the Plate table and enter the diameter of the drill needed for
mounting the spacer in each plate.

The diameters in the Plate table will be exported for each plate in the drill files.

That completes the setup of the first spacer. You may set up any other spacers that you want to use
in the same way.
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Insert Spacers
Before you insert spacers, you must set up the parameters for the spacers that you want to use. See Set
Up Spacers on page 282.

When inserting spacers, you should display the PCB data so that you can decide where to place the
spacers and you can be sure that spacers are not interfering with features of the board or the fixture.

To Display the PCB Data:
� On the View menu, click Data Elements and look at the menu item that says PCB.

• If the PCB menu item has a checkmark, then the PCB data is being displayed, and you
don’t need to do anything.

• If the PCB menu item does not have a checkmark, then click PCB so that it has a
checkmark and the PCB data is displayed.

You insert and delete spacers in almost the same way that you insert and delete drills.

To Insert Spacers One at a Time:
1. On the Edit  menu, click Fixture-Spacers-Insert Spacer.

Insert Spacer Dialog

2. On the Insert Spacer dialog, select the spacer code for the type of spacer you wan to insert.

3. Position the cursor at the desired insertion point.

4. Click  the mouse or press Enter.

FixMaster inserts a spacer of the selected spacer code at the cursor position.

The Insert Spacer tool remains selected until you select another tool or press the Escape key, so
you can insert one spacer after another.

Menu: Edit-Fixture-Spacers-Insert Spacer

Button:  then 

Key: Shift+R
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To Automatically Insert a Group of Spacers and Air Holes:

Note: Before the Autospacer operation can be run, test points must be assigned to the grid points.
See Assign Test Points to Tester Grid Points on page 177.

1. On the Setup menu, click Fixture-Spacers.

Space/Guter Setup Dialog, Auto Spacer Tab

Note: You can automatically insert spacers and air holes simultaneously. If you want to insert
only spacers, then enter zero for the Plate Number in the Air Holes group box to disable
air hole insertion. Or if you want to insert only air holes, then enter zero for the Spacer
Number in the Spacers group box to disable spacer insertion.

2. To set up spacers, enter the following in the Spacers group box of the Auto Spacer tab:

Spacer Number: This identifies a spacer set up on the Spacer Config Tab. Enter zero to disable
spacer insertion.

Note: To automatically insert two types of spacers simultaneously, set the Spacer Number to 2.
The program will place spacer number 1 inside the part and spacer number 2 outside the
part.
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Type: Select whether to add spacers in a grid fashion or by pin density.

• Density: The Density method determines how many pins press against the part and
automatically generates spacers to distribute the load. If you select the Density method,
enter values for the Pin Density and the Keep Away distance.

• Grid:  The Grid method automatically inserts spacers in a grid fashion. If you select the
Grid method, enter values for the Spacing, Border, Keep Away and Search.

Pin Density: The number of pins that require a spacer when using the Density option.

Spacing X, Y: Distance between spacers entered with the Grid option.

Border:  Distance from the edge of the part. The edge is determined by looking at the extents of
the data or from a Board Outline file (BOL), imported as a miscellaneous Gerber file. See Import
Supplemental Gerber Files into the Job on page 312.

Keep Away: Distance from pins and other elements.

Search: If a spacer cannot be placed directly on a grid point due to a conflict with pins and other
elements, the search value indicates the distance to look for an open spot to place the spacer.

3. To set up air holes, enter the following in the Air Holes group box of the Auto Spacer tab:

Plate Number: This identifies the plate where the air holes are to be inserted. Enter zero to
disable air hole insertion.

Spacing X, Y: Distance between air holes.

Border:  Distance from the edge of the part. The edge is determined by looking at the extents of
the data or from a Board Outline file (BOL), imported as a miscellaneous Gerber file. See Import
Supplemental Gerber Files into the Job on page 312.

Keep Away: Distance from pins and other elements.

Search: If an air hole cannot be placed directly on a grid point due to a conflict with pins and
other elements, the search value indicates the distance to look for an open spot to place the air
hole.

Hole Size: Size of the air holes.

4. Click OK  on the Space/Guter Setup dialog.

5. On the Edit  menu, click Fixture-Spacers-Auto Spacer.

The spacers and air holes are automatically inserted into the fixture.

If you repeat the automatic spacer insertion operation, the old spacers are automatically deleted
before the new ones are inserted. Air holes are not automatically deleted and must be manually
deleted. See Deleting Drills on page 89.

Menu: Edit-Fixture-Spacers-Auto Spacer

Button: None

Key: None
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Fixture before Spacers and Air Holes are Inserted

Fixture after Spacers and Air Holes are Inserted
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Delete Spacers
You can delete spacers one at a time or delete a group of spacers inside the Reference Frame. When
you run the operation to automatically insert spacers, the old spacers are automatically deleted before
the new ones are inserted. For more information on automatically inserting spacers, see Insert Spacers
on page 283.

To Delete Spacers One at a Time:
1. On the Edit  menu, click Fixture-Spacers-Delete.

Delete a Single Spacer

2. On the Delete Spacer dialog, select Single and click OK .

3. Position the cursor near the spacer you want to delete.

4. Click  the left mouse button or press the Enter key.

The cursor jumps to the center of the spacer.

5. Again, click the left mouse button or press the Enter key.

FixMaster deletes the spacer.

The Delete Spacer tool remains selected until you select a new tool or press the Escape key, so
you can delete one spacer after another.

Menu: Edit-Fixture-Spacers-Delete Spacer

Button:  then 

Key: None
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To Delete a Group of Spacers inside the Frame:
1. Position the Reference Frame around the spacers you want to delete.

2. On the Edit  menu, click Fixture-Spacer-Delete Spacer.

Delete a Group of Spacers

3. On the Delete Spacer dialog, select Group and click OK .

4. Click  the left mouse button or press the Enter key.

FixMaster deletes the spacers inside the Frame.

Menu: Edit-Fixture-Spacers-Delete Spacer

Button:  then 

Key: None
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Air Holes
Air holes may be inserted as part of the process of automatically inserting spacers. See To
Automatically Insert a Group of Spacers and Air Holes: on page 284.

Air holes may be deleted the same way any drill hole is deleted. See Deleting Drills on page 89.

Guter Holes
Guter Holes are specific tooling used to align a PCB to an Everett Charles universal tester. This tooling
is used by an autoloader that is specific to the Everett Charles 909X series of testers.

Setting up Guter Holes
To Set up Guter Holes:
1. On the Setup menu, click Fixture-Spacers.

2. On the Guter Setup tab of the Spacer/Guter dialog, enter the parameters as called for in your
tester specification.

Guter Setup Tab

3. Click OK  on the Space/Guter Setup dialog.

4. On the Edit  menu, click Fixture-Guter .

The Guter holes are automatically inserted into the fixture.
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Chapter 17
File Handling in FixMaster

The FixMaster Job File (.JOB) is the native file format for FixMaster and contains all information
regarding the current state of the database and program settings. The .JOB file is the only file type that
the program Opens and Saves. However the program can Import other file types into the open .JOB
file and Export other file types from the .JOB file.

FixMaster Job File (.JOB) Overview
The Job File (.JOB) is the native file format for FixMaster and contains all information regarding the
current state of the database and operation settings:

Fixture Configuration:

• Fixture Plates and Tooling

• Fixture Grid Size

• Probe Diameters

• Probe Air Gaps

• Probe Margins

Operation Variables:

• D Code and Probe Mapping

• Stagger Options

• Generate Options

PCB database:

• Pads, Traces, Netlist data

• Test Points

• Test Point to Grid Point Assignment

Boilerplate Job Files
.JOB files can be used as boilerplate fixture files that can be saved and reopened when you have
similarly configured jobs. A boilerplate .JOB file is saved with the fixture configuration and operation
variables, before the PCB database is loaded.

Job Files for ProbeMaster and Verify
FixMaster .JOB files can also be opened in the Lavenir products ProbeMaster and Verify.

Generally the FixMaster .JOB files that are opened in ProbeMaster are those that are saved after a Split
Net operation, and they contain nets that have been split out for testing on a moving probe tester. For
more information on splitting nets, see Split Nets on page 221.

FixMaster and ProbeMaster .JOB files of completed jobs can be opened in Verify for fault verification.
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Start a New FixMaster Job
The New command creates a new .JOB file that has nothing in it and is ready to have other files
imported into it or to have data inserted into it. The program can only have one .JOB file open at a
time; so, if a different .JOB file is already open when you start a new .JOB file, then the program
prompts to give you an opportunity to save the existing .JOB file before starting the new .JOB file.

To Start a New FixMaster Job:
1. On the File menu, click New.

FixMaster may prompt, “Are you sure?” This prompt is to warn you that you are about to close the
currently opened .JOB file and open a new one. This gives you an opportunity to save the existing
.JOB file before starting the new .JOB file

New File Prompt

2. Click Yes.

The newly created FixMaster .JOB file has nothing in it.

Menu: File-New

Button:

Key: Ctrl+N
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Open a FixMaster Job File
The Open command opens a previously saved .JOB file. The program can only have one .JOB file
open at a time; so, if a different .JOB file is already open when you open another .JOB file, then the
program prompts to give you an opportunity to save the existing .JOB file before opening the new
.JOB file.

Tip: To open a .JOB file you've used recently, click the file name on the Recent Files List at the
bottom of the File menu.

To Open a FixMaster Job:
1. On the File menu, click Open.

Open File Dialog

2. In the Look in box, click the drive, folder, or network location that contains the .JOB file.

3. In the folder list, double-click folders until you open the folder that contains the .JOB file you
want.

4. Double-click the .JOB file.
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FixMaster may prompt, “Are you sure?” This prompt is to warn you that you are about to close the
currently opened .JOB file and open a new one. This gives you an opportunity to save the existing
.JOB file before opening the new .JOB file.

Open File Prompt

5. Click Yes.

Menu: File-Open

Button:

Key: Ctrl+O
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Close a FixMaster Job File
The program can have one and only one .JOB file open at a time; so, closing the current .JOB file
without opening another one is the same as exiting the program. The Open and New commands
automatically close the current .JOB file; so, if a different .JOB file is already open when you open
another .JOB file, then the program prompts you to save and close the existing .JOB file before
opening the new .JOB file.

To Close a Job File:
1. On the File menu, click Exit .

Closing a .JOB file does not automatically save the .JOB file. FixMaster may prompt, “Are you
sure?” This gives you an opportunity to save the .JOB file before closing it.

Close File Prompt

2. Click Yes.

Tip: If you have made a bad mistake in your editing since the last time you saved and you
want to go back to your saved version, close the file without saving and then open the
saved version.

Menu: File-Exit

Button: None

Key: None
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Save a Job File
There are several ways to save a .JOB file.

To Save a New, Unnamed FixMaster Job File:
1. On the File menu, click Save.

Save As Dialog

2. To save the FixMaster .JOB file in a different folder, click a different drive in the Save in
box, or double-click a different folder in the folder list.

To save the FixMaster .JOB file in a new folder, click Create New Folder.

3. In the File name box, type a name for the .JOB file.

Menu: File-Save

Button:

Key: Ctrl+S
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To Save a Copy of a Job File:
1. On the File menu, click Save As.

Save As Dialog

2. To save the copy in a different folder, click a different drive in the Save in box, or double-
click a different folder in the folder list.

To save the copy in a new folder, click Create New Folder.

3. In the File name box, type a name for the copy.

Menu: File-Save As

Button: None

Key: None
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To Save Work in Progress:
When you have work in progress that you want to save in case of power failure or because you need to
shut down the program, you can save it under the current file name and overwrite the original .JOB
file.

1. To save the open .JOB file under the current file name, go to the File menu, and click Save.

FixMaster prompts for whether you want to overwrite the existing file.

Save File Prompt

2. Click OK .

Menu: File-Save

Button:

Key: Ctrl+S
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Import PCB Files into the Job
The program imports several formats of PCB data, including Gerber and several netlist formats.

Import IPC-D-356 Formatted Netlist Files into the Job
FixMaster imports IPC-D-356 formatted netlists including the Lavenir Format 4 and Format 2 netlists
(.F02 and .F04 files). If you want to import another format of netlist you may be able to convert it to a
Lavenir format. See Convert Netlist Files to Lavenir Format on page 303.

To Import IPC-D-356 Formatted Netlist Files into the Job:
1. On the Files Menu, click Import-Netlist .

Import Netlist File Dialog

2. In the Look in box, click the drive, folder, or network location that contains the netlist file.
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3. In the folder list, double-click folders until you open the folder that contains the netlist file
you want.

4. Click on the netlist file that you want.

5. Click the Options button.

Netlist File Setup Dialog

6. Select whether the incoming data is in English or Metric  units.

7. Select whether the incoming data has Numeric or Alphanumeric IPC Signal ID.

8. Format 4 netlists can contain trace data. Select whether to read in the trace data.

• Do Not Ignore: Reads in all traces.

• Ignore All:  Does not read in any traces.

• Ignore Inner:  Reads in component-side and solder-side traces, but does not read in
traces on inner layers.



Chapter 17 File Handling in FixMaster

301

9. Select whether to swap the component-side and solder-side data.

• Clicking this option so that there is a checkmark means FixMaster swaps the
component-side and solder-side data. This is not the same as flipping the data. The
orientation of the data remains the same, but the layers are switched.

• Clicking this option so that there is no checkmark means FixMaster does not swap the
data. The layers are read in as is.

10. Orient Board Layers to Tester Grids.

Netlists read by FixMaster identify the component side (CMP) and solder side (SOL) of the PCB
data. In order for the fixture to be designed properly and for the tester download files to be correct,
you must orient the data properly when reading it in and writing it out. Generally, users want to
orient the data so that the densest side of the board is tested by the densest part of the tester grid.
The settings for orienting the incoming data are different depending on whether you will be doing
a single-sided test, a one-fixture flip test, or a two-fixture flip test, a universal test, or a wire wrap
job. The following procedures outline how to read properly oriented data for each type of test.

Orientation for Single-Sided Test:

Generally, if you are testing only one side of a board on a single fixture, you are testing the
component side on the bottom grid of the tester.

• If you have a board with surface mounts and a dense component side, put the component
side against the bottom grid by setting Flip Component to Flip X  or Flip Y .

• If you have a through-hole board with no surface mounts, do not flip either side, and test
the solder side, which is already oriented toward the grid. Set Flip Solder to None. It
doesn’t matter how you orient the component side, because you are only testing the
solder side.

Orientation Two-Fixture Flip Test:

Generally, if you are testing each side of a board on separate fixtures, you are testing both the
component side and the solder side on the bottom grid of the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to None. The solder side is already oriented toward the bottom grid.

Orientation for One-Fixture Flip Test:

Generally, if you are testing both sides of a board on a single fixture, you are testing both the
component side and the solder side on the bottom grid of the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to None. The solder side is already oriented toward the bottom grid.
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Orientation for Tower Tester:

Generally, if you are testing both sides of a board simultaneously in a universal tester, you are
testing the component side on the bottom grid of the tester and the solder side on the top grid of
the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to flip exactly the same way that you set the component side. Both sides
are being tested simultaneously and must be oriented the same way.

Orientation for Wire Wrap Test:

Generally, if you are testing both sides of a board simultaneously in a wire wrapped fixture, you
are testing the component side on the bottom grid of the tester and testing the solder side on the
wire wrapped side.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to flip exactly the same way that you set the component side. Both sides
are being tested simultaneously and must be oriented the same way.

11. Click OK .

FixMaster imports the netlist file, orients the data as you specified, and displays the data on the
screen.
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Convert Netlist Files to Lavenir Format
The program can convert many formats of netlist file into Lavenir Format 2 or Format 4 netlists. When
the netlist is converted into a Lavenir format netlist, you can import the netlist into the job.

To Convert a Netlist File:
1. On the Tools Menu, click Netlist-Convert Netlist.

Convert Netlist Dialog

2. In the Look in box, click the drive, folder, or network location that contains the netlist file.

3. In the folder list, double-click folders until you open the folder that contains the netlist file
you want.

4. Click on the file that you want so that it is highlighted.

5. Pick the netlist type on the Netlist Type drop down list, or click Guess Type.

6. If the file contains N/C records for non-connected points and you want those points to have
unique identifiers, click on Add Numbers to N/C’s so that the option has a checkmark. If
there is no checkmark, then those points will have the N/C identifier with no unique net
number.
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7. If you want to automatically import the converted netlist after conversion, click on Import
Netlist After Conversion so that the option has a checkmark. If there is no checkmark, then
the netlist will be converted and saved under a name you specify later, but it will not be
imported.

8. Click Open.

Depending on the netlist type, the program may prompt for some additional information or files.

The program prompts for a name for the converted netlist file.

9. If you want to accept the default name, click Accept Default.
If you want to change the name or directory, click Change Name, and enter a new name or
location for the converted netlist file. Then click OK .
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Import ATF, CATE, TIF Formatted Netlist Files into the Job
You can import ATF, CATE and TIF formatted netlist files into the job

To Import ATF, CATE or TIF Files into the Job:
1. On the Files Menu, click Import-ATF/CATE/TIF .

Import ATF, CATE or TIF Dialog

2. Click the Browse button.
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Browse for File

3. In the Look in box, click the drive, folder, or network location that contains the file you want.

4. In the folder list, double-click folders until you open the folder that contains the file you want.

5. Click on the file that you want.

6. Click OK .

7. Orient Board Layers to Tester Grids.

Netlists read by FixMaster identify the component side (CMP) and solder side (SOL) of the PCB
data. In order for the fixture to be designed properly and for the tester download files to be correct,
you must orient the data properly when reading it in and writing it out. Generally, users want to
orient the data so that the densest side of the board is tested by the densest part of the tester grid.
The settings for orienting the incoming data are different depending on whether you will be doing
a single-sided test, a one-fixture flip test, or a two-fixture flip test, a universal test, or a wire wrap
job. The following procedures outline how to read properly oriented data for each type of test.

Orientation for Single-Sided Test:

Generally, if you are testing only one side of a board on a single fixture, you are testing the
component side on the bottom grid of the tester.

• If you have a board with surface mounts and a dense component side, put the component
side against the bottom grid by setting Flip Component to Flip X  or Flip Y .

• If you have a through-hole board with no surface mounts, do not flip either side, and test
the solder side, which is already oriented toward the grid. Set Flip Solder to None. It
doesn’t matter how you orient the component side, because you are only testing the
solder side.
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Orientation Two-Fixture Flip Test:

Generally, if you are testing each side of a board on separate fixtures, you are testing both the
component side and the solder side on the bottom grid of the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to None. The solder side is already oriented toward the bottom grid.

Orientation for One-Fixture Flip Test:

Generally, if you are testing both sides of a board on a single fixture, you are testing both the
component side and the solder side on the bottom grid of the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to None. The solder side is already oriented toward the bottom grid.

Orientation for Tower Tester:

Generally, if you are testing both sides of a board simultaneously in a universal tester, you are
testing the component side on the bottom grid of the tester and the solder side on the top grid of
the tester.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to flip exactly the same way that you set the component side. Both sides
are being tested simultaneously and must be oriented the same way.

Orientation for Wire Wrap Test:

Generally, if you are testing both sides of a board simultaneously in a wire wrapped fixture, you
are testing the component side on the bottom grid of the tester and the solder side on the wire
wrapped side.

• Set Flip Component to Flip X  or Flip Y . This puts the component side against the
bottom grid.

• Set Flip Solder to flip exactly the same way that you set the component side. Both sides
are being tested simultaneously and must be oriented the same way.

8. Click OK .

FixMaster imports the netlist file, orients the data as you specified, and displays the data on the
screen.
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Import Basic Gerber Files into the Job
You can import Basic Gerber files into the job.

To Import Basic Gerber Files into the Job:
1. On the Files Menu, click Import-Gerber .

Import Gerber Dialog

2. Click the Browse button.
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Browse for .ENV File

It’s a good idea to import the Lavenir environment file (.ENV file) associated with the Gerber file
before importing the Gerber.

3. In the Look in box, click the drive, folder, or network location that contains the .ENV file.

4. In the folder list, double-click folders until you open the folder that contains the .ENV file you
want.

5. Click on the .ENV file that you want.

6. Click OK .

7. On the main Import Gerber dialog, click the Env button.

FixMaster imports the environment file. The D Code sizes and shapes are shown in the file
inspection table.

The environment file also sets the Gerber format options for the incoming Gerber file in the Plot
Mode group box and the m and n fields.

8. Click the Browse button again.

9. Browse for the Gerber file and click OK .

10. On the main Import Gerber dialog, click the Inspect button.
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FixMaster displays the file name, number of pads and traces, and PCB dimensions.

File Inspection

11. Click OK .

Now, in the main Import Gerber dialog, in addition to the D Codes sizes and shapes loaded in the
environment file, FixMaster displays D Code counts for the named Gerber file.

12. You have the option of manually mapping incoming D Codes to Probe Codes in this table
now. Or you can skip this step and do the mapping either manually or automatically later. For
information on mapping D Codes to Probes later, see Map D Codes to Probe Codes on page
129.

If you are going to manually map D Codes to Probes now, then for each incoming D Code, enter a
Type.

Type-0 D Code: Unprobed pad.

• No test points will be generated for type-0 pads.

• No drill data will be generated when the drill files are generated.

Type-1 D Code: Probed pad.

• Test points will be generated for type-1 pads.

• Drill data will be generated for the probe drills. The Probe Code parameters for the
Probe Codes mapped to type-1 D Codes will be used to generate the Tool Codes
when drill files are generated.

Type-2 D Code: Tooling hole, not probed.

• No test points will be generated for type-2 pads.

• Drill data will be generated for these tooling holes. The shaft diameter of the type-T
Probe Codes mapped to the type-2 D Codes will be used as the tooling hole diameter
and will be used as the Tool Code size when drill files are generated.
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For each type-1 or type-2 D Code, enter a Probe Code.

Type-0 D Code: Don’t map a Probe Code for type-0 pads. These are unprobed pads.

Type-1 D Codes: Map each type-1 D Code to an appropriate Probe Code from the Probe
Setup table. A probe having that Probe Code will be used to test pads of that D Code.

• For surface-mount pads, use a type-S or type-B Probe Code.

• For through-hole pads, use a type-H or type-B Probe Code.

Type-2 D Codes: Map each type-2 D Code to an appropriate type-T Probe Code from the
Probe Setup Table. The type-T Probe Code isn't actually a probe. FixMaster uses the shaft
diameter of the type-T probe as the tooling hole size.

13. Orient the imported board layer to the tester grid.

• If you are loading a component-side file (CPU in Gerber file, CMP in FixMaster) select
Flip X or Flip Y . This puts the component-side data against the tester grid.

• If you are loading a solder-side file (CPL in Gerber file, SOL in FixMaster) select None.
This solder-side data is already oriented toward the tester grid.

14. Click OK .

FixMaster loads the Gerber file and displays the data on the screen.
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Import Supplemental Gerber Files into the Job
FixMaster can read in supplemental Gerber silkscreen, soldermask, and board outline PCB data.
Gerber files with the Lavenir layer types SKU, SKL, MSU, MSL contain silkscreen and soldermask
data which can be used to determine if pads are exposed and can be probed. Gerber files with the
Lavenir layer type BOL contain board outline data.

Before importing the soldermask, silkscreen, or board outline files, you import a Lavenir environment
file containing the D Code values and the layer file names. Unlike a Gerber PCB file, the elements of a
soldermask, silkscreen, or board outline file are not meant to be probed. So you do not map incoming
D Codes for soldermask, silkscreen, or board outline files to Probe Codes. When the soldermask,
silkscreen, or board outline layers are imported, FixMaster will automatically flip the files to match the
orientation of the loaded PCB file.

To Import Supplemental Gerber Files into the Job:
1. On the Files Menu, click Import-Misc Gerber .

Import Supplemental Gerber Dialog

2. Click the Browse button.
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Browse for .ENV File

You must import the Lavenir environment file (.ENV file) associated with the supplemental
Gerber files before importing the supplemental Gerber.

3. In the Look in box, click the drive, folder, or network location that contains the .ENV file.

4. In the folder list, double-click folders until you open the folder that contains the .ENV file you
want.

5. Click on the .ENV file that you want.

6. Click OK .

7. On the main Import Supplemental Gerber dialog, click the Load Env button.

FixMaster imports the environment file. The names of the supplemental Gerber files are added to
the Filename fields.

8. Click in the Load column for each file that you do want to import so that the file has a
checkmark next to it. If you do not want to import a particular file, make sure it does not
have a checkmark.

9. Click OK .

FixMaster imports the miscellaneous Gerber files.



FixMaster User’s Guide

314

Import Drill Data for Outside Tooling
The import drill command is used to bring in drill data for outside tooling. The drills are imported into
the active plates.

To Import Drill Data into the Job:
1. Set the active, visible plates.

2. On the Files menu, click Import-Drill .

Import Drill Dialog

3. Click the Browse button.

4. In the Look in box, click the drive, folder, or network location that contains the drill file.

5. In the folder list, double-click folders until you open the folder that contains the drill file you
want.

6. Click on the drill file that you want.

7. On the open file dialog, click OK .
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8. On the Import Drill Dialog, set the plot mode options:

• Leading: Leading zeros are omitted.

• Trailing:  Trailing zeros are omitted.

• Absolute: Position coordinates are absolute.

• Incremental: Position coordinates are incremental.

• English: Units are in English units.

• Metric:  Units are in metric.

9. In the m box, set the number of digits to the left of the implied decimal point. And in the n
box, set the number of digits to the right of the implied decimal point.

10. In the language box select Excellon or Sieb and Meyer.

11. If you selected Excellon as the language, select Version 1 or 2. If you selected Sieb and
Meyer, you do not need to select a version.

12. If you selected Excellon Version 2, then set the panel size. If you selected Sieb and Meyer or
Excellon Version 1, then you do not need to set a panel size.

13. Click OK .

The drill data is imported into the active, visible plates.

14. To import different data into a different plate, repeat the procedure selecting the new plate and
the new file.
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Export Tester Download Files
When the fixture is complete, all the test points are assigned, and all the design rule errors are
corrected, you may export the files to test the boards.

The tester download files tell the tester how the grid points or translation block locations are assigned
to test points. Exporting the tester download files involves setting the datum point, selecting the
specific tester and file options, and orienting the output data to the proper tester grid for the type of test
you are doing.

Export Tester Download Files:
1. If you are exporting data for only one board side, be sure it is the active board side shown in

the Status Bar.

2. Before exporting, set the datum point. See Setting the Datum Point on page 340.

3. On the File menu, click Export-Test.

The Export Test File main dialog is displayed.

Export Test File Main Dialog
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4. If you want to output a standard tester download file:

• Click Standard in the Output group box so that the option has a checkmark.

• Click the Browse button.

• Browse for the drive, folder, or network location where you want the file to be saved and
enter a name for the file.

• Click OK .

5. If you don’t want to output a standard tester download file, be sure the Standard option in the
Output group box does not have a checkmark.

In addition to standard output, most formats, except EPC and CAET, allow you to output a shorts
file in which test points are output as a single continuous netlist.

6. If you want to output a shorts file:

• Click Shorts in the Output group box so that the option has a checkmark.

• Click the Browse button.

• Browse for the drive, folder, or network location where you want the file to be saved and
enter a name for the file.

• Click OK .

7. If you don’t want to output a shorts file, be sure the Shorts option in the Output group box
does not have a checkmark.

8. Orient Board Layers to Tester Grids:

When you imported the netlist data, you oriented the PCB data so that the fixture data can be
generated properly. But telling FixMaster to flip the data does not actually tell the program which
tester grid will be used to test each board side. You set this up when you write out the tester
download files

The Map to BOT/TOP options on the Export Test File dialog tell FixMaster to write the data for
each board side to either the top or bottom tester grid. And the CMP/SOL Combine option, when
available in a particular format, tells FixMaster whether component-side and solder-side data will
be output in a single file or in separate files. The following procedures outline settings for typical
scenarios. For information about importing data in the proper orientation, see Import PCB Files
into the Job on page 299.
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Orientation for Single-Sided Test:

Generally, if you are testing only one side of a board on a single fixture, you are testing the
component side on the bottom grid of the tester.

• In the Map CMP to BOT/TOP group box, select CMP to BOT

• In the Map SOL to BOT/TOP group box, select SOL to BOT

Note: Regardless of which side is actually tested, the above two steps are the same, because in
a single sided test, the test data is mapped to the bottom grid.

• Later, in the Setup options for the selected file format, if there is an option for
CMP/SOL Combined, don’t select that option. You are only writing out test data for the
one side.

Orientation Two-Fixture Flip Test:

Generally, if you are testing each side of a board on separate fixtures, you are testing both the
component side and the solder side on the bottom grid of the tester.

• In the Map CMP to BOT/TOP group box, select CMP to BOT. This puts the component
side against the bottom grid.

• In the Map SOL to BOT/TOP group box, select SOL to BOT. This puts the solder side
against the bottom grid.

• Later, in the Setup options for the selected file format, if there is an option for
CMP/SOL Combined, don’t select that option. You are writing out test data for the
component side and solder side separately.

• After exporting the data for one Board Side, change the active layer shown in the Status
Bar, and export the other board side with the same options as shown above.

Orientation for One-Fixture Flip Test:

Generally, if you are testing both sides of a board on a single fixture, you are testing both the
component side and the solder side on the bottom grid of the tester.

• In the Map CMP to BOT/TOP group box, select CMP to BOT. This puts the component
side against the bottom grid.

• In the Map SOL to BOT/TOP group box, select SOL to BOT. This puts the solder side
against the bottom grid.

• Later, in the Setup options for the selected file format, if there is an option for
CMP/SOL Combined, select that option. You are writing out test data for the
component side and solder side combined in one file.
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Orientation for Tower Tester:

Generally, if you are testing both sides of a board simultaneously in a universal tester, you are
testing the component side on the bottom grid of the tester and testing the solder side on the top
grid.

• If you flipped the component side data when you imported the PCB data, then in the Map
CMP to BOT/TOP group box, select CMP to BOT.
Or, if you did not flip the component side data when you imported the PCB data, then in
the Map CMP to BOT/TOP group box, select CMP to TOP.

• If you flipped the solder side data when you imported the PCB data, then in the Map SOL
to BOT/TOP group box, select SOL to TOP.
Or, if you did not flip the solder side data when you imported the PCB data, then in the
Map SOL to BOT/TOP group box, select SOL to BOT.

• Later, in the Setup options for the selected file format, if there is an option for
CMP/SOL Combined, select that option. You are writing out test data for the
component side and solder side combined in one file.

Orientation for Wire Wrap Test:

Generally, if you are testing both sides of a board simultaneously in a wire-wrapped fixture, you
are testing the component side on the bottom grid of the tester and testing the solder side on the
wire wrapped side.

• If you flipped the component side data when you imported the PCB data, then in the Map
CMP to BOT/TOP group box, select CMP to BOT.
Or, if you did not flip the component side data when you imported the PCB data, then in
the Map CMP to BOT/TOP group box, select CMP to TOP.

• If you flipped the solder side data when you imported the PCB data, then in the Map SOL
to BOT/TOP group box, select SOL to TOP.
Or, if you did not flip the solder side data when you imported the PCB data, then in the
Map SOL to BOT/TOP group box, select SOL to BOT.

• Later, in the Setup options for the selected file format, if there is an option for
CMP/SOL Combined, select that option. You are writing out test data for the
component side and solder side combined in one file.

9. In the Test Format drop down list, select the format for your tester download files.

10. Click the Setup button.

Each format calls up a unique setup dialog when you click the Setup button.
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11. Set up the unique setup options for the selected tester format as explained in the following
sections:

• Export ATG1000 Test Files on page 321.

• Export ATG2000 Test Files on page 322.

• Export CAET Test Files on page 323.

• Export CircuitLine Test Files on page 324.

• Export EPC Test Files on page 326.

• Export Everett Charles Test Files on page 327.

• Export Fastek Test Files on page 328.

• Export Luther & Maelzer Test Files on page 330.

• Export Mania Test Files on page 331.

• Export PDI Test Files on page 332.

• Export TRACE Test Files on page 332.

• Export TTI Test Files on page 333.

• Export Viking Test Files on page 334.

• Export Integri Test Files on page 335.

• Export Utron Test Files on page 336.

• Export NidecRead Test Files on page 337.

• Export Taiyo Test Files on page 338.

• Export Kyoei Test Files on page 339.

12. Click OK .
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Export ATG1000 Test Files

ATG1000 Export Setup Options

Jobname
Enter an internal job name for your own reference in the Jobname field.
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Export ATG2000 Test Files

ATG2000 Export Setup Options

Jobname
Enter an internal job name for your own reference in the Jobname field.

Dual Density
The ATG2000 tester is unique in that the top and bottom grids both have dual density capability but
have different offsets. The two sides are defined independently when setting up the grids. In the Dual
Density box indicate whether the top and/or bottom grids are set up for dual density.

Tester Type
• Normal ATG2000: This is the normal ATG output.

• Hitachi: This is a special ATG output for Hitachi Corp.

Files Group Box
• If you want to export a file that contains only grid points, click the Net option so that it has a

checkmark. The exported file has a .NET suffix.

• If you want to export a file that contains both grid points and test points, click the Reference
option so that it has a checkmark. The exported file has a .REF suffix.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export CAET Test Files
There are no additional setup options for the CAET format.

CAET Export Setup Options
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Export CircuitLine Test Files

CircuitLine Export Setup with Fewer Options Displayed

CircuitLine Export Setup with More Options Displayed
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CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.

Start Grid
Indicate whether the grid begins at (0, 0) or (1, 1).

• X0Y0

• X1Y1

Format
• 0

• 2

Use Common Grid Origin
Indicate whether the top and bottom grids have the same origin or unique origins.

CPU/CPL Grid Corner X/Y
Enter the grid corners for the CPU and CPL sides.

Grid Unit X/Y
Enter the grid units in the X and Y directions.
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Export EPC Test Files

EPC Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export Everett Charles Test Files

Everett Charles Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.

Switch Point
• If you want to output a switch point file, click the Switch option so that it has a checkmark.

Select this option if you are outputting wire wrap information for a Kryterion-type dedicated
tester.

• Otherwise, do not select this option, and export the .XY file with test point locations.

Switch Max Y
The Switch Max Y parameter defines the maximum grid field (i.e., 161=16” grid, 171=17” grid,
181=18” grid, etc.)
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Export Fastek Test Files

Fastek Export Setup Options

Type
For the Type setting, select MDA or Non-MDA. This indicates how the file name will be extended. If
you select MDA, FixMaster will automatically extend the file name with the .MDA suffix. If you
select Non-MDA, then you should enter the extension you want to use as part of the file name.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Non-MDA Setup Group Box
Enter the Leakage and Continuity factors: r, v, and d.

RTX and RTY
Optional information for Fastek header.

RBX and RBY
Optional information for Fastek header.

Datum X and Datum Y
Optional information for Fastek header.
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Export Luther & Maelzer Test Files

Luther Maelzer Export Setup Options

Header
• If you want to attach a header file to the export file, click the Header option so that it t has a

checkmark. Then click the Browse button and browse for the file that you would like to attach
to the export file.

• If you do not want to attach an additional file to the export file, be sure the Header option
does not have a checkmark.

Use QSA
Select whether you want to export the QSA map that contains the microstagger information. For
information about generating the microstagger information, see Microstagger for Luther Maelzer
Testers on page 176.

• If you want to export the QSA map, click the QSA option so that it has a checkmark. Then
enter the values in the QSA group box.

• If you do not want to export the QSA map, be sure the QSA option does not have a
checkmark.

Output Unit
Select whether you want the output in inches or metric units.
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CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.

Export Mania Test Files

Mania Export Setup Options

Format
• XY’s Only:  If you want to output grid points only, select XY’s Only.

• Complete: If you want to output both grid points and test points, select Complete.

• Mania CAD:  If you want to output both grid points, test points, and a check sum value, select
Mania CAD.

• New XY’s Only: Select this option if you use this specific proprietary format. This file
contains the same information as the file generated by the XY’s Only option, but it has a .TES
or .SMT suffix and is formatted with 3 digits and leading zeros.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export PDI Test Files

PDI Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.

Export TRACE Test Files

TRACE Export Setup Options

Max XY
The Max XY parameter defines the maximum grid field (i.e., 161=16” grid, 171=17” grid, 181=18”
grid, etc.)
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Export TTI Test Files

TTI Export Setup Options

Tester
Identify the tester model in the Tester field: 8, 14, 16, 36, 44, 45, 221, 222.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export Viking Test Files

Viking Export Setup Options

Output Unit
Select inches or metric units for output.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.



Chapter 17 File Handling in FixMaster

335

Export Integri Test Files

Integri Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export Utron Test Files

Utron Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export NidecRead Test Files

NidecRead Export Setup Options

Parameters Table
Parameters for Nidec header.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export Taiyo Test Files

Taiyo Export Setup Options

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Export Kyoei Test Files

Kyoei Export Setup Options

Conduction Discriminant Resistance
Customer parameters for individual Kyoei testers.

Conduction Test Voltage
Customer parameters for individual Kyoei testers.

Insulation Discriminant Resistance
Customer parameters for individual Kyoei testers.

Insulation Test Voltage
Customer parameters for individual Kyoei testers.

CMP/SOL Output
See the information about orienting the board sides to the tester grids in step 8 on page 317.

• If you want both the component-side and solder-side data to be output in a combined file,
click the CMP/SOL Output Combined option so that it has a checkmark.

• If you want to output tester data for only the current board side, be sure the CMP/SOL
Output Combined option does not have a checkmark.
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Setting the Datum Point
The tester and the test file output must share a common datum point. To ensure this, always check the
datum point prior to outputting test files and change it if necessary.

To Set the Datum Point:
1. On the View menu, click Go To-Datum Point.

FixMaster positions the cursor at the current datum point and displays the coordinates in the Status
Bar.

If the datum point is correct, then you don’t need to do anything.

2. To change the datum point, go to the Setup menu and Fixture-Datum Point .

FixMaster prompts for the new datum point.

3. Position the cursor using the X and Y key commands.

4. When the cursor positioned at the desired new datum point, press the Enter key.

FixMaster puts the datum point at the cursor position and reports the coordinates on the Status
Bar.
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Export Fixture Drill Files
You may export drill data for the fixture outside tooling. Or when the fixture is complete, all the test
points are assigned, and all the design rule errors are corrected, you may export drill files containing all
drill data necessary to build the fixtures.

The complete drill files contain the data to drill for the fixture tooling, spacers and probe drills.
FixMaster exports the fixture drill data for the current board side, component or solder, in one of two
NC formats. Each plate of the fixture is exported in its own individual file, extended with the plate
number as its suffix.

The following procedure outlines steps required regardless of whether you are exporting Excellon or
Sieb and Meyer drill data. There are also additional procedures to outline the options that are specific
to each of those formats.

To Export Fixture Drill Files:
1. On the View menu, click Active Side and select the board side for which you want to write

out fixture drills, Component or Solder.

2. On the File menu, click Export-Drill-Plates  or Fixture .

• Plates: If you click File-Export-Drill-Plates , FixMaster exports all drill data for the
fixture tooling, spacers and probe drills.

• Fixture:  If you click File-Export-Drill-Fixture , FixMaster exports only the drill data for
the fixture tooling.

Export Drill Main Dialog

3. Click the Browse button.
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4. Browse for the drive, folder, or network location where you want the Drill files to be saved
and enter a Prefix for the file.

5. Click OK .

6. In the Trailing/Leading  group box, select whether trailing  or leading zeros are omitted in
outgoing data.

7. In the Incremental/Absolute group box, select whether outgoing data contains absolute or
incremental position coordinates.

8. In the English/Metric  group box, select whether English or metric units are written out for
outgoing data.

9. In the m and n group boxes, set the number of digits to the left and right  of the implied
decimal point for outgoing data.

10. In the Language field, select the either Excellon or Sieb and Meyer as the drill language for
the outgoing file.

FixMaster supports subsets of Excellon Format 1 and 2, and subsets of Sieb & Meyer Format 1000
and 3000.

11. For additional language format options, click the Write Options button.

Your choice of language determines which dialog appears when you click the Write Options
button:

• For Excellon, see Set Excellon Language Format Options on page 343.

• For Sieb and Meyer, see Set Sieb & Meyer Language Format Options on page 346.
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Set Excellon Language Format Options
The following procedure outlines the options for when you are exporting drill data in the Excellon
format.

To Set Excellon Language Format Options:
The Excellon Write Options dialog is displayed when you have selected Excellon as your drill
language on the Export Drill  main dialog and you click the Write Options button.

Excellon Write Options

1. In the Options group box, select either Format 1 or Format 2.

2. In the Options group box, select whether to output both X and Y coordinates for every move
command (non-modal) or only the coordinate that has changed (modal).

• For modal output, click the Full XY  checkbox so that it doesn’t have a checkmark. If
there is no checkmark, FixMaster will only output the coordinate that has changed.

• For non-modal output, click the Full XY  checkbox so that it does have a checkmark. If
there is a checkmark, FixMaster will always output both coordinates, even if only one has
changed.
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3. In the Options group box, select whether or not to park the drill bit after each subprogram.

• To park the bit, click Park in the Options group box so that the option has a checkmark,
and set the park position in Park X  and Park Y . If there is a checkmark, FixMaster will
park the bit at the park position you specified after each subprogram.

• To not park the bit, click Park in the Options group box so that the option doesn’t have a
checkmark. If there is no checkmark, FixMaster will not park the bit after each
subprogram.

4. In the Options group box, select whether or not to output a T00 at the end of the program
before M30.

• To output a T00, click T00 in the Options group box so that the option has a checkmark.

• To not output a T00, click T00 in the Options group box so that the option doesn’t have a
checkmark

5. In the Version drop down list, select Version 1-8 for outgoing data. This sets the version of
the Excellon File.

6. If you selected an Excellon version other than Version 1, set the panel size in Panel X and
Panel Y. Ignore this setting if you are using Excellon version 1.

7. In the G92 X and G92 Y fields, set the offset coordinate for the G92 Zero Set command.

8. Select whether to generate an Excellon Header containing tool sizes for the output file.

If you don’t want to generate an Excellon Header for the Excellon file, click the Tool Sizes option
in the Program Header group box so that the option doesn’t have a checkmark.

If you do want to generate an Excellon Header containing tool sizes, do the following:

a. In the Program Header group box, click the Tool Sizes option so that the option has a
checkmark.

b. Click the Tool Format button.

Excellon Tool Format Dialog



Chapter 17 File Handling in FixMaster

345

c. In the Header Group Box, select how to number tools in each individual plate’s drill file:

• If you want every plate file to have a header in which tools are numbered according
the drill diameters in that one plate, click Single so that the option has a checkmark.

• If you want all the plate files to have header files in which tools are numbered
according the drill diameters for all the plates in the job, click Combined so that the
option has a checkmark. Only the tools used for the individual plates are output in
the individual headers, but the tools are numbered according to a combined tool
chart.

d. In the Sort Tools Group Box, select how you want tools sorted:

• If you want the tools to be sorted in ascending order of tool diameter, click
Ascending so that the option has a checkmark.

• If you want the tools to be sorted in descending order of tool diameter, click
Descending so that the option has a checkmark.

• If you do not want the tools to be sorted, click None so that the option has a
checkmark.

e. In the Tools field, enter the maximum number of tools you want output in one file.
FixMaster will split files that have more than the maximum number of unique diameters
so as not to exceed the maximum.

f. On the Excellon Tool Format Dialog, click OK .

9. You also have the option to attach an additional file to the Excellon file. This is not an actual
Excellon header containing tool sizes. It is any file which you would like to attach to the
Excellon file and can contain any information you want, job or customer information for
instance. To attach an additional file to the Excellon file:

If you don’t want to attach an additional file to the Excellon file, click the Header File option in
the Program Header group box so that the option doesn’t have a checkmark.

If you do want to attach an additional file to the Excellon file, do the following:

a. In the Program Header group box, click the Header File option so that the option has a
checkmark.

b. Click the Browse button.

c. Browse for the drive, folder, or network location where the file you want to attach is
located and select the file.

d. On the browse dialog, click OK .

10. On the Excellon Write Options dialog, click OK .

11. On the Drill Export main dialog, click OK .

FixMaster exports the drill files as you specified.

12. If you are doing a dual-fixture test, change the board side, CMP or SOL, and export the drill
files for the other fixture.
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Set Sieb & Meyer Language Format Options
The following procedure outlines the options for when you are exporting drill data in the Sieb and
Meyer format.

To Set Sieb & Meyer Language Format Options:
The Sieb & Meyer Write Options dialog is displayed when you have selected Sieb & Meyer as
your drill language on the Export Drill  main dialog and you click the Write Options button.

Sieb and Meyer Format Options

1. In the Options group box, select whether to output both X and Y coordinates for every move
command (non-modal) or only the coordinate that has changed (modal).

• For modal output, click the Full XY  checkbox so that it doesn’t have a checkmark. If
there is no checkmark, FixMaster will only output the coordinate that has changed.

• For non-modal output, click the Full XY  checkbox so that it does have a checkmark. If
there is a checkmark, FixMaster will always output both coordinates, even if only one has
changed.
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2. In the Options group box, select whether or not to park the drill bit after each subprogram.

• To park the bit, click Park in the Options group box so that the option has a checkmark,
and set the park position in Park X  and Park Y . If there is a checkmark, FixMaster will
park the bit at the park position you specified after each subprogram.

• To not park the bit, click Park in the Options group box so that the option doesn’t have a
checkmark. If there is no checkmark, FixMaster will not park the bit after each
subprogram.

3. In the Options group box, select either Format 1000 or Format 3000.

4. If you selected Format 3000, select %%3000 or %%3008.

5. Sieb & Meyer does not support an actual header file containing tool sizes like Excellon does,
but with FixMaster you do have the option to attach any file you wish to the Sieb & Meyer
output file. This file can contain any information you want, job or customer information for
instance:

If you don’t want to attach an additional file to the Sieb & Meyer file, click the Header File
option in the Program Header group box so that the option doesn’t have a checkmark.

If you do want to attach an additional file to the Sieb & Meyer file, do the following:

a. In the Program Header group box, click the Header File option so that the option has a
checkmark.

b. Click the Browse button.

c. Browse for the drive, folder, or network location where the file you want to attach is
located and select the file.

d. On the browse dialog, click OK .

6. On the Sieb and Meyer Write Options dialog, click OK .

7. On the Drill Export main dialog, click OK .

FixMaster exports the drill files as you specified.

8. If you are doing a dual-fixture test, change the board side, CMP or SOL, and export the drill
files for the other fixture.
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Export Plate Gerber for an Interface Board
An interface board, also called a personality board, is a board that sits between the part being tested
and the test fixture. The interface board translates the test point locations to grid point locations so that
the fixture pins have no deflection.

FixMaster can output the Gerber and drill files for building a two-layer interface board. These files use
the drill points generated by dropping pins for a three-plate fixture. The drill points on the top and
bottom plates represent the locations of the test points and grid points, and they are output as pad
locations for the interface board. Traces connect these pad locations. Drill points on the middle plate
are output as vias to connect the two layers of the interface board.

In order for the fixture data in FixMaster to be output in Gerber, certain elements need to be assigned
D Codes.

To Export Plate Gerber for an Interface Board:
1. On the File menu, click Export-Plate Gerber.

Export Plate Gerber

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the prefix for the files.

4. On the browse dialog, click OK .

5. In the Trailing/Leading  group box, select whether trailing  or leading zeros are omitted in
outgoing data.
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6. In the Incremental/Absolute group box, select whether outgoing data contains absolute or
incremental position coordinates.

7. In the English/Metric  group box, select whether English or metric units are written out for
outgoing data.

8. In the m and n group boxes, set the number of digits to the left and right  of the implied
decimal point for outgoing data.

9. To set the drill data format options, click Drill Setup and set these options the same way as
explained in Export Fixture Drill Files on page 341.

10. Select the types of files you want to export:

• Interface Plates: To export interface plate files, click the Interface Plates option so that
it has a checkmark. When this option is selected with a checkmark, FixMaster exports
one file with the drill points from the top and middle plates as pads connected by traces in
Gerber format. In a second file FixMaster exports the drill points from the bottom and
middle plates as pads connected by traces in Gerber format. These files can be used to
build an interface plate board. If the option is not selected, FixMaster does not export
these files.

• Road Map: To export a “road map” file showing the connections between the grid points
and test points, click the Road Map option so that it has a checkmark. If this option is
selected with a checkmark, FixMaster exports the drill points from the top and bottom
plates as pads connected by traces in Gerber format. If this option is not selected,
FixMaster does not export this file.

• Drill:  To export the via drills, click the Drill  option so that it has a checkmark. If this
option is selected with a checkmark, FixMaster exports the drill points from the middle
plate in NC Drill format. These will be the via drills between the two layers of the
interface board. If this option is not selected, FixMaster does not export this file.

11. In the D Code Map table, for each Probe Code, assign each type of element a Gerber D Code:

• Via:  D Code to be mapped to drill points on the middle plate. This will be the D Code of
the via covering pads.

• Pad: D Code to be mapped to drill points on the top plate. This will be the D Code of the
pads on the test point side of the interface board.

• Grid:  D Code to be mapped to drill points on the bottom plate. This will be the D Code
of the pads on the grid side of the interface board.

• Trace: This will be the D Code of the traces that connect the pads to the vias.

Note: The D Code values for these D Codes (size, shape, etc.) are not set in FixMaster. Set the
D Code values in CAMMaster.

12. On the Export Plate Gerber dialog, click OK .

FixMaster outputs the Gerber and Drill files for an interface board.
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Export a Gerber Road Map for Wire Wrapping
The wire wrap road map aids in the actual physical wire wrapping of test points to translation blocks.
In FixMaster the road map is represented on screen by test points, test point numbers, the colored wire
wrap path, and colored translation blocks. The colored wire wrap path indicates the sequence of the
wire wrapped points for each translation block. The test point numbers appear periodically on the wire
wrap path to help keep track of the sequence.

The road map can be output from FixMaster in Gerber format and later plotted for hard copy. In order
for the road map displayed in FixMaster to be output in Gerber, the graphic elements of the road map
need to be assigned D Codes.

To Export a Gerber Road Map for Wire Wrapping:
1. On the File menu, click Export-Road Map.

Export Wire Wrap Road Map

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the prefix for the files.
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4. On the browse dialog, click OK .

5. In the Trailing/Leading  group box, select whether trailing  or leading zeros are omitted in
outgoing data.

6. In the Incremental/Absolute group box, select whether outgoing data contains absolute or
incremental position coordinates.

7. In the English/Metric  group box, select whether English or metric units are written out for
outgoing data.

8. In the m and n group boxes, set the number of digits to the left and right  of the implied
decimal point for outgoing data.

9. In the Output group box, select whether you want to output the road map as a wire wrap path
or straight-line links.

• Map:  If you select Map, FixMaster exports the road map as a wire wrap path.

• Link:  If you select Link, FixMaster exports the road map as straight-line links between
each test point and the translation hole. This can be very cluttered when there are more
than a few wire-wrapped points.

10. In the D Code Map table, assign each type of graphic element in the road map to a Gerber D
Code:

• Wire wrap path

• Test point

• Numbered test point

• Drill

• Digit

Note: The D Code values for these D Codes (size, shape, etc.) are not set in FixMaster. Set the
D Code values in CAMMaster.

11. On the Export Wire Wrap Road Map dialog, click OK .

FixMaster outputs the Gerber road map.
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Export ATF
ATF is the download file format for ATG.

To Export ATF:
1. On the File menu, click Export-ATF .

Export ATF

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the name for the file.

4. The following are parameters for the ATF header:

• Layers

• Jobname

• Output Group Box: All/Test Point

5. On the browse dialog, click OK .
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Export TIF
TIF is the format for UTRON.

To Export TIF:
1. On the File menu, click Export-TIF .

Export TIF

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the name for the file.

4. On the browse dialog, click OK .

5. On the Export TIF dialog, click OK .
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Export IPC356A
FixMaster can export a subset of IPC356A.

To Export IPC356A:
1. On the File menu, click Export-IPC356A.

Export IPC356A

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the name for the file.

4. On the browse dialog, click OK .

5. In the English/Metric  group box, select whether English or metric units are written out for
outgoing data.

6. On the Export IPC356A dialog, click OK .
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Export a Report File
FixMaster can export a new report file or append to the end of an existing Report File. The report file
is an informational text file and cannot be read back in to FixMaster as data.

A report file contains the fixture size, grid size, PCB size, number of pads, number of assigned test
points, number of crossed pins and breakout errors, and allowed pin deflection.

The report also includes a table of D Codes, pad counts, and probe information for each PCB side, as
well as Tool Codes, drill sizes and counts for each fixture plate.

At the end of the report is a label table containing a time stamp, job name, units and probe information
for both sides of the PCB.

You can also output an ASCII file extended with the suffix .TG that contains a list of test points, their
assigned grid points, net numbers and their access directions: top or bottom.

To Export a Report File:
1. On the File menu, click Export-Report File .

Export a Report File

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the name for the file.

4. On the browse dialog, click OK .

5. In the Jobname field, enter an internal job name for your own reference. The job name does
not need to be related to Report File Name.

6. In the Report group box, select whether you want to generate a New report file or if you want
to Append to an existing file of the same name.
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7. If you want to generate a text file that contains a list of test points, their assigned grid points,
net numbers and their access directions, click the Write Test/Grid  option so that is has a
checkmark. This file will be extended with the suffix .TG. If you don’t want to generate the
additional file, be sure the option does not have a checkmark.

8. If you want to generate a text file that contains pad coordinates for the original PCB data and
corresponding pad coordinates for the mirrored, moved and/or rotated data as it is set up in the
job, click the Write Misc  option so that is has a checkmark. This file will be extended with
the suffix .MIS. If you don’t want to generate the additional file, be sure the option does not
have a checkmark.

9. Click OK .

FixMaster generates or appends the report file as you specified.
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Chapter 18
Edit PCB Data

FixMaster has several features for editing PCB data that has been imported into the job.

This chapter discusses PCB Editing topics which all involve changing the fundamental characteristics
of the design, not just the position of the design as a whole. Generally the PCB data imported into the
job is completely prepared in a CAM environment before importing, and this type of editing is seldom
required in FixMaster.

FixMaster also has commands for changing the position of the entire PCB design. Those commands
are discussed in Position the PCB on page 119.

Insert Pad
You can insert a pad into the loaded PCB database.

To Insert a Pad:
1. On the Edit  Menu, click PCB Data-Insert Pad.

The Insert Pad tool is selected, and FixMaster prompts you to select an element.

2. Position the cursor near an existing pad that has the same D Code and Net Number as the pad
you want to insert.

3. Click  the mouse or press Enter.

The cursor hops to the existing pad and makes its D Code and Net Number the current values in
the Status Bar.

4. Position the cursor where you want to insert the new pad.

5. Click  the mouse or press Enter.

A new pad with the same D Code and Net Number as the selected pad is inserted at the new
location.

The Insert Pad tool remains selected until you select another tool or press the Escape key, so you
can insert one pad after another before quitting the operation.

Menu: Edit-PCB Data-Insert Pad

Button:  then 

Key: Ctrl+Shift+P
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Delete Pads
You can delete a pad from the loaded PCB database.

To Delete Pads:
1. Position the Frame around the pads you want to delete.

2. On the Edit  Menu, click PCB Data-Delete Pad.

FixMaster prompts whether you want to delete all pads inside the Frame.

3. Click OK .

Menu: Edit-PCB Data-Delete Pad

Button:  then 

Key: None
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Transcode Net Numbers
The net numbers of elements are included in imported netlist data. The commands for transcoding net
numbers allow you to change the net number of a single element or an entire net.

To Transcode the Net Number of a Single Element:
1. On the Edit  Menu, click PCB Data-Transcode-Trans Netcode.

Transcode Net Number of  Single Element

2. On the Trans Netcode dialog, select Single and click OK .

The Transcode Net Number tool is selected, and FixMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the Net Number.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New Net Number

6. On the Net dialog, enter the new net number, and click OK .

The pad is transcoded to the new Net Number and the entire net of that Net Number is highlighted.

The Transcode Net Number tool remains selected until you select another tool or press the Escape
key, so you can transcode the Net Number of one pad after another before quitting the operation.

Menu: Edit-PCB Data-Transcode-Trans Netcode

Button: None

Key: Ctrl+Shift+T

To Transcode the Net Number of an Entire Net:
1. On the Edit  Menu, click PCB Data-Transcode-Trans Netcode.

Transcode Net Number of Entire Net

2. On the Trans Netcode dialog, select Net, and click OK .

The Transcode Net Number tool is selected, and FixMaster prompts you to select an element.

3. Position the cursor near a pad in the net for which you want to change the Net Number.

4. Click  the mouse or press Enter.
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The cursor hops to the pad.

5. Click  the mouse or press Enter.

New Net Number

6. On the Net dialog, enter the new net number, and click OK .

The net containing the selected pad is transcoded to the new Net Number and the entire net is
highlighted.

The Transcode Net Number tool remains selected until you select another tool or press the Escape
key, so you can transcode the Net Number of one net after another before quitting the operation.

Menu: Edit-PCB Data-Transcode-Trans Netcode

Button: None

Key: Ctrl+Shift+T
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Transcode Probe Codes
The Probe Code used to probe a given pad is automatically determined by the D Code of the pad and
the D Code to Probe mapping. See Map D Codes to Probe Codes on page 129. However, you may
decide that some pads of a given D Code may need to be probed by a different probe than the one
mapped to that D Code. The commands to transcode Probe Codes allow you to do this.

To Transcode the Probe Code of a Single Pad:
1. On the Edit  Menu, click PCB Data-Transcode-Probe Code.

Transcode Single Probe

2. On the Trans Probe dialog, select Single and click OK .

The Transcode Probe Code tool is selected, and FixMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the Probe Code.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New Probe Code

6. On the New Probe dialog, enter the new Probe Code and click OK .

The pad is transcoded to the new Probe Code.

The Transcode Probe Code tool remains selected until you select another tool or press the Escape
key, so you can transcode the Probe Code of one pad after another before quitting the operation.

Menu: Edit-PCB Data-Transcode-Probe Code

Button: None

Key: None

To Transcode Probe Codes of a Group of Pads in the Frame:
1. Position the Frame around the pads for which you want to change the Probe Code.

2. On the Edit  Menu, click PCB Data-Transcode-Probe Code.

Transcode a Group of Probes

3. On the Trans Probe dialog, select Group and click OK .

The Transcode Probe Code tool is selected, and FixMaster prompts you to select an element.

4. Position the cursor near a pad that has the Probe Code you want to change.
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5. Click  the mouse or press Enter.

The cursor hops to the pad and its Probe Code is displayed as the current Probe Code in the Status
Bar.

6. Click  the mouse or press Enter.

New Probe Code

7. On the New Probe dialog, enter the new Probe Code and click OK .

All pads inside the Frame that have the same Probe Code as the selected pad are transcoded to the
new Probe Code.

The Transcode Probe Code tool remains selected until you select another tool or press the Escape
key, so you can transcode the Probe Code for one group of pads in the Frame after another before
quitting the operation.

Menu: Edit-PCB Data-Transcode-Probe Code

Button: None

Key: None
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Transcode D Codes
The D Codes of pads are included in imported PCB data, and they determine the size and shape of the
pads. The commands for transcoding D Codes allow you to change the size of a single pad or of a
group of pads inside the Frame.

To Transcode the D Code of a Single Pad:
1. On the Edit  Menu, click PCB Data-Transcode-D Code.

Transcode D Code of a Single Pad

2. On the Trans D Code dialog, select Single and click OK .

The Transcode D Code tool is selected, and FixMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the D Code.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New D Code Size

6. On the D Code XY Size dialog, enter the dimensions of the new D Code and click OK .

The pad is transcoded to a new D Code with the new dimensions. If a different D Code with the
new dimensions already exists, that D Code is used. If a D Code with the new dimensions does not
exist, a new D Code is created with the new dimensions.

The Transcode D Code tool remains selected until you select another tool or press the Escape key,
so you can transcode the D Code of one pad after another before quitting the operation.

Menu: Edit-PCB Data-Transcode-D Code

Button:  then 

Key: Ctrl+T

To Transcode the D Codes of a Group of Pads in the Frame:
1. Position the Frame around the pads for which you want to change the D Code.

2. On the Edit  Menu, click PCB Data-Transcode-D Code.

Transcode D Code of a Group of Pads

3. On the Trans D Code dialog, select Group and click OK .
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The Transcode D Code tool is selected, and FixMaster prompts you to select an element.

4. Position the cursor near a pad that has the D Code you want to change.

5. Click  the mouse or press Enter.

The cursor hops to the pad and its D Code is displayed as the current D Code in the Status Bar.

6. Click  the mouse or press Enter.

New D Code Size

7. On the D Code XY Size dialog, enter the dimensions of the new D Code and click OK .

All pads inside the Frame that have the same D Code as the selected pad are transcoded to a new
D Code. If a different D Code with the new dimensions already exists, that D Code is used. If a D
Code with the new dimensions does not exist, a new D Code is created with the new dimensions.

The Transcode D Code tool remains selected until you select another tool or press the Escape key,
so you can transcode the D Code for one group of pads in the Frame after another before quitting
the operation.

Menu: Edit-PCB Data-Transcode-D Code

Button:  then 

Key: Ctrl+T
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Remove Padstacks
FixMaster has a command that automatically removes stacked pads in the imported PCB database. The
command identifies pads that have the same centerpoint and removes all but the largest pad. The pads
that are removed must be entirely covered by the larger pads in order to be removed. If the pads
identified are all the same size, then only one is kept.

Removing stacked pads helps to eliminate stacked test points that can cause head butt errors. Head butt
errors that appear to have two grid points assigned to the same test point are due to stacked pads, and
you should remove the padstacks to solve such errors. For more about head butt errors, see Crossed
Pins and Head Butts on page 199.

To Remove Padstacks:
� On the Action menu, click Remove Padstacks.
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Chapter 19
Automatic Job Processing Features

The FixMaster product family has two features for automating the processing of jobs. The AutoGen
feature is an automatic processing feature within FixMaster that allows for some user intervention
when desirable. And the AutoFixture product is an upgraded version of FixMaster that has an
automatic “lights out” feature that can process batches of jobs with no intervention.

With AutoGen, you load a boilerplate fixture file, import the new PCB data for the new job, and then
AutoGen automatically assigns D Codes to Probe Codes, generates test points, staggers test points,
positions the PCB data, drops pins, and saves the new .JOB file. If AutoGen runs into a problem during
the processing, you can intervene to fix it.

With AutoFixture’s “Lights Out” automatic processing, you start the AutoProcessing feature and point
it at a folder containing netlists or .JOB files to be processed. AutoFixture processes the netlists or
.JOB files in the directory automatically with no intervention. For netlists, AutoFixture finds the best
fixture to use for the job, processes the job to completion, exports the tester and fixture files, and
moves on to the next netlist. For .JOB files, AutoFixture uses the fixture information saved in the files
and processes the job to completion. If AutoFixture cannot complete a particular job, it saves a .JOB
file to be completed by you later, and moves on to the next netlist or .JOB file.
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AutoGen
Once you have mastered the beginning-to-end fixture building procedures, you may be ready to
automate standard jobs using the FixMaster AutoGen Feature. AutoGen combines all the setup dialogs
in one place and automatically performs operations that you would ordinarily do manually one at a
time. You need a thorough understanding of each of the operations and dialogs available from the
AutoGen dialog to effectively use the feature.

If you frequently process similar jobs, using FixMaster could become as simple as loading a boilerplate
.JOB file, reading the new PCB data, checking the AutoGen setup options, and clicking OK . AutoGen
can automatically assign D Codes to Probe Codes, generate test points, stagger test points, position the
PCB data, drop pins, and save the new .JOB file.

To Process a Job Using AutoGen:
1. Open a boilerplate .JOB file. See Open a FixMaster Job File on page 293.

2. Import the PCB data. See Import PCB Files into the Job on page 299.

3. Map the D Codes to types as you read in the file, or do it next by going to the Action menu
and clicking D Code to Probe Map. See Map D Codes to Probe Codes on page 129.

4. On the Action menu click AutoGen.

FixMaster displays the AutoGen Automated Features Dialog. You can activate each operation on
the dialog by clicking the option so that it has a checkmark.

AutoGen Automated Features Dialog
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Most operations have corresponding setup dialogs that must be configured before the operation
can be run. To set up each operation, click on the corresponding button to display the setup dialog.
Many of these settings are stored in the boilerplate .JOB file and will not need to be changed
between jobs.

5. If you want FixMaster to automatically remove padstacks, click the Remove Padstacks
option so that it has a checkmark. For information on removing padstacks, see Remove
Padstacks on page 368.

6. If you want FixMaster to automatically map D Codes to Probe Codes:

• Click the Assign Probes option so that it has a checkmark.

• Click the Probe Table button.

• On the Probe Table dialog, make sure the settings are what you want. See Setting up the
Probes on page 70.

Note: D Codes need to be mapped to types before FixMaster can assign Probe Codes, so if you
did not map them when reading in the PCB data, do it before running the AutoGen
operation by going to the Action menu and clicking D Code Probe. See Map D Codes to
Probe Codes on page 129.

7. If you want FixMaster to automatically generate test points:

• Click the Generate option so that it has a checkmark.

• Click the Generate button.

• On the Generate Config dialog, make sure the settings are what you want. See Set Up
Test Point Generation Options for Netlists on page 140.

8. If you want FixMaster to automatically stagger test points:

• Click the Stagger option so that it has a checkmark.

• Click the Stagger button.

• On the Stagger Setup dialog, make sure the settings are what you want. See Stagger Test
Points on page 165.

9. If you want FixMaster to automatically Step and Repeat the PCB:

• Click the Step and Repeat option so that it has a checkmark.

• Click the Step and Repeat button.

• On the Step and Repeat dialog, make sure the settings are what you want. See Step and
Repeat the PCB on page 126.

10. If you want FixMaster to automatically position the PCB within the fixture tooling:

• Click the Place PCB option so that it has a checkmark.

• Click the Place PCB button.

• On the Place PCB dialog, make sure the settings are what you want. See Automatically
Centering the PCB in the Fixture Tooling on page 121.
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11. If you want FixMaster to automatically assign test points to fixture grid points, click the
Drop Pin option so that it has a checkmark.

12. If you want FixMaster to optimize the pin deflection by sequentially reducing the maximum
displacement, click the Optimize Pin Deflection option so that it has a checkmark.

13. If you want FixMaster to automatically save the completed job:

• Click the Save New Job option so that it has a checkmark.

• Click the New Job File button.

• On the Save File dialog, browse for the drive, folder, or network location where you want
to save the file and enter the name for the file.

14. If you want FixMaster to automatically insert spacers and/or air holes:

• Click the Spacer/Air Hole option so that it has a checkmark.

• Click the Spacers button.

• On the Spacer/Guter Setup dialog, make sure the settings are what you want. See Add
Spacers on page 281.

15. In the Layer field, select the PCB layer that you want processed by AutoGen, Component
only, Solder only or Both.

16. Click OK .

FixMaster begins to process the job using the settings you specified. If the program encounters a
problem, it stops and prompts for input. There are several potential trouble spots. The program
stops if:

• The Assign Probe operation is unable to map all D Codes to Probe Codes.

• The Generate or Stagger operations create any head butts.

• The Drop Pins operation creates any crossed pins, breakouts, or unassigned test points.

• The New .JOB file has a bad file name.

Menu: Action-AutoGen

Button:

Key: None
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AutoFixture “Lights Out” Processing
The AutoFixture product has an AutoProcessing feature that automatically detects Lavenir .F04 format
netlists or Lavenir .JOB files as they are placed in a target directory and generates fixture drill files and
tester download files for them with no user intervention. For a full “lights-out” fixture-processing
routine you can use AutoFixture’s automatic processing along with the NetRipper.BAS script for
CAMMaster. Using the two features together, the system can take a directory full of prepared .BIN
files, automatically create the netlists and then automatically generate the fixture and tester download
files. This is useful for overnight processing of netlist and fixture files.

AutoFixture Overview
During the AutoProcessing setup, you make some AutoFixture template files for the types of fixtures
that you usually use. You may have several fixture designs, some for one-sided, some for two-sided,
some for dense boards, some for not so dense ones, some for large boards, and some for smaller ones.
Then you tell AutoFixture whether each fixture template is for single-sided or double-sided boards and
the maximum size of board that can be tested on each. You organize the fixture templates in order so
that AutoFixture will use the most cost-effective fixtures whenever it can and only use the more
complex fixtures when the board design requires it. You also tell AutoFixture where to look for input
netlists or input .JOB files and where to output the finished fixture and tester files.

After you have done the one-time setup, daily fixture processing can be automated. On a daily basis,
you do the normal CAM processing for your day’s jobs, but save the netlist extraction and fixture
processing for “lights-out” AutoProcessing by AutoFixture. Tell the CAMMaster NetRipper.BAS
script where the CAMMaster .BIN files are located and where to put the netlists. Start the CAMMaster
NetRipper.BAS script and the AutoFixture AutoProcessing feature.

The AutoFixture system will do the following:

• The NetRipper.BAS script extracts netlists from the jobs you prepared during the day and puts
the netlists in a directory where AutoFixture can find them.

• The AutoFixture AutoProcessing feature automatically detects the completed netlists as
NetRipper places them in the input directory.

• AutoFixture matches each netlist to the first fixture file template in its list that has the right
number of sides (single or double) and the right size.

• AutoFixture processes each job to completion. If the system cannot completely solve a
particular job using the current fixture template, it moves to the next fixture design in the list
and tries again. If it can’t find a fixture design that it can use to solve the job automatically, it
saves the job out for manual processing, makes a log file entry, and moves on to the next job.

• Once AutoFixture has processed each job to completion, it exports all the necessary test files,
drill files and report files, and it updates the log file. Then it looks for the next netlist.

When you return, you find all the files you need to generate the fixtures and test the jobs and a log file
that gives you the status of all jobs processed.
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Set Up AutoFixture Fixture Templates
Before you can use AutoFixture to automatically process netlists, you must set up the AutoFixture
templates. Templates are not necessary if you are using AutoFixture to process .JOB files.

To Set Up AutoFixture Fixture Templates:
1. If you have a boilerplate .JOB file that you want to use as a starting point, import the job. See

Open a FixMaster Job File on page 293.

2. On the Setup menu, click AutoProcess-Build Templates.

The AutoProcess Templates dialog is where you will set up the configurations that define each of
your templates. This dialog is able to access all the other configuration and setup dialogs that you
ordinarily use to process a FixMaster job. Each of these dialogs is explained in other sections of
this manual, so to set up a given configuration dialog, click on the appropriate button and refer to
the corresponding section in this manual.

After you have saved all the template files that you plan to use, there is a separate procedure in
which you will organize the templates by what size of job each template should be used for and
whether each template is for a single sided or double sided test. See Set Up the AutoProcessing
Options on page 376.

AutoProcess Templates Dialog

3. To set up the fixture probes and the D Code to probe mapping, click the Probe Table button.
See Setting up the Probes on page 70.
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4. To set up the fixture plates, click the Fixture Table button. See Setting up the Fixture Plates
on page 52.

5. To set up the tester grid, click the Tester Grid button. See Setting up the Fixture Grids on
page 61.

6. To set up the automatic spacer insertion, click the Spacers button. See Add Spacers on page
281.

Note: Be sure to set up both the Spacer Config tab and the Auto Spacer tab.

7. To set up the datum point, click the Datum Point button. See Setting the Datum Point on
page 340.

8. To set up test point staggering, click the Stagger button. See Stagger Test Points on page 165.

9. To set up net splitting if necessary, click the Split Net button. See Set Up Split Net Options on
page 222.

10. To set up automatic placement of the PCB, click the Place PCB button. See Automatically
Centering the PCB in the Fixture Tooling on page 121.

11. To set up generation of a report file, click the Report button. See Export a Report File on
page 355.

12. To set up test point generation, click the Generate button. See Generating Test Points on
page 137.

13. To set up automatic hole-size calculation based on drill bits, click the Drill Bit Table  button.
See Automatically Pick Best Fit to Drill Bit Table on page 74.

14. To set up the tester download file options, click the Export Test button. See Export Tester
Download Files on page 316.

15. To set up the allowable pin deflections and breakout gap, click the Pin Deflections button.
See Setting up the Fixture Design Rules on page 59.

16. To set up the drill files for the fixture plates, click the Export Plates button. See Export
Fixture Drill Files on page 341.

17. When all the configuration settings are set up the way you want, click the Browse button.
Browse for the drive, folder, or network location where you want to save the file and enter the
name for the file.

18. Click the Save Now button.

19. If you want to save other templates, you can go back and make changes on the AutoProcess
Templates dialog and save the new templates under new names.

20. When you are done saving templates, click OK  on the AutoProcess Templates dialog.

21. Go to the AutoProcessing setup procedure to prioritize your fixture templates and set up your
other AutoProcessing options. See Set Up the AutoProcessing Options on page 376.

Menu: Setup-AutoProcess-Build Templates

Button: None

Key: None
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Set Up the AutoProcessing Options
Before you can use AutoFixture, you must set up the AutoProcessing options.

To Set Up the AutoProcessing Options:
1. On the Setup menu, click AutoProcess-AutoProcess.

AutoProcess Processing Paths Tab

2. On the Processing Paths Tab, set the following folder locations:

IN Folder:  Next to the IN Folder field, click the Browse button, and browse for the folder where
the netlists or .JOB files that are to be processed are located.

OUT Folder: Next to the OUT Folder field, click the Browse button, and browse for the folder
where you want the completed .JOB, fixture and test files to be saved.

INCOMPLETE Folder:  Next to the INCOMPLETE Folder field, click the Browse button, and
browse for the folder where you want the .JOB files for incomplete AutoProcessing jobs to be
saved.

3. When the Folder locations are set up on the Processing Paths tab, click Apply .
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AutoProcess Processing Options Tab

4. On the Processing Options tab, set the following processing options:

Optimize Pin Deflection: If you select this option, AutoFixture will attempt to solve the job with
the original pin deflection. If the program succeeds with all test points assigned without error, it
will try to solve the job with a smaller pin deflection, and so on. This process can be time-
consuming, but it can achieve tighter pin deflections.

If Current Job Cannot be Completed Start Next Job: If this option is selected, AutoFixture
will move on to the next job if it cannot complete the current job.

Allow Auto Rotate for Best Fit: If this option is selected, AutoFixture will rotate the imported
netlist if the PCB will not fit within the fixture tooling. Because the rotation is only attempted if
the PCB doesn’t fit, this does not mean that the long side of the board will always match the long
side of the fixture. If you know how you want the PCB to be oriented, you should set it up that
way and not select this option.

Output Report File:  If this option is selected, AutoFixture will export a Report File for every job.

Allow Netlist Split if Necessary: If you select the option to allow netlist splitting if necessary,
there are more options to set up. For information about the options for netlist splitting during
AutoProcessing, see To Set up the AutoProcess Netlist Splitting: on page 380.
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Remove Padstacks: If this option is selected, AutoFixture will remove padstacks. For information
on removing padstacks, see Remove Padstacks on page 368.

5. When the options are set up on the Processing Options tab, click Apply .

AutoProcess Fixture Selection Tab

6. On the Fixture Selection tab, prioritize the order in which you want the fixture templates to be
used.

Note: When processing .JOB files, AutoFixture does not use these fixture template files, and the
order is unimportant. Instead, AutoFixture will use the fixture information saved in the
.JOB file. The template selection order is only used when processing netlists.

When the AutoProcessing feature begins to process a netlist, it starts in the beginning of this
Fixture Selection Setup list and uses the first fixture it finds that is the right type (Single Sided or
Double Sided), and that is for the correct size (Max X, Y dimensions). If AutoProcessing is unable
to solve the job using the first fixture template, it tries to process the job with the next fixture
template that is the right type and right size. By prioritizing this list you can have AutoProcessing
try the most cost-effective fixtures first.
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Set up the following:

Name: This field lists the file names of fixture template files that you saved earlier in the Build
Templates procedure. See Set Up AutoFixture Fixture Templates on page 374. Move these files up
or down in the list by selecting the row of the file you want to move and then clicking the Move
Up, Move Down buttons.

Max Size X, Y: Enter the Maximum board dimensions that can be tested on the given fixture
template.

Type: Select whether the given fixture template is appropriate for testing single or double sided
jobs.

Enable: You can select whether to turn on or turn off a given fixture template file. This way you
may decide not to use a particular template at a particular time, but still maintain the order of the
list. To allow a given template to be used, click the Enable checkbox for that template file so that
the template has a checkmark. To not allow a given template to be used, click the Enable
checkbox for that template file so that the template does not have a checkmark.

Move Up, Move Down: These buttons move a selected template up or down in the list.

7. When the templates are set up on the Fixture Selection tab, click Apply .

8. When all the AutoProcessing options are set up, click OK .

Menu: Setup-AutoProcess-AutoProcess

Button: None

Key: None



FixMaster User’s Guide

380

To Set up the AutoProcess Netlist Splitting:
This procedure explains the options for netlist splitting that you may select while setting up the
AutoProcessing options. For the main setup procedure for AutoProcessing, see To Set Up the
AutoProcessing Options: on page 376.

1. On the AutoProcess Processing Options Tab, click the Allow Netlist Split if Necessary
option so that it has a checkmark.

AutoProcess Processing Options Tab

2. Click the Options button.
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3. On the Split Options dialog, enter a threshold number of test points. If there are more
unassigned test points than the number you enter, AutoFixture will split out the nets
containing unassigned points.

4. In the Options group box select whether to split to another fixture or to a flying probe
tester.

Split into Fixture:  If you select this option, AutoFixture will split nets into another FixMaster job.
And then it will process the split job until the entire job is done.

Split into Flying Probe: If you select this option, AutoFixture will split nets into a ProbeMaster
job. And then it will process the split ProbeMaster job until the entire job is done.

5. If you selected to split the nets to a Flying Probe job, click the More button and set up the
additional flying probe options.
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Split Options for Flying Probe

• Tester: Select the type of Flying Probe Tester.

• Output Format:  Select English or Metric units.

• Minimum Net Separation: This is for generating adjacency data.

• MP-440 Find Thru-Hole Connection Info: Generates thru-hole connection data for
the EMMA tester.

6. Click OK .

7. Return to the main setup procedure. See To Set Up the AutoProcessing Options: on page 376.
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Start AutoProcessing
The AutoProcessing feature can be run on its own, or it can be run with the NetRipper.BAS script for
CAMMaster. Regardless, the AutoProcessing feature monitors an input directory for netlist files or for
.JOB files that need to be processed. AutoFixture processes any files that are in the directory when
AutoProcessing is started and any files that are placed into the directory while it is running. By using
the NetRipper.BAS Script, you can also automate the netlist extraction process.

To Start AutoProcessing:
1. If you are going to use the NetRipper.BAS script in CAMMaster, start it now.

2. If you have difficult jobs that you would like to be processed using a specific fixture, or if you
expect that jobs will need to use split nets, import those types of jobs into FixMaster.
Generate test points and save the .JOB file.

3. Place your prepared netlists or .JOB files in the AutoProcessing IN Folder directory you
defined during the setup. Or start the NetRipper.BAS script in CAMMaster and make its
output directory the same as the AutoProcessing IN Folder directory you defined during the
setup.

4. On the Action Menu, click AutoProcess.

The FixMaster window minimizes, and the AutoProcessing feature begins processing netlists or
.JOB files in the IN Folder directory.

If you are using the NetRipper.BAS script in CAMMaster, AutoFixture automatically detects the
completed netlists as NetRipper places them in the IN Folder directory.

AutoFixture matches each netlist to the first fixture template file in its list that is the right type
(single-sided or double-sided) and the right size. For .JOB files, AutoFixture does not attempt to
match to a template file; it uses the fixture saved in the .JOB.

AutoFixture processes each job to completion. If the system cannot completely solve a particular
netlist job using the current fixture template, it moves to the next fixture design in the list and tries
again. If it can’t find a fixture design that it can use to solve the job automatically, it saves the job
out for manual processing, makes a log file entry, and moves on to the next job.

If AutoFixture cannot completely solve a particular .JOB file job and netlist splitting is enabled, it
splits the job to another FixMaster or ProbeMaster job and processes the split jobs to completion.

Once AutoFixture has processed a job to completion, it exports all the necessary test files, drill
files and report files, and it updates the log file. Then it looks for the next netlist or .JOB file.

When you return, you find all the files you need to generate the fixtures and test the jobs and a log
file that gives you the status of all jobs processed.

Menu: Action-AutoProcess

Button: None

Key: None
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Chapter 20
PCB Tooling Holes and Fixture Alignment Pins

Some PCBs are designed with tooling holes to match alignment pins on the test fixture. Those tooling
holes are represented by D Codes on the PCB design, and they can be imported into FixMaster when
the PCB design is imported. Then, if you want to add drills to your fixture plate drill files so that you
can mount the alignment pins, FixMaster can export drills for alignment pins in your fixture to match
tooling holes on the PCB. FixMaster reads the tooling hole locations from the imported PCB data, then
exports drills in the fixture plate files at the same locations.

You specify:

• Which fixture plate files will be exported with tooling holes.

• The size of the tooling holes needed to mount the alignment pins.

• Which D Codes in the PCB represent tooling holes.

Dual Fixture Issues
Just as you can map the same D Code to different probes on different sides of the board, you can
handle tooling holes differently on different sides of the board. For instance, you may want to put drills
for mounting alignment pins at tooling hole locations on the component-side fixture, and put a
different size drill at the same location on the solder side fixture to allow the tower tester to close over
the pins. If you are doing simultaneous dual-sided testing, you can set up two Fixture Plate
configurations and two Probe Tables and two D Code/Tool to Probe Maps. Whenever you have one of
these tables displayed, it is for the current board side, CMP or SOL.
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Fixture Plates with Tooling Holes
When the drill files are exported, you have the option to export tooling holes from the PCB data as
drills in fixture plates. It may be that you want to have drills for tooling holes in some plates and not in
others.

To Specify which Fixture Plates will be Exported with Tooling Holes:
1. On the Setup menu, click Fixture-Fixture Table .

Fixture Plates Tab

2. On the Fixture Plates tab, if you want to export tooling holes for a particular plate, enter a
checkmark in the Tooling field of that plate. Otherwise clear the checkmark for that plate.
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Tooling Hole Drill Diameters
The D Codes which are imported from the PCB data as tooling holes have diameters that represent the
diameter of the hole in the PCB. The diameter of the corresponding hole in the fixture will be different.
The hole in the fixture needs to be drilled to the diameter needed to mount the alignment pin on the
fixture. The Probe Table, where you set up the probe parameters, is also used to set up tooling hole
diameters.

To Set up Tooling Hole Diameters:
1. On the Setup Menu, click Fixture-Probe.

Probe Setup Tab

2. On the Probe Setup tab of Probe Setup dialog, enter T in the Type field of this table for each
Tooling Hole.

A type-T probe isn't actually a probe. FixMaster uses the diameter of the type-T probe as the
tooling hole size and the size of the Tool Code in the drill export files.

3. In the Shaft Dia field, enter the size you want the tooling hole to be.

Note: The Drill Oversize parameter in the Fixture Plates dialog is not added to this size.

4. If you are going to automatically map D Codes to Probe Codes, set up the Pad Min and Pad
Max fields also. This is not necessary if you are manually mapping D Codes to Probes.
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D Codes Mapped as Tooling Holes
In order for this process to work, the PCB data must contain D Codes which represent tooling holes on
the PCB. After the PCB data is imported, set up the tooling holes in the D Code to Probe Map, just like
you set up the D Codes for probed and unprobed pads.

To Map D Codes as Tooling Holes:
1. On the Action menu, click D Code to Probe.

D Code to Probe Map Table

2. For each D Code that represents a tooling hole, enter 2 in the Type field.

This indicates to FixMaster that the D Code is a tooling hole. No test points will be generated for
type-2 pads.
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3. Type-2 D Codes need to be mapped to a Tooling Hole Probe Code, even though they are not
actually probed.

• If you are manually mapping D Codes to Probe Codes, map the type-2 D Codes to a
type-T Probe which you have set up earlier in the Probe Table. The shaft diameter of the
type-T Probe will be used as the tooling hole diameter and will be used as the Tool Code
size when drill files are generated.

• If you use the Auto Assign feature to automatically map type-2 D Codes to Probe Codes,
FixMaster looks first for the type-T Probe Code and then the correct pad-size range. The
first type-T Probe Code in the list that matches pad minimum and maximum size criteria
is mapped to the D Code.

View Tooling Holes
You can highlight and inspect each pad mapped as a tooling hole.

To Highlight all Tooling Holes:
� On the View Menu, click HiLite Image-By Tooling Code.

FixMaster highlights all elements which have D Codes mapped as tooling holes in the D Code to
Probe Map.

To Go to Each Tooling Hole:
� After the Tolling Holes are highlighted, press N.

The cursor hops to the next Tooling Hole.

To Remove the Highlighting from all Tooling Holes:
� On the View Menu, click HiLite Image-Remove HiLite.

FixMaster removes the magenta highlighting.
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Chapter 21
Key Commands Summary

In FixMaster, many menu and toolbar commands have shortcut key equivalents, and some commands
are only activated by key commands. Shortcut key commands are usually the fastest way to activate
commands. In addition all menu commands can be accessed using access key commands, which are an
alternative way of working the command menus. See Access Keys for Menu Commands on page 8.

This chapter lists the shortcut key commands.

File Commands
Start a New FixMaster Job Ctrl+N

Open a FixMaster Job Ctrl+O

Save a FixMaster Job Ctrl+S

Displaying Data
Display Component Side or Solder Side Data Shift+O

Display the PCB Data B

Display All Pads or Only Pads with Test Points Shift+P

Display Net Numbers F

Display Only Unassigned Test Points U

Display Traces T

Display Silkscreen Data K

Display Board Outline Data O

Display the Fixture Drills L

Show the Drill Count Shift+F5

Show Job Statistics F6

Highlighting Data
Highlight a Specific Netlist Shift+F

Highlight Data by D Code Ctrl+D

Highlight Tooling Holes Shift+E

Highlight Data by Probe Code Shift+B

Highlight Data by Pin Deflection Shift+5

Remove Highlighting from the Screen Shift+H
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Zooming
Zoom Up or Down Page Up or Page Down

Zoom so that All Data is Shown on Screen Home

Zoom on the Reference Frame W

Zoom to a Specific Zoom Level Z

Going to Locations on Screen
Move the Cursor Arrow Keys

Go To Specific X, Y Coordinates X or Y

Select a Pad or Test Point S

Go to the Last Selected Test Point Ctrl+H

Move between a Test Point and its Grid Point E

Go to the Next Highlighted Element N

Screen Grid
Turn the Screen Grid On or Off G

Anchored or Dragged Grid Shift+G

Fixed or Variable Grid Ctrl+G

Measuring Distance
Measure Distance with Distance Measure Mode D

Measure Distance with the Relative Origin R

Reference Frame
Draw a New Reference Frame Shift+W

Edit Drills
Insert Drill Shift+L

Position PCB
Center PCB Ctrl+B



Chapter 21

393

Map D Codes to Probe
Map D Codes to Probe F5

Insert Test Points
Insert Single Test Point Shift+I

Stagger Test Points
Stagger All Test Points Automatically Ctrl+Shift+F9

Manually Stagger Individual Test Points Shift+F9

Swap the Stagger Position of Staggered Points Ctrl+F9

Assign Test Points to Grid
Assign All Test Points to Tester Grid Points Ctrl+Shift+J

Assign Test Points with Priority Ctrl+J

Manually Assign Individual Test Points to Grid Shift+J

Design Rule Checking
Run a Design Rule Check on the Whole PCB Ctrl+C

Netlist Inspection Mode
Display the First Net Shift+F

Display the Next Net Shift+N

Display the Previous Net Shift+B

Select a Pad or Test Point S

Wire Wrap Mode
Wire Wrap Test Points One at a Time Spacebar

Undo Wire Wrapping for Last Wire Wrapped Test
Point

Backspace

Go To the First Wrapped Test Point F

Go To the Next Wrapped Test Point N

Go To the Previous Wrapped Test Point B
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Spacers
Insert Spacer Shift+R

Edit PCB Data
Insert Pad Ctrl+Shift+P

Transcode Net Numbers Ctrl+Shift+T

Transcode D Codes Ctrl+T
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Assign Test Points to Tester Grid Points Overview,
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Assigning All Test Points to Tester Grid Points, 177
Assigning All Test Points to Tester Grid Points Based

on Density, 178
Assigning Test Points for a Priority Probe Code to

Tester Grid Points, 185
Assigning Test Points from a Priority Centerpoint

Outward, 183
Assigning Test Points in a Priority Region to Tester

Grid Points, 181
Assigning Test Points in the Frame to Tester Grid

Points, 179
Assignment Aid, 188
Automatically Moving the PCB when Dropping Pins,

119
Automatically Transcode to Smaller Probes to Assign

Test Points, 187
Manually Assigning Individual Test Points to Tester

Grid Points, 188
Manually Un-Assigning Individual Test Points from

Tester Grid Points, 192

Unassigned Test Points, 197
Un-Assigning Test Points in the Frame from Tester

Grid Points, 193
Waiting to Position the PCB until After Dropping

Pins, 120
Assignment Aid, 188
ATF Files

Export ATF, 352
ATF Netlist

Import ATF, CATE, TIF Formatted Netlist Files into
the Job, 305

AutoFixture
AutoFixture "Lights Out" Processing, 373
Automatic Processing in FixMaster and AutoFixture

Overview, 369
Set Up AutoFixture Fixture Templates, 374
Set up the AutoProcess Netlist Splitting, 380
Set Up the AutoProcessing Options, 376
Start AutoProcessing, 383

AutoGen, 370
Automation

AutoFixture "Lights Out" Processing, 373
AutoGen, 370
Automatic Processing in FixMaster and AutoFixture

Overview, 369
Set Up AutoFixture Fixture Templates, 374
Set up the AutoProcess Netlist Splitting, 380
Set Up the AutoProcessing Options, 376
Start AutoProcessing, 383

B
Barrel Optimize

Through-Hole Test Points on Opposite Board Side
from Incoming Trace, 143

Basic Gerber
Import Basic Gerber Files into the Job, 308

Best Fit
Automatically Pick Best Fit to Drill Bit Table, 74

Black Box
AutoFixture "Lights Out" Processing, 373
Automatic Processing in FixMaster and AutoFixture

Overview, 369
Board Outline

Displaying Board Outline Data, 23
Import Supplemental Gerber Files into the Job, 312

Board Side
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All Through-Hole Test Points on One Board Side, 142
Displaying Component Side or Solder Side Data, 17
Equal Number of Through-Hole Test Points Per

Board Side, 141
Switch the Active Board Side in Netlist Inspection

Mode, 218
Transfer Test Point to other Side of Board, 163

Boilerplate Jobs
FixMaster Job File (.JOB) Overview, 291
Set Up AutoFixture Fixture Templates, 374
Set Up the Fixture Configuration, 51

Breakouts, 201
Going To Breakouts, 40
Setting up the Fixture Design Rules, 59

C
CATE Netlist

Import ATF, CATE, TIF Formatted Netlist Files into
the Job, 305

Center PCB
Automatically Centering the PCB in the Fixture

Tooling, 121
Automatically Moving the PCB when Dropping Pins,

119
Close a FixMaster Job File, 295
CMP

Displaying Component Side or Solder Side Data, 17
Switch the Active Board Side in Netlist Inspection

Mode, 218
Color

Color System in Netlist Inspection Mode, 208
Plate Color, 88

Combination Testing
Set Up Split Net Options, 222
Split Nets Overview, 221
Splitting All Nets with Unassigned Test Points, 227
Splitting Nets to a Different FixMaster Job or

ProbeMaster Job, 223
Splitting Nets with Unassigned Test Points in the

Frame, 228
Command Menus, 8
Commands

FixMaster Interface Overview, 7
Key Commands Overview, 16
Key Commands Summary List, 391

Commented Pads
Display "Commented" Pads in IPC- D-356 Data, 18

Component Side
All Through-Hole Test Points on One Board Side, 142
Displaying Component Side or Solder Side Data, 17

Switch the Active Board Side in Netlist Inspection
Mode, 218

Convert
Convert Netlist Format, 303

Coordinates
Going To Specific X Y Coordinates, 37
Using the Relative Origin, 48

Copy
Copy Block of Wire Wrapped Points, 254
Copying Drills, 92

Correcting Design Rule Errors, 203
Covered Pads

Going To Possibly Probeable Pads not Given Test
Points, 41

Possibly Probeable, Possibly Covered Test Points,
148

Crossed Pins
Crossed Pins and Head Butts, 199
Going To Crossed Pins, 40

Curosr
Moving the Cursor Manually, 36

Current Plate
Active Plate, 86
Fixture Plates Toolbar, 12
Plate Toolbar, 85

Current Tool Code, 84

D
D Codes

Automatically Mapping D Codes to Probe Codes, 132
D Codes Mapped as Tooling Holes, 388
Highlighting Data by D Code, 29
Manually Map D Codes to Probe Codes, 135
Map D Codes to Probe Codes Overview, 129
PCB Tooling Holes and Fixture Alignment Pins, 385
Transcode D Codes, 365

Datum Point
Going To the Datum Point, 39
Setting the Datum Point, 340

Dedicated Fixtures, 69
Delete

Delete Pads, 358
Delete Spacers, 287
Delete Test Points, 154
Deleting a Group of Test Point Numbers from the

Wire Wrap Road Map, 263
Deleting a Single Test Point Number from the Wire

Wrap Road Map, 261
Deleting Drills, 89
Deleting Test Points in Netlist Inspection Mode, 219
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Density Drop
Assigning All Test Points to Tester Grid Points Based

on Density, 178
Densly Packed Component

Testing Densely Packed Components Separately, 232
Design Rule Errors

Breakouts, 201
Check for Design Rule Errors, 195
Correcting Design Rule Errors, 203
Crossed Pins and Head Butts, 199
Going To Breakouts, 40
Going To Crossed Pins, 40
Going To Possibly Probeable Pads not Given Test

Points, 41
Going To Unassigned Test Points, 39
Possibly Probeable, Possibly Covered Test Points,

148
Running a Design Rule Check Inside the Frame, 196
Running a Design Rule Check on the Whole PCB,

195
Setting up the Fixture Design Rules, 59
Unassigned Test Points, 197

Display
Choosing What Data to Display, 17
Display "Commented" Pads in IPC- D-356 Data, 18
Display Only the Accessed Side for IPC-D-356 Pads

with Access Data, 19
Display Test Points with a Large X in Netlist

Inspection Mode, 214
Displaying a Specific Net in Netlist Inspection Mode,

210
Displaying All Pads or Only Pads with Test Points, 18
Displaying All Pads or Only Pads with Unassigned

Test Points, 20
Displaying Board Outline Data, 23
Displaying Component Side or Solder Side Data, 17
Displaying Fixture Grid Points, 22
Displaying Net Numbers, 19
Displaying Nets in Netlist Inspection Mode, 210
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 212
Displaying Silkscreen Data, 22
Displaying Soldermask Data, 23
Displaying the Drill Path for the Fixture Drills, 24
Displaying the First, Next or Previous Net in the File

in Netlist Inspection Mode, 211
Displaying the Fixture Drills, 24
Displaying the PCB Data, 17
Displaying Traces, 21
Going to the Next Highlighted Element, 38

Show Everything in Gray Except for the Highlighted
Elements, 26

Show the Drill Count, 25
Showing the Job Statistics, 46
Viewing Data in FixMaster Overview, 17
Visibility Toolbar, 15

Distance Measurement
Distance Measurement Overview, 47
Using Distance Measurement Mode, 47
Using the Relative Origin, 48

Download
Download FixMaster Updates, 4

Download Files
Export Tester Download Files, 316

Dragged or Anchored Grid, 43
Drill Bit Table

Automatically Pick Best Fit to Drill Bit Table, 74
Drill Count, 25
Drill Editing

Active Plate, 86
Copying Drills, 92
Current Tool Code, 84
Deleting Drills, 89
Displaying the Drill Path for the Fixture Drills, 24
Displaying the Fixture Drills, 24
Fixture Plates Toolbar, 12
Inserting Drills, 88
Mirroring Drills, 96
Moving Drills, 94
Plate Color, 88
Plate Numbers, 85
Plate Toolbar, 85
Plate Visibility, 87
Replicating Drills, 106
Rotating Drills, 100
Set Up the Fixture Outside Tooling, 83
Setting up the Tool Codes for Outside Tooling, 83
Show the Drill Count, 25
Stepping and Repeating Drills, 105
Tool Codes Overview, 83
Transcoding Drill Tool Codes, 114
Transferring Drills, 110

Drill Files
Export Fixture Drill Files, 341
Import Drill Data for Outside Tooling, 314
Set Excellon Language Format Options, 343
Set Sieb & Meyer Language Format Options, 346

Drill Size
Automatically Calculate Hole Size Based on Plate

Oversize, 81
Automatically Pick Best Fit to Drill Bit Table, 74
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Manually Set Up Probe Hole Size Table, 78
Set up Drill Size for Probe Drills, 73
Setting up the Probes, 70
Setting up the Tool Codes for Outside Tooling, 83
Tool Codes for Probe Drills, 84
Tool Codes Overview, 83
Tooling Hole Drill Diameters, 387
Transcoding Drill Tool Codes, 114

Drop Pins
Assign Test Points to Tester Grid Points Overview,

177
Assigning All Test Points to Tester Grid Points, 177
Assigning All Test Points to Tester Grid Points Based

on Density, 178
Assigning Test Points for a Priority Probe Code to

Tester Grid Points, 185
Assigning Test Points from a Priority Centerpoint

Outward, 183
Assigning Test Points in a Priority Region to Tester

Grid Points, 181
Assigning Test Points in the Frame to Tester Grid

Points, 179
Automatically Moving the PCB when Dropping Pins,

119
Automatically Transcode to Smaller Probes to Assign

Test Points, 187
Manually Assigning Individual Test Points to Tester

Grid Points, 188
Waiting to Position the PCB until After Dropping

Pins, 120
Dual-Density Grids, 64
Dual-Sided Testing

Set Up the Fixture Configuration, 51

E
Edit PCB Data Overview, 357
Editing Mode Toolbar, 11
Editing Toolbar, 10
Endpoints

Surface-Mount Pads - Test Points for Endpoints Only,
145

Through-Hole Pads - Test Points for Endpoints Only,
146

Vias - Test Points for Endpoints Only, 146
English or Metric Units, 49
Entering and Exiting Netlist Inspection Mode, 209
Equal Number of Through-Hole Test Points Per Board

Side, 141
Errors

Breakouts, 201

Check for Design Rule Errors, 195
Correcting Design Rule Errors, 203
Crossed Pins and Head Butts, 199
Going To Breakouts, 40
Going To Crossed Pins, 40
Going To Possibly Probeable Pads not Given Test

Points, 41
Going To Unassigned Test Points, 39
Possibly Probeable, Possibly Covered Test Points,

148
Running a Design Rule Check Inside the Frame, 196
Running a Design Rule Check on the Whole PCB,

195
Setting up the Fixture Design Rules, 59
Unassigned Test Points, 197

Excellon Language Format Options, 343
Export

Export a Gerber Road Map for Wire Wrapping, 350
Export a Report File, 355
Export ATF, 352
Export Fixture Drill Files, 341
Export IPC356A, 354
Export Plate Gerber for an Interface Board, 348
Export Tester Download Files, 316
Export TIF, 353
File Handling in FixMaster Overview, 291
Fixture Plates with Tooling Holes, 386
Set Excellon Language Format Options, 343
Set Sieb & Meyer Language Format Options, 346

F
Feedback

Send Us Your Comments, 3
Files

Close a FixMaster Job File, 295
Convert Netlist Format, 303
Export a Gerber Road Map for Wire Wrapping, 350
Export a Report File, 355
Export ATF, 352
Export Fixture Drill Files, 341
Export IPC356A, 354
Export Plate Gerber for an Interface Board, 348
Export Tester Download Files, 316
Export TIF, 353
File Handling in FixMaster Overview, 291
FixMaster Job File (.JOB) Overview, 291
Import ATF, CATE, TIF Formatted Netlist Files into

the Job, 305
Import Basic Gerber Files into the Job, 308
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Import IPC-D-356 Formatted Netlist Files into the
Job, 299

Import PCB Files into the Job Overview, 299
Import Supplemental Gerber Files into the Job, 312
Open a FixMaster Job File, 293
Save a Job File, 296
Start a New FixMaster Job, 292

Fixed or Variable Grid, 44
Fixture

Set Up the Fixture Configuration, 51
Setting up Fixture Plate Materials, 55
Setting up the Fixture Grids, 61
Setting up the Fixture Pin Loading Plate, 57
Setting up the Fixture Plates, 52

Fixture Grid
Dedicated Fixtures, 69
Displaying Fixture Grid Points, 22
Dual-Density Grids, 64
Quad-Density Grids, 67
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